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Welcome to iceAdministrator 

As email and web-based communications become more common in today’s 

business world, many call centers are evolving into contact centers. This allows 

businesses to interact with clients over the telephone, through email messages, 

web chats, social media posts, social media messages, and SMS.  

ice is a powerful contact center solution that allows for the integrated handling of 

contacts (calls, email messages, chat requests, etc.) that are directed to your 

contact center. iceAdministrator is the tool that helps you manage your contact 

center from your desktop. 

 

 

Chapter 1: Getting Started describes permissions for each user type, the logon 

procedure, common error messages, major components of iceAdministrator, and 

Edit and View modes. 

Each subsequent chapter provides information on viewing, creating, modifying, 

and deleting items in iceAdministrator. Advanced topics can be found in the 

appendices.  

Note: The iceAdministrator User Manual does not discuss workflow, audio 

messages, building blocks, holidays, or variables. For information on these topics, 

refer to the iceWorkflow Designer User Manual. 

 



 

 

In discussing how this application works, this manual assumes that you: 

• Are familiar with the contents of the iceBar User Manual; 

• Understand basic telephony terms and concepts, such as queue and contact; 

• Have basic navigating skills for standard Windows-based graphical user 

interfaces. This includes the ability to right-click and left-click, select options 

from a right-click menu, re-size and minimize windows, and navigate and 

scroll with a mouse pointer. 

The following conventions are used in this manual: 

• Notes highlight important information. 

• Cautions are used to bring attention to functions and features that can affect 

the information viewed. 

• Words displayed in bold font are defined within the paragraph. 

• Italics are used to indicate buttons found on the software interface. 

• The term "right-click" is used to indicate that the secondary mouse button, 

which by default is the button on the right, should be clicked. This 

configuration can be changed so that the left mouse button is the secondary 

button (for personal preference, for example, if the user is left-handed.) 



 

 

 

 

 

 

 

 

 

Chapter 1: Getting Started 

To view and modify configurations for your contact center, you must first be able 

to log on and navigate through iceAdministrator. iceAdministrator requires a 

specific User ID and password to open the application. User type controls the 

type of information each user can see.  

In this chapter you will learn about the following topics: components of 

iceAdministrator; permissions on iceAdministrator; logon procedures; common 

error messages; View and Edit modes; and working offline.  

Once you are familiar with the interface of iceAdministrator, you can refer to the 

subsequent chapter for detailed information on configuring your contact center.  
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Logging On 

Each time you start iceAdministrator, you must verify your five-digit switch ID, your four-digit user 

ID, and enter your password.  

To log on:  

1. Double-click on the iceAdministrator icon.   

The ‘iceAdministrator Logon’ dialog box appears. 

 
 

Select the ‘Work Offline’ checkbox if you wish to use iceAdministrator without loading the 

configuration for your contact center from the database. For more information on working offline, 

refer to page 13. When this option is selected, you are not required to enter switch ID, user ID, or 

password, as described in the steps that follow.  

2. In the ‘Switch ID’ field, enter the five-digit switch ID associated with the switch to which you are 

assigned. 

The default value for the ‘Switch ID field’ is 11001. If your ice system has more than one switch, 

the ice administrator (the person responsible for maintaining ice) should provide the switch ID 

that represents your contact center.  

3. In the ‘User ID’ field, type your four-digit user ID. 

4. In the ‘Password’ field, type your password (up to twenty digits). 
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5. Click OK. 

A message box appears. 

 

6. Click Yes to enter the application in Edit Mode, which allows you to modify the existing 

configuration. Click No to enter the application in View Mode, which allows you to view existing 

configuration without making changes. 

Once the application is open, you can toggle between these two modes. For more information on 

Edit Mode and View Mode, refer to page 10. 

Upon making a mode selection, the configuration for your contact center is retrieved from the 

database, and iceAdministrator opens.  

You have successfully logged on to iceAdministrator. The next time you log on, iceAdministrator 

remembers the switch ID and user ID last entered. If you are the only person using the computer 

where iceAdministrator is installed, you only need to enter your password and click OK.  

If you have experienced difficulty logging on, refer to the next section for a description of 

common error messages and ways to resolve them. For a description of the iceAdministrator 

interface, refer to page 15 when the application is open. 

Note: The information displayed in iceAdministrator is dependent on your user type. For 

information on permission levels and user types, refer to page 27. 
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Single Sign-On   

If your organization has enabled Single Sign-On for iceAdministrator, you will be able to sign on 

using your Windows credentials.  

 

Note: To enable Single Sign-On, it will need to be configured using Active Directory in 

iceAdministrator. For further information on how to enable Single Sign-On, please review 

Importing Users from Active Directory on page 55.  

Signing On with Single Sign-On 

When Single Sign-On is configured for iceAdministrator, enter the Switch ID you would 

like to connect to, followed by checking the Use Windows Credentials box when the 

logon window appears. 

 

1. When you click OK, the Single Sign-On dialog box will appear. 

  

2. To sign in with this method, you will use the same credentials that you use to log on to 

your computer or your company email. Enter your username and password in the boxes. 
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3. Click OK when you are ready to connect to iceAdministrator.  

 

Note:  

• If you wish to skip this step for future logins, check the box for Remember my credentials. 

This way, you will not have to enter your Username each time you sign in. 

• This dialog box may look different, depending on the way your administrator has 

configured the system. 

• These steps are applicable to other single sign-on methods such as Okta. 
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Choose Language  

When you are starting iceAdministrator for the first time, the application will try to determine 

what operating system language you are using and default the application to that language. For 

example, if you have a French OS installed, it will default the settings to French. If you are using a 

non-supported language, then it will default the language to English. 

The iceAdministrator interface is available in English or French.   

 

To change the language: 

1. Log on to the iceAdministrator application as described in the previous section, selecting either 

Edit or View mode. 

2. Open the Settings menu. 

 

 

 

3. Select Language. 

4. Select the desired language. A checkmark appears beside the language currently in use. 

The application will update to reflect the change. 
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Common Error Messages 

The sections that follow describe some common error messages you might experience when 

logging on or when the application is running. 

Invalid Information 

The error message shown below appears when you enter an incorrect password, an 

invalid user ID, or an incorrect switch ID. 

  

Verify the information that you have entered and try again. 

User ID Does Not Have Access Rights  

The error message shown below appears when you enter a user ID that does not have 

access rights to the iceAdministrator application. For information on permission levels 

and user types, refer to page 27. 

  

Contact your ice administrator to verify if the user ID that was provided has the necessary 

permission level to access the application. 
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Database Locked 

The message shown below appears if you attempt to enter Edit Mode while another user 

is in Edit Mode. 

   

For more information on database locking, refer to page 12.  

Connectivity Error 

iceAdministrator must have network connectivity to the ice server to function properly. If 

your contact center is experiencing network problems, you may see this error message: 

 

 

Click Yes to try to re-establish your connection with the ice server. Otherwise, click No to 

close the message box and exit from iceAdministrator. Once network difficulties are 

resolved, you may re-open iceAdministrator. 

Caution: If you make changes in iceAdministrator while network connectivity is lost, the 

changes may eventually be saved to the database (the database may not be reachable if 
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there are network issues) without notifying ice. ice is not notified of these changes until 

the server is restarted.  

iceAdministrator provides a warning message when the database has changed without 

notifying ice. Click Retry on the dialog box once network connectivity is restored. As an 

alternative workaround, you may modify the changed items again when the connection is 

re-established. This updates the ice server with the changes, including the changes made 

while the connection was lost. 
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Edit Mode and View Mode 

Each time you log on, iceAdministrator prompts you to make a selection. 

 

When you click Yes, the application opens in Edit Mode, which allows you to make changes to the 

configuration of your contact center. When you click No, the application opens in View Mode, 

which allows you to view the current configuration of your contact center. 

Selecting Edit Mode 

You may decide to switch from View Mode to Edit Mode to modify the configuration of 

your contact center. To toggle from View Mode to Edit Mode, select Edit from the Mode 

menu. 

The configuration for the contact center is updated from the database and 

iceAdministrator switches to Edit Mode. 

 

Note: 

• When in Edit Mode, a checkmark appears beside the Edit option in the Mode menu and 

the bottom right corner of the iceAdministrator window displays ‘You are currently in 

EDIT mode.’ 

 

• While in Edit Mode, you can modify the configuration for the contact center.  
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Selecting View Mode 

You may decide to switch from Edit Mode to View Mode when you want to see 

configurations in your contact center.  

 

To toggle from Edit Mode to View Mode: 

1. Select View from the Mode menu. 

If you have any unsaved changes, iceAdministrator will prompt you to save changes. 

 

                     

2. Click Yes if you want to save any unsaved changes before exiting Edit Mode.  

Click No to switch to View Mode without saving changes. The configuration for your 

contact center is updated from the database and iceAdministrator switches to View 

Mode.  

Click Cancel to stay in Edit Mode without saving changes. 

Note: 

• When in View Mode, the checkmark does not appear beside the ‘Edit’ option and the 

bottom right corner of the iceManager window displays ‘You are currently in VIEW 

mode.’ 

 

• While in View Mode, you can only view the configuration for the contact center.  
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Locking the Database 

Having a lock on the database ensures the data you are viewing is the most up to date 

and another iceAdministrator user does not overwrite your changes. 

When a user successfully enters Edit Mode, a locking mechanism is placed on the ice 

database. This ensures that two iceAdministrator users are never editing the same portion 

of the ice database at the same time. If your contact center has only one instance of 

iceAdministrator, this should never be a concern.  

If you attempt to enter Edit Mode while another user has already locked the portion of 

the database to which you require access, the ‘Database Locked’ dialog box appears. 

  

This dialog box notifies you that another user has the lock on the database and provides 

the user ID and user name of the current lock holder. In addition, you will also see the 

date and time of how long the database has been locked for. Until this user exits Edit 

Mode, you are limited to View Mode. If you click the Quick Text and Continue in View 

Mode button, you can send a note to the user who has locked the database and you can 

then proceed to use the application in View Mode. (For more information on quick text 

messaging, refer to page 37.) Click Cancel to close the application. 

Force to Edit Mode becomes available only under special circumstances. For example, if 

your PC crashes, it is possible that ice may think that you still have the lock on the 

database. When you log on to iceAdministrator and select Edit Mode, you may be 

presented with the ‘Database Locked’ dialog box with your own user ID appearing as the 

current lock holder. In this scenario, you can click Force to Edit Mode to regain the lock on 

the database. 

Note: Depending on how your system is configured, it is possible to have two users 

editing the ice system at the same time. For example, two switch administrators assigned 

to different switches have the ability to make changes to their respective switches 

simultaneously.  



 

 

 

 

 

  
  

13 iceAdministrator User Manual 

Working Offline 

When you log on to iceAdministrator, you have the option to work offline instead of working with 

a connection to the ice database/ice server. You do not need to specify your user ID and 

password when working offline. As a result, you have the permissions of a Global Administrator 

while working offline.  

All changes that are saved while you are working offline are saved to a file (e.g., a file on your PC). 

The next time you log on to iceAdministrator, you can import the changes made while working 

offline. Keep in mind that iceAdministrator only allows you to import changes that your user type 

allows. For information on permission levels and user types, refer to page 27. 

Note: The quick text messaging feature is not available when you are working offline. 

 

To work offline: 

1. Double-click on the iceAdministrator icon. 

The ‘iceAdministrator Logon’ dialog box appears. 
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2. Enable the ‘Work Offline’ checkbox. 

  

You are not required to supply any other logon information. 

3. Click OK to open iceAdministrator. 

You have successfully opened iceAdministrator, but you will not see any data. It is recommended 

that you import a switch that you previously exported, or you can create a site, node, and switch 

as required. For more information on importing data, refer to page 227. For more information on 

creating sites, nodes, and switches, refer to page 243. 
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Components of iceAdministrator 

The iceAdministrator user interface is composed of a menu bar, toolbar, tree view, and detail view.  
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Menus 

The table below provides a summary of each Menu: 

iceAdministrator menus 

Menu Menu Items Function 

File Validate Validate any changes without 

updating them in the database. 

This is useful if you are working 

offline because you can check the 

integrity of your work without 

connecting to the database. After 

you select validate, you are given 

the option to see the list of items 

that have changes. For more 

information, refer to page 33. 

Save Save changes to the ice database 

and notify the ice server of the 

changes. You can cancel the save 

process at any time by clicking 

Cancel on the ‘Progress’ dialog 

box. 

Reload Reload configuration from the ice 

database. Any unsaved changes 

are lost upon selecting Reload. 

Work Offline Work with iceAdministrator 

without a connection to the ice 

database or ice server. Changes 

made while working offline can 

be saved to an exported file. For 

more information on working 

offline, refer to page 13. For more 

information on exporting, refer to 

Appendix A: Exporting and 

Importing. 

Print Print the workflow page you are 

viewing.  

Print Preview Display a print preview of the 

workflow page you are viewing. 
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iceAdministrator menus 

Menu Menu Items Function 

To return to the normal view, 

select this menu option again.  

Page Setup Configure the paper size and 

orientation of the paper before 

printing or previewing the 

workflow page you are viewing.  

Send Quick Text Message Send a quick text message to any 

users logged in to 

iceAdministrator, iceMonitor, 

iceManager, or iceBar. 

Exit Close iceAdministrator. 

Edit Undo Delete Undo the deletion of an item in 

iceAdministrator. For example, if 

you delete a user, click Undo 

Delete to undo the change. If you 

save changes, Undo Delete is no 

longer available for deletions 

made prior to a save operation. 

Note: If you create a new item 

that has the same ID as the item 

that you deleted, Undo Delete is 

no longer available for that item. 

For example, if you delete user 

2502, Undo Delete is available. If 

you then create user 2502, Undo 

Delete is no longer available.  

Cut Cut an action or a group of 

actions that you have selected on 

the workflow page. 

Copy Copy an action or a group of 

actions that you have selected on 

the workflow page. 

Paste  Paste an action or a group of 

actions onto a workflow page, 

provided you have copied or cut 
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iceAdministrator menus 

Menu Menu Items Function 

an action or group of actions 

from a workflow page.  

Delete Delete an action or a group of 

actions that you have selected on 

the workflow page. 

Select All Select all of the actions and links 

on the workflow page.  

Layout Align Align selected workflow actions 

on the workflow page. This menu 

is only available when you are 

viewing a workflow page and 

have more than one action 

selected. 

View Tree Restore tree view if tree view has 

been closed.  

Highlight Imported Highlight imported data in the 

tree view with red text. For more 

information on importing and 

exporting, refer to page 227.  

Grid Show a grid on the workflow 

page.  

Snap to Grid  Anchor actions and links to the 

grid, whether or not the grid is 

displayed.  

Link Labels Display link labels on the 

workflow page.  

All Links Override any ‘Hide Incoming 

Links’ settings for actions on a 

workflow page in order to see all 

links. 

Workflow Actions Toolbar Open the ‘Show Workflow 

Actions’ dialog box. Select the 

workflow actions to be displayed 

in the Workflow Actions toolbar. 
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iceAdministrator menus 

Menu Menu Items Function 

Mode Edit When checked, iceAdministrator 

is in Edit Mode. When unchecked, 

iceAdministrator is in View Mode. 

When working offline, this menu 

option is greyed out. 

Settings General Define ranges for user IDs and 

queue IDs that can be viewed and 

added, and select the method for 

sorting these items. You may also 

define settings for workflow. 

iceAdministrator must be 

restarted for these settings to 

take effect. 

Min ID – The lowest user/queue 

ID that can be viewed or added.  

Max ID – The highest user/queue 

ID that can be viewed or added.  

Sort by – The method (ID or 

Name) used to sort users/queues 

in iceAdministrator’s tree view.  

Hunt Group Order – Defines 

how users are sorted in the tree 

view for the queue.  

Single Click – By default 

workflow pages open with a 

double-click. Select this check 

box to open workflow pages with 

a single click.  

Show Workflow Action 

Properties when dropping on 

canvas – By default, the Workflow 

Action property window opens 

when you drop an Action on the 

Workflow canvas. Unselect this 

checkbox to stop the Workflow 

Action property window from 

opening.  
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iceAdministrator menus 

Menu Menu Items Function 

Show Workflow Action 

Properties when using Link 

Tool – By default, the Workflow 

Action property window opens 

when linking two Workflow 

Actions. Unselect this check box 

to stop the Workflow Action 

property window from opening. 

Verify before deleting a user – 

Ask for confirmation before 

deleting a user. 

Clear the list of messages to 

ignore – When users are 

importing workflows and there 

are conflicts, users can choose a 

default action that is taken for 

such conflicts. Users can also 

choose to never see the message 

again during the import. Disable 

the checkbox beside this option 

to have the message pop up 

during imports. 

Import Determine the action that 

iceAdministrator takes when a file 

being imported has the same ID 

as an existing file. For more 

information on import settings, 

refer to page 239.  

 Language Change the language selection in 

iceAdministrator. Language 

choices include English and 

French. 

Window Previous Select to view the page you just 

left. This feature is similar to the 

Back button in Microsoft 

Windows Explorer. 

Next Select to view the page you were 

on before selecting the Previous 
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iceAdministrator menus 

Menu Menu Items Function 

button. This feature is similar to 

the Forward button in Microsoft 

Windows Explorer. You cannot 

use the Next button until you 

have used the Previous button. 

Cascade Arrange all windows that have 

been recently viewed in the detail 

view in cascading order, with the 

most recently viewed window on 

top.  

Tile Arrange all windows that have 

been recently viewed in the detail 

view as tiles. 

Close All Close all recently viewed 

windows.  



  

 
 

 

22 iceAdministrator User Manual 

iceAdministrator menus 

Menu Menu Items Function 

Workflow 

 

When viewing a workflow page, 

select actions from this menu to 

place on the page.  This is an 

alternative to using the workflow 

action icons.  

Note: This menu will only be 

available when on a Workflow 

page. 

Help About iceAdministrator Provides information on the 

version of iceAdministrator, the 

ice server version, as well as the 

connected servers. 
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Toolbar 

The Edit Mode and Save buttons on the toolbar are always available, as shown below: 

 

When a workflow page is displayed in the detail view, the remaining toolbar buttons will 

become available: 

 

 

The table below describes each button on the toolbar. All but the first six buttons are 

specific to the workflow: 

Toolbar buttons 

Button Name Function 

 
Edit Mode Toggle between Edit Mode and View Mode.  

 
Validate All Validate any changes you have made without 

updating the ice database. 

 
Save Save changes to the ice database and notify the 

ice server of the changes.  

 
Back 

(Previous) 

Select to view the page you just left. This feature is 

similar to the Back button in Microsoft Windows 

Explorer. You cannot use the Back button until you 

have clicked on at least two items in the tree view. 

 
Forward 

(Next) 

Select to view the page you were on before 

selecting the Back button. This feature is similar to 

the Forward button in Microsoft Windows 

Explorer. You cannot use the Next button until you 

have used the Back button. 
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Toolbar buttons 

Button Name Function 

 
Undo Delete Undo the deletion of an item in iceAdministrator. 

For example, if you delete a user, you can click 

Undo Delete to undo that deletion. If you save 

changes, Undo Delete is no longer available for 

deletions made prior to a save operation. 

Note: If you create a new item that has the same 

ID as the item that you deleted, the Undo button is 

no longer available for that item. For example, if 

you delete user 2502, the Delete button is 

available. If you then create user 2502, the Undo 

Delete button is no longer available. 

 
Select Select actions and links on a workflow page. By 

default, this option is enabled. 

 
Add Link Add a link between two actions you have placed 

on a workflow page.  

 
Delete Node 

or Link 

Delete nodes and links on a workflow page. 

 
Zoom In Zoom in on a workflow page. 

 
Zoom Out Zoom out on a workflow page. 

 
Restore Size After using Zoom In and Zoom Out, use this 

option to restore the workflow page to its original 

size.  

 
Print Print a workflow page.  

 
Properties Show the properties page for the workflow page. 
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Tree View 

Similar to any tree control found in a Windows-based application (e.g., Windows 

Explorer), the tree view in iceAdministrator is easy to use. 

 

The tree view allows you to: 

• Access different levels or components of the system, including individual users, 

queues, and more. The information available in the tree view is based on your user 

type. For information on permission levels and user types, refer to page 27. 

• When in Edit Mode, many items in the tree view have right-click menus. These menus 

provide access to options such as importing, exporting, adding, and deleting (e.g., 

Import Queues, New Queue). 

Detail View 

The detail view displays the configurable parameters for the item that you have selected 

in the tree view. For example, when a user is selected in the tree view, seven tabs are 

shown in the detail view. Each tab allows you to view or configure a portion of the user’s 

profile.  

The information available in the detail view is based on your user type. For more 

information on permissions on iceAdministrator, refer to page 27. 
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Sites, Nodes, and Switches 

Sites, nodes, and switches represent the hierarchy of an ice system in iceAdministrator. 

The following screenshot shows how sites, nodes, and switches appear in the tree view of 

iceAdministrator for a typical system: 

  

A switch contains all configuration requirements for a single contact center. A switch can be 

thought of as a partition of the ice system. 

In iceAdministrator, a switch can be expanded in the tree view to show the following folders: 

Users, Queues, Teams & Skills; Email Groups; UC Groups; and Workflow. Each folder represents a 

component of your contact center and is discussed in detail in the chapters that follow.  

Sometimes an ice system can be “shared” between two contact centers. In this scenario, each 

company can be configured with its own switch. 

A node is comprised of one switch or multiple switches. An ice server is essentially a node.  

A site is comprised of one node or multiple nodes. Multiple ice servers linked together form a 

site. 

 

Note: Creating sites, nodes, and switches is an advanced topic that requires license changes. If 

you have questions, please contact your account executive. Switches must be created using ice 

Database tools. License checks will occur before a switch is uploaded to a node.  

For a step-by-step guide on creating switches, refer to the DB tool user manual.  
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Permissions on iceAdministrator 

Permissions on iceAdministrator are based on your user type. 

There are seven user types: 

• User 

• Team Leader 

• Supervisor 

• Administrator 

• Node Administrator 

• Site Administrator 

• Global Administrator 

 

All user types, except for Users, have some level of access to iceAdministrator: 

• In the tree view, user type determines your ability to view sites, nodes, and switches.  

• Within a specific switch, user type determines your ability to view specific folders. 

• In the detail view, user type determines your ability to see configuration details for an item 

selected in the tree view. 
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Sites, Nodes, and Switches 

A user’s ability to view sites, nodes, and switches in the tree view and detail view of 

iceAdministrator is dependent on his or her user type. 

The table below describes the tree view and the detail view for each user type in relation 

to sites, nodes, and switches.  

User Types 

User Type Access to Sites, Nodes, Switches Icon 

User Users have no access rights to iceAdministrator.  

The primary function of a user is to log onto iceBar 

and handle contacts.  

Team Leader1 Team Leaders can view the Users, Queues, Teams, & 

Skills folder. They cannot access the Skills subfolder 

within this folder. They cannot view the Switch 

folder in the tree view or the detail view. They 

cannot view anything higher than the switch. 

 

Supervisor2 Supervisors can view the Users, Queues, Teams & 

Skills and the Workflow folders. They cannot view 

the Switch folder in the tree view or the detail view. 

They cannot view anything higher than the switch. 

 

Administrator3  Administrators can view all folders within the 

switch. They can view the Switch folder in the tree 

view, but cannot view the properties for the switch 

in the detail view. They cannot view anything higher 

than the switch. Administrators can create and 

modify users of the same level. 

 

Node 

Administrator4 

Node Administrators can view all folders for all 

switches within the node. They can view the Node 

folder in the tree view, but cannot view the 

properties for the node in the detail view. They 

cannot view anything higher than the node. Node 

Administrators can create and modify users of the 

same level. 

 

 
1 Can only see the team to which he or she belongs. 
2 Can only see the queue to which he or she belongs. 
3 Can only see the switch to which he or she belongs. 
4 Can only see the node to which he or she belongs. 
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User Types 

User Type Access to Sites, Nodes, Switches Icon 

Site 

Administrator5 

Site Administrators can view all details for all nodes 

within the site. They can view the Site folder in the 

tree view, but cannot view the properties for the site 

in the detail view. They cannot view anything higher 

than the site. Site Administrators can create and 

modify users of the same level. 

 

Global 

Administrator 

Global Administrators can view everything. This 

includes all details for all sites and the properties for 

each site. Global Administrators can create and 

modify users of the same level. 

 

  

 
5 Can only see the site to which he or she belongs. 
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The Tree View 

A switch can be expanded in the tree view to show sub-folders. Each folder represents a 

component of your contact center and will be discussed in detail in the chapters that 

follow. Your ability to view switch folders in the tree view is determined by your user type.  

The table below describes the folders that can be viewed in the tree view for each user 

type. A checkmark indicates the user can view the folder. 

User Type UQTS Email Groups UC Groups Workflow 6 

Team Leader   7  --  --  -- 

Supervisor 
   --  --   

Admin 
        

Node Admin 
        

Site Admin 
        

Global 

Admin 
        

UQTS = Users, Queues, Teams, & Skills 

Note: For more information about workflow, refer to the iceWorkflow Designer User 

Manual. 

 

  

 
6 The workflow folder includes audio messages, building blocks, holidays, and workflow variables. By default, 

building blocks are visible to users that have an administrator user type or higher, but a unique level of 

access can be applied to a building block. For more information, refer to the iceWorkflow Designer User 

Manual.  
7 Team leaders can only see queues and teams to which he or she is assigned, and other users assigned to 

the same teams. They cannot view the contents of the Skills folder. 
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The Detail View 

In general, a user with a user type of Team Leader or higher can click on an item in the 

tree view to see more information about that item in the detail view. For the Users, 

Queues, Teams & Skills folder, the information that a user can view in the detail view is 

dependent on the user’s type, as described below.  

 

Viewing users in detail view 

• You can view configuration details for yourself and for other users with a lower user 

type.  

• You can view configuration details for other users with an equal user type. 

 

Viewing queues and teams in detail view 

• You can view all details for a queue or team under the ‘Properties’ tab. 

• You can view users with a lower user type under the ‘User Assignments’ tab for a 

queue or team. 

• If you have an Administrator user type or higher, you can view other users with an 

equal or lower type on the ‘User Assignments’ tab for a queue or a team.  

• Global Administrators can view all details for any queue or team. 

Adding, Changing, or Deleting a User, Team, Queue, or Skill 

Adding, changing, or deleting other users 

• You can create a new user with a lower user type.  

• You can modify all proprieties for an existing user with a lower user type. 

• You can delete users with a lower user type. 

• An Administrator user type or higher can modify most of the properties for an 

existing user with an equal user type. The properties you cannot modify are User 

Name, User ID, User Type, and Password.  

• Global Administrators can create and delete all user types. They can also modify the 

properties of all other users, including other Global Administrators.  

 

Adding, changing, or deleting queues 

• A Supervisor user type or higher can create and modify queues.  
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• An Administrator user type or higher can delete queues8. 

• Global Administrators can create queues and modify or delete any queues.  

 

Adding, changing, or deleting teams 

• A Supervisor user type or higher can create, modify, and delete teams8.  

• Global Administrators can create teams and modify or delete any teams. 

 

Adding, assigning, or deleting skills 

• A Supervisor user type or higher can create, assign, and delete skills. 

• Global Administrators can create skills, assign, or delete any skills. 

 
8 You may be able to delete the queue or team even if a user with a higher type is assigned to the queue or 

team. In this scenario, the queue/team assignment of the user with the higher type is changed (i.e., the user 

is removed from the queue/team). This is the only time you can modify the properties of a user with a higher 

type. 
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Validating Data 

iceAdministrator checks the integrity of your work before saving it. If there are no errors, your 

changes are saved to the database. For more information on saving data, refer to page 35. 

You can run this integrity test without saving your data by using the ‘Validate’ feature. This allows 

you to check your data and can be useful if you are working offline. 

 

To validate your data: 

1. After you have made changes, select Validate from the File menu, or click the Validate button 

on the toolbar. 

Note: You can also validate data for a specific switch or for all of the workflow on a switch by 

right-clicking on the Switch folder or Workflow folder in the tree view and selecting Validate. 

If an error in your unsaved data is detected, a message box appears, prompting you to 

complete or change the relevant data. When you click OK, the iceAdministrator window 

containing the error appears. Once you fix the first error, you can validate your data again. It 

will find the next error and prompt you to fix it. This repeats until all errors have been fixed. 

The image below shows the message that appears when the properties of a workflow action 

have not been properly set. You are given the option of completing the action or of exporting 

the workflow to a file. For more information on exporting data, refer to page 227. If you select 

the ‘Complete Action’ radio button and click OK, you are taken to the workflow page 

containing the error. 

  

 

2. Once you have fixed the data containing errors, run the validation process again. 
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When the process is complete, and you have no errors, a message box appears. You are 

asked whether or not you wish to see a list of changes. 

3. Click Yes to see the ‘Show Modified Items’ dialog box. Click No if you do not want to see it. 

The ‘Show Modified Items’ dialog box example below shows the list of unsaved items in the 

system. The unsaved items in the tree are displayed in a different font colour. 
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Saving Data 

To save changes to the database: 

1. Select Save from the File menu or click on the Save icon ( ) in the toolbar. 

The ‘Progress’ dialog box appears. 

 

2. Click Cancel on the ‘Progress’ dialog box at any time to cancel the save operation. When you 

click Cancel, the following pop-up message box appears:  

 

3. Click OK to complete the cancel operation. 
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4. If iceAdministrator detects any errors in the changes you have made, you are prompted to 

complete or change the relevant data. For more information on validating data, refer to the 

previous section. 

When the save operation is complete, the ‘ice Server Response’ dialog box appears. Errors 

that prevent the database from being updated appear in the ‘ice Server Error Messages’ 

dialog box. 

To be certain that saved changes have been successfully applied to ice, it is important to wait 

for the successful server response. This message is shown below.  

 

 

5. Click OK to close the dialog box. 
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Quick Text Messaging 

Quick text messaging on iceAdministrator allows you to exchange messages with any users 

logged on to iceAdministrator, iceMonitor, or iceBar.  

 

To send a message: 

1. Right-click on a user in the tree view and select Quick Text… from the pop-up menu. 

The ‘Quick Text Message’ dialog box appears. 

2. In the ‘User ID’ field, enter the four-digit ID of the user to whom you wish to send a message. 

If you reached the ‘Quick Text Message’ dialog box by right-clicking on a user in the tree 

view, the user’s ID appears in the ‘User ID’ text box. 

3. From the ‘Priority’ drop-down list, select Low, Normal, or High. 

‘Normal’ is the default priority. 

4. Type the text of the message. 
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5. Click Send to send the message to the specified user. 

The user receives the message, as shown below. 

 

Note: 

• To send a message you can also select Send Quick Text Message from the File menu. 

• Users will receive messages even if they are logged off iceBar, as long as the application itself 

is open on their computer. 

• If the user to which you sent the message does not have iceBar, iceAdministrator, or 

iceMonitor opened on their computer, you will see the following error message: 
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• To respond directly to a user that has sent you a message, type your message in the lower 

portion of the window and click Send.  

• Quick text messaging is not available when you are working offline.





 

 

 

 

 

 

 

 

 

Chapter 2: Users 

iceAdministrator allows you to create, modify, and delete a user. A user might log 

on to iceBar to handle contacts, or a user might log on to the iceManager 

applications, as described below: 

• A user must specify a valid user ID and password to log on to iceBar. Queue 

assignments and features selected for the user ID affect the way that user can 

use iceBar. 

• A user must specify a user ID and password to log on to iceMonitor. The user 

type defined for the user ID determines the user’s level of access in 

iceMonitor. For more information on iceMonitor, refer to the iceMonitor User 

Manual. 

• A user must specify a user ID and password to log on to iceAdministrator. 

The user type defined for the user ID determines the user’s level of access in 

iceAdministrator. For information on permission levels and user types, refer 

to page 27. 

• A user must specify a user ID and password to gain access to iceReporting. 

The user type defined for the user ID can be used to determine the user’s 

level of access in iceReporting. For more information, refer to the 

iceReporting User Manual. 

The sections that follow describe how to view users, create and modify users, 

assign users to queues, assign users to teams, and delete users from ice.  

Note:  
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• iceAdministrator should be used by trained contact center staff. Before you begin 

modifying or creating users, you must be familiar with your current configuration.  

• To view and edit users you must have a user type that allows you to access the 

Users, Queues, Teams & Skills folder that is part of iceAdministrator’s tree view. 

This chapter assumes that you are familiar with the permissions on ice, as 

described in  
 

Chapter 1: Getting Started.  

• Changes to user properties are audited and visible in iceManager Audit Trails. For 

a complete list of audited objects, refer to the iceManager User Manual. 
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Password Security Policy 

A password security policy can be configured and applied to all users. This policy can set the 

frequency of required password changes and establish how failed logon attempts should be 

handled.  This policy applies to all users. Individual password security settings are also available 

for each user.  

 

To view and/or modify a password security policy: 

Click on the User folder under Users, Queues, Teams & Skills folder in the tree view. 

A Properties page appears in the Detail View. 

  

 

 

The table that follows describes each of the fields in the Password Security Policy. 

Password Security Policy 

Field Description Possible Values 

Min 

Duration 

between 

Password 

Changes 

The minimum amount of time that must pass 

between password changes. For example, if the 

value is set to 5d, users will not be able to 

change their existing password until 5 days 

have elapsed since the last password change. 

d = days 

h = hours 

m = minutes 
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Password Security Policy 

Field Description Possible Values 

Password 

Expires 

After 

The number of days after which the current 

password will expire. For example, if the value 

is set to 5d, users will be forced to change their 

password 5 days after their current password 

was set. Select the checkbox ‘never expire’ to 

disable this feature. 

d = days 

 

    never expire 

Max Failed 

Logon 

Attempts 

before 

Lockout 

The number of allowable failed logon attempts 

before a user will be locked out of the 

application. 

1 – 20  

No max = there will be 

no lockout for any 

users based on 

number of failed 

logons. 

Lockout 

Duration 

after Max 

Failed 

Logon 

Attempts 

The amount of time that an account will 

remain locked after the Max Failed Logon 

Attempts for that account is met. 

d = days 

h = hours 

m = minutes 

s = seconds 
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Routing 

Routing settings can be configured and applied to all users. The settings configured on the 

properties page can enable MS Teams Direct Routing and Block PSTN Remote DN for all users.  

Individual routing settings are also available for each user.  

 

To view and/or modify a routing setting: 

Click on the User folder under Users, Queues, Teams & Skills folder in the tree view. 

A Properties page appears in the Detail View. 

  

 

Note: You must have Global Administrator privileges to modify these settings. 

 

The table that follows describes each of the fields in Routing settings. 

Routing 

Field Description 

Default 

User MS 

Teams 

Direct 

Routing 

If this setting is enabled, by default, all new users will have Use MS Teams 

Direct Routing enabled in their Connections tab. 

Note: This will not apply to users who have already been created. If you 

wish to enable or disable MS Teams Direct Routing for existing agents, 

you will need to manually update the setting.  
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Routing 

Field Description 

Default 

User Block 

PSTN 

Remote 

DN 

If this setting is enabled, by default, all new users will have Block PSTN 

Remote DN enabled in their Connections tab. 

Note: This will not apply to users who have already been created. If you 

wish to enable or disable Block PSTN Remote DN for existing agents, you 

will need to manually update the setting. 
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Viewing a User  

You may wish to view a user if you are planning to change the way that he or she handles 

contacts, change the user’s queue assignments, change the user’s team assignments, or delete 

the user from ice.  

Viewing a user involves finding and selecting the user in the tree view. When a user is selected, 

the right side of the iceAdministrator window displays seven tabs detailing the user’s 

configuration.  

Note: To view a user, you must have a user type that allows you to access the Users, Queues, 

Teams & Skills folder that is part of iceAdministrator’s tree view. For information on permission 

levels and user types, refer to page 27.  

 

To view a user: 

1. Open the Users, Queues, Teams & Skills folder in the tree view.  

2. Open the Users folder in the tree view. 

  

3. Click the user in the tree view whose configuration you wish to view. 

Six tabs appear in the detail view: Properties, Connections, Class of Service, Call Forwarding, Queue 

Assignments, and Skills. These tabs allow you to select one of the six pages that hold information 

about the user’s configuration. 
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By default, the ‘Properties’ page is displayed.  

   

 

 

This section explained how to navigate to an existing user. The sections that follow describe how 

to add and modify settings for a user. 
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Adding a User 

There will be instances where you need to add new users, perhaps to accommodate new staff. 

There are several ways to add a user: 

• Right-click Users and select New User. This allows you to create one user with iceAdministrator’s 

default properties.  

• Right-click Users and select New User(s). This allows you to create one user or multiple users. This 

feature can be helpful if you want new users to have the same properties as an existing user in 

your contact center. 

• Right-click Users and select Active Directory Import. This allows you to import multiple users from 

Active Directory. This feature is useful when your users have already been set up in Active 

Directory. 

• Add new user through the standalone ‘Active Directory Import Tool.’ This allows a user who does 

not have access to iceAdministrator to export a list of ice users that can later be uploaded to 

iceAdministrator. 

• Add a new user when setting up workflow. This allows you to create users on the spot as 

workflow is being developed. For more information on workflow, refer to the iceWorkflow 

Designer User Manual. 

Once you have added a new user, you can configure unique properties for that user. For 

information on completing configurable properties for users that you have just created or for 

modifying settings for an existing user, refer to page 65. 

Note: To add a user, you must be in Edit Mode and have a user type that allows you to access the 

Users, Queues, Teams & Skills folder. For information on permission levels and user types, refer to 

page 27. 

 

To add a new user, complete the following steps: 

1. Open the Users, Queues, Teams & Skills folder in the tree view. 

2. Right-click on the Users folder. 
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A menu appears. 

 
 

 

3. Select New User from the menu. 

You may also right click on a queue that you have already created to select the New User option. 

In this case, the new user is created and is assigned to the queue.  
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Six tabs appear in the detail view. By default, the Properties page is displayed. 

 

   

 

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

This section has explained how to add a user to the tree view with iceAdministrator’s default 

properties. For information on modifying properties for the user that you have just created, refer 

to page 65. The section that follows describes how to add multiple users to the tree view. 

Note: After adding a new user, the default password for the new account is dependent on the 

minimum password length. By default, the minimum password length is set to 3, making the 

default password 123. However, if the minimum password is set to 6, the default password will be 

123456.  
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Adding Multiple Users 

iceAdministrator allows you to create multiple users simultaneously: 

• You can add users based on iceAdministrator’s default properties for a user, which is very 

similar to adding a ‘New User’, as described in the previous section.  

• You can add users based on an existing user’s configuration, which is referred to as the 

‘Template.’ This feature can be helpful if you want new users to have the same properties 

as the existing users in your contact center.  

Once you have created the users, you need to configure them so that they have unique 

Connection Addresses, Call Forwarding rules, etc. For information on modifying 

properties for users, refer to page 65.  

 

To add multiple users to the tree view: 

1. Open the Users, Queues, Teams & Skills folder in the tree view. 

2. Right-click on the Users folder. 

A menu appears. 

 

  

3. Select New User(s) from the menu. 

A message box appears. 
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4. Click Yes to continue. Click No to cancel the process. 

The ‘Create New Users’ dialog box appears. 

 

 

5. Select the number of users you wish to create from the ‘Number of Users to create’ drop-

down list. 

6. Select the starting user ID from the ‘Starting ID’ drop-down list. 
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This ID is assigned to the first user. The remaining users are assigned the next available 

IDs.  

7. Select the ‘Default’ radio button if you would like the users to have iceAdministrator’s 

default user configuration. 

You can also select ‘From Template’ if you would like each user to have the same 

configuration as an existing user. When the ‘From Template’ radio button is selected, you 

can choose a user in the ‘Choose Template’ table. 

In the following illustration, Liam Gerbert (user ID: 1000) has been selected as the 

template. 

  

4. Click OK to create the new users. 

The users appear in the tree view. 
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5. From the File menu, choose Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 

This section has explained how to add multiple users to the tree view. You may need to 

configure the new users so that they have unique connection addresses, Call Forwarding 

rules, etc. The sections that follow provide more information on configuring a user. 

Importing Users from Active Directory 

iceAdministrator allows you to import multiple users from Active Directory: 

• You can add users within iceAdministrator using the Active Directory Import 

• You can use the standalone Active Directory Import Tool if you do not have access to 

iceAdministrator.  

When you import users from Active Directory their unique Connection Addresses will 

already be configured. For information on modifying properties for users, refer to page 

65.  

 

To Import Users with the Active Directory Import Tool: 

1. If using the standalone Active Directory Import Tool open the application and proceed to 

step 11. 

2. Open the Users, Queues, Teams & Skills folder in the tree view. 

3. Right-click on the Users folder. 
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4. A menu appears. 

 

5. Select Active Directory Import from the menu. 

6. A message box appears. 

 

7. Click Yes to continue. Click No to cancel the process. 
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8. The ‘Active Directory Importer’ dialog box appears. The Azure AD Tenant ID and the ice 

Application ID fields will be automatically populated. 

 

9. Click Add User. If you logged into iceAdministrator with your ice credentials, you will be 

asked to login with your single sign-on credentials at this step. If you logged into 

iceAdministrator with SSO, proceed to the next step. 
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10. The ‘Azure AD Search’ dialog box appears. 

 

11. Enter the name of the user you wish to add.

 

12. Select the user you wish to import and click OK. 

13. In the original Active Directory Importer window you will see the new account added. 

14. Click Import Users to import the user or click Add User to add another user.  

Note: If you are using the standalone Active Directory Import Tool you will need to export 

users by clicking on Export Users to File. This exports an .XML file that iceAdministrator can 

recognize. 

 

Active Directory Import Tool 

Field Description 

Reset This button resets all configurations in the Active Directory Import 

Tool to default, including removing any users you may have 

added to the Active Directory Users list.  

Add User Add user or group of users to the Active Directory Users list. 

Remove User Remove user from the Active Directory User list. Select user in the 

‘Active Directory Users’ list and click Remove User. 
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Active Directory Import Tool 

Field Description 

Export Users to 

File 

Export users to an .XML file that can be uploaded to 

iceAdministrator. 

Active Directory 

Users 

List of users ready to be imported to iceAdministrator or exported 

to file. 

 

Active Directory Link and Unlink 

If you would like to link existing ice users with their Active Directory credentials, follow 

the steps below. 

1. Open the Users, Queues, Teams & Skills folder in the tree view. 

2. Open the Users folder. 

  

3. Select the applicable user from the list. 

The user’s profile opens on the right. 

 

4. In the Active Directory section, click the Link button. 
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5. The ‘Active Directory Importer’ dialog box appears. The Azure AD Tenant ID and the ice 

Application ID fields will be automatically populated. 

 

6. Click Add User. If you logged into iceAdministrator with your ice credentials, you will be 

asked to login with your single sign-on credentials at this step. If you logged into 

iceAdministrator with SSO, proceed to the next step. 
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7. The ‘Azure AD Search’ dialog box appears. 

 

8. Enter the name of the user you wish to link.  

 

9. Select the user you wish to import and click OK. 

10. In the original Active Directory Importer window you will see the new account added. 

11. Click Import Users to link the user.  

12. In the Active Directory section of the user’s profile, the Azure GUID has been linked. 
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To unlink the Azure Directory credentials from the ice user, click Unlink. 

Remember to save your changes. 

Auto Link Email on First Login 

The “Auto Link on First Login” setting must first be enabled by a Global Administrator in 

iceManager Core Settings in order for the steps described below to take effect. If this 

setting is not enabled, please contact Computer Talk for assistance. 

When this setting is enabled, a single-sign on user who logs in to iceBar without an 

assigned Azure AD GUID in their ice profile can be auto-linked. If a single-sign on user 

logs in and their token does not match an assigned Azure AD GUID, iceIdentity 
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determines if their email is a match for any configured ice agents. If a match is found, the 

user’s Azure AD GUID is assigned to the ice agent and the login is allowed to proceed. 

Note: ice agents must have an email configured for their profile for a match to be found.  

When configuring SSO, the users can be linked to the SSO GUID upon import or can be 

configured to auto-link the GUID upon first login. 

Adding a User from the Properties of a Workflow Action 

On the properties page of specific workflow actions that require the selection of a user 

(e.g., User Control), you can create a new user by using the appropriate drop-down list. 

For more information on workflow actions, refer to the iceWorkflow Designer User 

Manual.  

 

To create a user from the properties dialog box of a workflow action: 

1. From the workflow page, double-click the action from which you would like to create the 

user. 

2. In the field that requires a user, select <NEW USER> from the drop-down list. 

The following screenshot shows the User Control properties page: 

 

You can also right-click the arrow in the drop-down list and select User from the menu 

that appears.  
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The ‘Select User’ dialog box appears. 

 

3. Click Create New... on this dialog box. 

4. The ‘New User’ dialog box appears. This dialog box has the same six configuration tabs as 

the ones that appear when you create a user from the tree view. 

5. Click OK on this dialog box to add the user. 

6. The user is added to the tree view and becomes the selected option in the workflow 

action field. 

7. From the File menu, choose Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 
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User Properties 

You may wish to modify an existing user to reflect staffing changes, or you may wish to configure 

a user that you have just created.  

Note: 

• To modify a user, you must be in Edit Mode and have a user type that allows you to access the 

Users, Queues, Teams & Skills folder that is part of iceAdministrator’s tree view. For information 

on permission levels and user types, refer to page 27. 

• When you have made all your changes, from the File menu, choose Save. (To cancel the save 

operation, click Cancel on the ‘Progress’ dialog box.) 

Updating User and User Type 

A user’s name appears on ice reports. User type determines permissions allowed to the 

user. For more information on user types and permissions, refer to  

 

Chapter 1: Getting Started.  

 

To modify a user’s name or user type: 

1. Navigate to the user that you wish to customize or modify. 

The ‘Properties’ page for the selected user appears in the detail view.  

2. Enter the name of the user in the ‘User Name’ field. 

 

The user’s name can be up to 40 characters in length. 

3. From the ‘Type’ drop-down list, select the appropriate user type. 

 

For more information on user types, refer to the ‘User Types’ table on page 28. 

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 

This section has explained how to configure user names and user types. The section that 

follows provides information on changing a user’s ID. 
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Changing a User ID 

A user ID is required to log on to iceBar, iceMonitor, iceAdministrator, etc.  

 

To modify a user ID: 

1. Navigate to the user that you wish to customize or modify. 

The ‘Properties’ page for the selected user appears in the detail view.  

2. Click Change User ID.  

The Change User ID dialog box appears. 

  

You may click Cancel to close the window without changing the user ID.  

3. Select a four-digit number from the ‘User ID’ drop-down list and enter the user’s 

password in the ‘Password’ field.  

The drop-down list shows user ID numbers that are not in use.  

The user’s password is required to change the user’s ID. The default password is 123. If an 

invalid password is entered, an error message appears. Click OK on the error message to 

return to the Change User ID dialog box and re-enter the password.  

 

Note: The default password is dependent on the minimum password length. By default, 

the minimum password length is set to 3. However, if the minimum password is set to 6, 

the default password will be 123456.  

 

4. Click OK on the Change ID dialog box.  

5. The new user ID is displayed in the ‘User ID’ field. 

6. From the File menu, choose Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.). 

 

.   
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User Account Expiration 

A user account can be configured to expire on a particular date. For example, if you have 

a temporary employee or contractor, you can ensure that their account is automatically 

disabled after their last scheduled day of employment. By default, the Account Expiration 

Datetime is set to ‘None.’ 

 

To set account expiration:  

1. Navigate to the ‘Properties’ page for the user you wish to modify.  

 

2. Uncheck ‘None’ 

 

 
 

3. The field will populate with today’s date, with midnight as the time. 

 
4. Click on the down arrow to display a calendar.  

 
5. Select the desired date from the calendar. To specify a time, highlight the time and click 

the spin box arrows to edit it.  

 

6. Save your changes. For information on user passwords, refer to page 68. 

This section has explained how to configure a user ID. The section that follows provides 

information on resetting a user’s password. 
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User Password 

In addition to a user ID, a password is required when a user logs on to iceBar, 

iceAdministrator, iceMonitor, etc. The default password for a new user is 123.   

 

To modify a user’s password: 

1. Navigate to the user that you wish to customize or modify. 

The ‘Properties’ page for the selected user appears in the detail view.  

2. Click Reset Password to modify the user’s password.  

The Reset Password dialog box appears.  

 

Click Cancel to close the window without changing the password.  

3. Enter the new password in the ‘New Password’ field and retype the new password in the 

‘Re-type New Password’ field.  

If the minimum password length is set to 3, the password can be from 3 to 31 numeric 

characters in length.   

Note: Users are able to reset their own passwords from iceBar. For more information, 

refer to the iceBar User Manual.  

 

4. Click OK to set the new password and close the ‘Reset Password’ dialog box.  

5. From the File menu, select Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 

This section has explained how to reset a user password. The section that follows 

provides information on remote user properties. 
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To force a password change upon next logon: 

1. Select the ‘Force Password Change on Next Logon’ checkbox. 

 

2. From the File menu, choose Save. 

The specified user will be prompted to change their password the next time he/she logs 

on to any ice application. 

 

To ensure that a user’s password never expires: 

1. Select the “Never Expire” Checkbox. 

 

2. From the File menu, choose Save. 
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Connections 

To configure ice server connection properties for a specific user, navigate to the ‘Connections’ tab 

for that user. 

Note: To modify a user, you must be in Edit Mode and have a user type that allows you to access 

the Users, Queues, Teams & Skills folder that is part of iceAdministrator’s tree view. For 

information on permission levels and user types, refer to page 27. 

 

To modify a user’s Connections: 

1. Navigate to the user that you wish to customize or modify. 

The ‘Properties’ page for the selected user appears on the right side of the iceAdministrator 

window.   

2. Click the Connections tab to bring that page to the front. 
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User Connections 

When a user logs on to iceBar, a call is placed from the ice server to the address in the 

Connection Address/Remote DN field (i.e., their phone line, Skype for Business account or 

Microsoft Teams account at the user’s workstation.) When the user answers the call, a 

voice connection to ice is established. 

When configuring a user, you must enter the connection address or the Directory 

Number (DN) at which ice can reach this user when he or she logs on to iceBar. The 

connection address is a phone number or SIP address that is routed through Skype for 

Business or Microsoft Teams. Any workstation with iceBar, a dedicated phone line, or a 

TCP/IP connection to the ice server can be set up as a remote workstation. 

To configure a user’s Connections: 

1. Navigate to the user’s ‘Connections’ tab. 

2. Enter the phone number or SIP address associated with the Skype for Business or 

Microsoft Teams account of that user in the ‘Connection Address/Remote DN’ field. If 

using icePhone, the connection address field can be left empty. 

 

 

The Connection Address/Remote DN field can hold up to 256 characters. 

 

3. Check ‘Password Callback’ if you would like ice to call the user each time the user logs on 

to iceBar.  
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The purpose of this feature is to confirm that the user is at the specified address. The user 

is required to enter his/her ice password to verify his/her identity.  

 

4. Check ‘Use MS Teams Direct Routing’ if you would like the agent’s calls to use the 

dedicated Direct Routing phone lines. 

Note: 

• This option is only available for customers hosted on ComputerTalk’s 

environment. 

• Setup is required on both ComputerTalk’s environment and your Office 365 

tenant. 

• Users must have a line URI assigned to each account; this can be a DID or an 

internal extension. 

• Each agent requires an E5 or E3+ phone system add on (license). 

 

5. Check ‘Block PSTN Remote DN’ if you would like to restrict agents to SFB Federation or 

Teams Direct Connect for Agent Remote DN Callbacks. This is to restrict agents when 

PSTN trunks are not dedicated for agent callbacks.  

6. From the File menu, choose Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 

This section has explained how to configure remote user connections. The section that 

follows provides information on email user connections. 

Email Connections 

ice allows your users to handle queued email messages. If your contact center handles 

emails, select the ‘Can Handle Email Contacts from ice’ checkbox in the iceAdministrator 

user profile. Only users with this feature enabled are eligible to receive queued email 

messages. 

 

To configure email settings: 

1. Select ‘Can Handle Email Contacts from ice’ to allow this user to handle queued email 

messages. 

2. Select ‘Use Connection Address’ to have emails sent to the user’s connection address. If 

your Connection Address is not linked to an email account, select ‘Use This Address’ and 

enter the address for your email account.  
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3. From the File menu, select Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 

 

Note: 

• Users with the ‘Can Handle Email Contacts from ice’ feature enabled can handle email 

messages only, email messages and calls, or another combination of contacts. In order to 

handle email contacts the user must be assigned to an email queue and must be logged 

into the email queue on iceBar. For more information, refer to the iceBar User Manual. 

• Use the User Control action to retrieve a user’s email address in workflow. This is useful if 

you have workflow requirements to email information to specific users. For example, 

workflow can be configured to send a warning email message to a supervisor when all of 

the users log off from a queue during business hours. 

This section has explained how to configure email properties. The section that follows 

provides information on instant messaging connections. 

 

IM Connections 

ice allows your users to handle queued instant messages (IM).  

 

To configure IM settings: 

1. Check ‘Can Handle IM Contact from ice’ to allow user to handle queued IMs. 

2. Check “Use ACS” if using icePhone to handle chat contacts. This will auto-populate and 

lock the address field. 

 

3. Select ‘Use Connection Address’ to have IMs sent to the user’s connection address. Select 

‘Use This Address’ to have IMs sent to a different address.  
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The user’s IM address can be up to 255 characters in length. 

4. From the File menu, select Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 

 

Note: 

• Users with the ‘Can Handle IM Contacts from ice’ feature enabled can handle IM 

messages only, IM messages and calls, or another combination of contacts. In order to 

handle IM contacts the user must be assigned to an IM queue and must be logged into 

the IM queue on iceBar. For more information, refer to the iceBar User Manual. 

• Use the User Control action to retrieve a user’s IM address in workflow. 

This section has explained how to configure IM properties. The section that follows 

provides information on auto logon properties. 
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Auto Logon Properties 

Auto Logon allows users to automatically log on each time the ice server is restarted. You 

can select the queues to which the user will automatically log onto, using the drop-down 

list.  

 

To enable Auto Logon: 

1. Enable the ‘Auto Logon’ checkbox on the ‘Connections’ tab. 

  

2. Select ‘All Assigned Queues’ or a specific queue from the ‘Queue’ drop-down list. 

The user is automatically logged on to the selected queue(s) each time the ice server is 

restarted. 

3. From the File menu, select Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 

Note: If the user is not assigned to any queues, ‘All Assigned Queues’ will be the only 

option available in the ‘Queues’ drop-down list. 

This section has explained how to configure auto logon properties. The section that 

follows provides information on Image URL. 

Image URL 

Image URL configuration is only required for iceMonitor settings. The image URL is the 

picture file you want to use as your ice display picture.  

 

To configure Image URL properties: 

1. In the ‘Image URL’ field, enter the URL associated with the image displayed for the user. 

  

2. From the File menu, select Save. To cancel the save operation, click Cancel on the 

‘Progress’ dialog box. 

 

This section has explained how to configure display picture properties. The section that 

follows provides information on class of service features. 
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Class of Service Features 

Class of Service features are used to determine user privileges with respect to iceBar and the 

manner in which a user handles contacts.  

Note: To modify a user, you must be in Edit Mode and have a user type that allows you to access 

the Users, Queues, Teams & Skills folder that is part of iceAdministrator’s tree view. For 

information on permission levels and user types, refer to page 27. 

 

To modify a user’s Class of Service features: 

1. Navigate to the user that you wish to customize or modify. 

The ‘Properties’ page for the selected user appears on the right side of the iceAdministrator 

window. 

2. Click the Class of Service tab to bring that page to the front. 

   

  

3. Check the checkbox(s) beside the appropriate class of service feature(s) for the user. 

For more information on the features, refer to the sections that follow. 
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4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

This section has explained how to configure a user’s class of service features.  The sections that 

follow provide detailed information on each class of service feature.  

Allow Multi Contact Handling 

By default, a user enters an On Contact state (eg., On Call, On IM, or On Email) upon 

receiving a queued contact. The user remains in the On Contact state until he or she 

releases the contact. Pressing the Ready or Not Ready button while in an On Contact state 

determines the state to which the user returns (i.e., Ready state or Not Ready state) when 

the contact is released.  

When ‘Allow Multi Contact Handling’ is checked, the user can handle multiple contacts at 

the same time. For example, while handling a voice contact the user can be alerted to 

handle an IM or Email contact as well.  

• Max Concurrent IMs: limit the number of IMs or SMS that this user can handle at 

the same time. 

• Max Concurrent Emails: limit the number of emails that this user can handle at 

the same time. 

 

Note: 

• Only 1 voice contact can be handled at one time. 

• For example, if the user has the Max Concurrent IMs field set to 3 and Max 

Concurrent Emails field set to 3, this agent can handle 3 IMs, 3 emails, and 1 voice 

contact at the same time. 

• IMs and SMS contacts are both categorized as IMs in ice. Therefore the Max 

Concurrent IMs limit applies to IMs and SMS. For example, if the user has the Max 

Concurrent IMs field set to 3, they can handle 3 IMs or SMS. This includes the 

following scenarios: 

o Only IMs: 3 IMs, 0 SMS 

o Only SMS: 0 IMs, 3 SMS 

o  A combination of IMs and SMS contacts: 2 IMs, 1 SMS 

 

For more information on IM and Email handling, refer to the iceBar User Manual.  
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Auto Answer Calls 

By default, a user hears one beep in his or her headset when a call arrives at his or her 

workstation. The user connects with the call by clicking the Answer button on iceBar.   

When ‘Auto Answer’ is checked, the user is automatically connected to each call that 

reaches his/her workstation, provided that the user is in the Ready state and the phone is 

off-hook. 

Note: If a phone is on-hook when the call arrives, it rings, and the user is automatically 

connected to the call when the phone becomes off-hook. 

Only require answer button when off-hook 

By default, when ‘Auto Answer’ is disabled, a user must press the Answer button to 

answer calls, when the phone is on-hook and off-hook.  

When ‘Only require answer button when off-hook’ is checked, the user will only need to 

press the Answer button when the phone is off-hook. 

Auto Answer Email or IM 

By default, the user must click Answer on iceBar Toolbar to be connected with the email 

or IM that alerts at his/her workstation.  

When ‘Auto Answer Email or IM’ is checked, the user is automatically connected to each 

IM or email message that is presented.  

Disable Auto Not Ready 

By default, the user is put into the Not Ready state after a contact that alerted at his/her 

workstation goes unanswered. This default setting is recommended for contact center 

users.  

When ‘Disable Auto Not Ready’ is checked, the user stays in the Ready state after a 

contact that alerted at the workstation goes unanswered. 
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Disable PAQ Queuing 

By default, a user’s direct calls wait in the user’s Personal Access Queue (PAQ) when the 

user is in Not Ready state or if the user is already handling a contact. Direct calls are calls 

that did not come from a queue.  

Consider the following examples of direct contacts: 

• A user-to-user call. 

• Your contact center provides a number to family and friends, allowing them to reach 

a specific user. When the family member or friend calls the number, he or she is 

prompted to enter the four-digit user ID.  

• The caller is transferred directly to the user from another user.  

When ‘Disable PAQ Queuing’ is checked, the user’s direct calls are automatically 

redirected to the dial number for PAQ Overflow when the user is in Not Ready state or if 

the user is already handling a contact. The caller is not queued in the user’s PAQ. If ‘PAQ 

Overflow’ is not enabled, the caller receives a busy signal. For more information on ‘PAQ 

Overflow’ and call forwarding, refer to page 92. 

Note: If PAQ Overflow is disabled and the direct call originates in workflow, workflow can 

be designed to route the caller elsewhere if the user is in Not Ready state or handling 

another contact. For example, the caller could be routed to a queue. 
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Emergency Contact 

By default, a user is not an emergency contact. 

When ‘Emergency Contact’ is checked, ice considers the user to be an emergency contact.  

ice looks for an emergency contact when a user submits an emergency request by 

clicking the iceBar Emergency button.  

To receive notification of an emergency request, the emergency contact must be logged 

on to iceBar and must belong to one of the same queues as the requesting user. ice scans 

for the emergency contact who has been idle the longest and is in the Ready state. If no 

emergency contacts are found in the Ready state, ice scans for the emergency contact 

who has been idle the longest and is logged on. 

When a suitable emergency contact is found, ice sends a message to the emergency 

contact through iceBar. 

 

When no emergency contact can be found, the requesting user receives the following 

message. 

 

For more information, refer to the iceBar User Manual.  
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Enable Cleardown 

By default, the ‘Enable Cleardown’ feature is disabled.  

When ‘Enable Cleardown’ is checked, a fastbusy tone is played to ensure that a user does 

not get another call until the phone is placed on-hook. The fastbusy tone is played when 

the other party hangs up first and on the termination of a dial tone, a busy signal, and 

other tones. The fastbusy tone is played until the user places the phone on-hook.  

Consider the following example of when the ‘Enable Cleardown’ feature can be used: 

Users have handsets, and the ‘Auto Answer Calls’ class of service is enabled. There is a 

chance that users are presented with a call while they are hanging up their phone. If 

‘Enable Cleardown’ is enabled, then the user can hang up the phone after completing a 

call without fear of disconnecting an incoming caller.  

Drop ice User Line Between Calls 

By default, the ‘Drop ice User Line Between Calls’ feature is disabled. ice keeps the user 

off-hook, so the user is constantly on a call with the ice server. 

When ‘Drop ice User Line Between Calls’ is checked, ice will hang up the call to the user, 

after the caller has disconnected.  

This feature takes precedence over Enable Cleardown, described above. 

Logon to Not Ready 

By default, a user enters the Ready state as soon as he/she logs on to ice. Users who log 

on to Ready state must be prepared to handle contacts immediately upon log on.  

When ‘Logon to Not Ready’ is checked, the user enters the Not Ready state as soon as 

he/she logs on to ice and does not receive a queued contact until he/she is in the Ready 

state. 

Disable Whisper 

By default, a user hears a “whisper” message when it has been configured in workflow. A 

whisper announces the purpose of the call. For more information on whisper, refer to the 

Set User Whisper action in the Workflow Designer User Manual. 

When ‘Disable Whisper’ is checked, the user will not hear the User Whisper message, 

even when it is configured in workflow. 
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Recording Notification 

ice has the ability to provide conversation recording. Recording Notification is only 

relevant for contact centers using recordings. By default, the user does not receive any 

notification of being recorded.  

When Recording Notification is enabled, the user sees the Recording Notification button 

flashing when they are being recorded, provided that this iceBar button has been 

configured.  

Note: If the ‘User Initiated Recording’ feature is enabled in iceManager, a user can click 

on the Recording Notification button during a call that is not already being recorded to 

initiate a recording of the call.  

Recording Error Notification 

ice has the ability to provide conversation recording. ‘Recording Error Notification’ is only 

relevant for contact centers using recordings.  

By default, the user does not receive notification of any recording errors that may occur, 

unless the recording was self-initiated. 

When ‘Recording Error Notification’ is enabled, the user sees a message box with the 

appropriate error message if a recording error occurs during a call.  

If the recording is ‘Supervisor Initiated’ and a recording error occurs, the user does not 

see an error message even when Recording Error Notification is enabled.  

Note: The most common errors are those having to do with scheduled recordings, which 

cannot be started due to low disk space or the unavailability of recording resources.  

Send Callers ANI to User Device 

With this class of service enabled, the caller’s ANI (i.e., name and phone number) is sent 

to the user’s phone, Skype for Business or Microsoft Teams client.   

With this class of service disabled, the information presented to the physical 

phone/device will be the configured UC Group settings.  The caller’s ANI information 

would be displayed only in iceBar, as Originator Name and Originator Number.  
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Silent Monitoring Privilege 

‘Silent Monitoring Privilege’ is available to Team Leader user types and higher. By default, 

the user cannot perform silent monitoring of other users. 

When ‘Silent Monitoring Privilege’ is enabled, the user can perform silent monitoring of 

other users if they satisfy the following conditions:  

• The user has the appropriate user type to be monitoring the target user;  

• The user is assigned to at least one queue to which the target user is also assigned; 

• The user has the Silent Monitoring button configured on iceBar.  

Note: For the target user to receive notifications that they are being silent monitored, the 

Silent Monitoring button has to be configured on iceBar and the Silent Monitoring 

Notification class of service checked. 

For more information on silent monitoring, refer to the iceBar User Manual. 

Silent Monitoring Notification 

By default, the user does not receive any notification of being silently monitored. 

When ‘Silent Monitoring Notification’ is enabled and the button is configured on iceBar, 

the Silent Monitoring button flashes to notify the user when his/her calls are being 

monitored. 

Screen Monitoring Privilege 

‘Screen Monitoring Privilege’ is available to Team Leader user types and higher. This class 

of service is only available after the ‘Silent Monitoring Privilege’ is checked. By default, the 

user cannot perform screen monitoring of other users. 

Similar to ‘Silent Monitoring Privilege’, when ‘Screen Monitoring Privilege’ is enabled, the 

user can perform screen monitoring of other users if they satisfy the following conditions: 

• The user has the appropriate user type to be monitoring the target user;  

• The user is assigned to at least one queue to which the target user is also assigned; 

• The user has the Silent Monitoring button configured on iceBar; 

• Screen Recording is enabled and installed. 
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Play Call Waiting Tone 

By default, the user does not hear any call waiting notification. 

When ‘Play Call Waiting Tone’ is enabled, the user hears a beep in his/her headset if there 

is a call waiting in his/her PAQ. The user hears one beep per call, up to a maximum of 4 

beeps. The user also hears a beep if the number of calls waiting in the PAQ drops. 

Virtual User 

This class of service is reserved for users that are used exclusively to integrate ice to third-

party IVR systems. This feature should remain unchecked for all other users. 

Wrapup After Queued Call 

By default, the user returns to the Ready state upon completion of a queued call. An 

exception to this rule occurs when a user picks a call out of a queue while in the Not 

Ready state. In this case, the user returns to the Not Ready state upon completion of the 

call.  

Note: A user can change his/her state while on a call, in which case the user remains in 

the state they have selected upon completion of the call. 

When ‘Wrapup After Queued Call’ is checked, the user enters the Wrapup state upon 

completion of a queued call. Each Queue’s ‘Auto Wrap’ timer determines the length of 

time that a user stays in Wrapup state. 

This can be used to ensure that users have time to record Line of Business (LOB) codes, 

which describe the reason for the call.  For more information on configuring LOB codes, 

refer to the iceBar User Manual. 

Wrapup After Placed Call 

By default: 

• If the user is in Ready state or in Wrapup state when placing a call, the user returns to 

Ready state upon completion of the call. 

• If the user is in Not Ready state when placing a call, the user returns to Not Ready 

state upon completion of the call. 

When ‘Wrapup After Placed Call’ is enabled, the user enters the Wrapup state upon 

completion of a placed call. The ‘Auto Wrap Time’ that is selected for the user 

determines the length of time that the user stays in Wrapup state after a placed call. 
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The ‘Auto Wrap Time’ drop-down list becomes available when you enable ‘Wrapup 

After Placed Call.’ 

Not Ready Cancels Timed Wrapup 

By default, when the user is in a timed Wrapup (i.e. it will expire after a set period and is 

not set to infinite) and selects a not ready reason, they will enter into a pending not ready 

state. When the timed Wrapup automatically ends, the user will enter into a Not Ready 

state.  

When ‘Not Ready Cancels Timed Wrapup’ is enabled, a user who selects a Not Ready 

Reason while in timed Wrapup will immediately enter the Not Ready state chosen. 

Selecting a Not Ready Reason will automatically cancel the timed Wrapup and set the 

user to Not Ready. 

Request to Select Next Contact 

By default, if the user has ‘Allow Multi Contact Handling’ enabled, the user can handle 

multiple contacts at the same time. For example, the user can be alerted to handle IM and 

Email contacts while handling a voice contact. 

When ‘Request to Select Next Contact’ is enabled, the user can manually choose when 

they are presented with their next contact. If a user is handling a contact, they will not be 

automatically alerted for additional contacts. To handle additional contacts at the same 

time, the user will need to select the ‘Request New Contact’ button on their iceBar. 

For example, a user handling a voice call will not be alerted for an additional Email or IM 

contact in queue until they select the ‘Request New Contact’ button on their iceBar. 

For more information on how to use the button, refer to the iceBar User Manual. 

Disable Voice while on IM 

By default, if the user has ‘Allow Multi Contact Handling’ enabled, they can handle voice, 

IM, and/or email contacts at the same time. 

When ‘Disable Voice while on IM’ is enabled, the user will not receive voice contacts while 

on an IM. 
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Disable Voice while on Email 

By default, if the user has ‘Allow Multi Contact Handling’ enabled, they can handle voice, 

IM, and/or email contacts at the same time. 

When ‘Disable Voice while on Email’ is enabled, the user will not receive voice contacts 

while on an email. 

 

Disable IM while on Voice 

By default, if the user has ‘Allow Multi Contact Handling’ enabled, they can handle voice, 

IM, and/or email contacts at the same time. 

When ‘Disable IM while on Voice’ is enabled, the user will not receive IM contacts while 

on a voice contact.  

 

Disable IM while on Email 

By default, if the user has ‘Allow Multi Contact Handling’ enabled, they can handle voice, 

IM, and/or email contacts at the same time.  

When ‘Disable IM while on Email’ is enabled, the user will not receive email contacts while 

on an IM.  

 

Disable Email while on Voice 

By default, if the user has ‘Allow Multi Contact Handling’ enabled, they can handle voice, 

IM, and/or email contacts at the same time. 

When ‘Disable Email while on Voice’ is enabled, the user will not receive email contacts 

while on a voice contact.  

 

Disable Email while on IM 

By default, if the user has ‘Allow Multi Contact Handling’ enabled, they can handle voice, 

IM, and/or email contacts at the same time. 



 

 

 

  
  

87 iceAdministrator User Manual 

When ‘Disable Email while on IM’ is enabled, the user will not receive email contacts while 

on an IM.  

 

Not Ready Reason  

The Not Ready Reason field becomes available once you have enabled ‘Logon to Not 

Ready.’ This will enable you to select the Not Ready Reason code that will be displayed 

when the user first logs in. This will be visible on iceMonitor and reported in iceReporting.  
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Auto Wrap Time(s) drop-down 

The default setting for the ‘Auto Wrap Time’ for calls is ‘Infinite’ seconds. With the default 

setting, the user stays in the Wrapup state until they change themselves to either Ready 

state or Not Ready state. You can also select a number as the ‘Auto Wrap Time.’ In this 

case, the value selected determines the number of seconds a user stays in the Wrapup 

state. If the user takes no action, he/she is placed in the Ready state when the selected 

timer expires. If the user selects Not Ready while in the Wrapup state, the user is placed in 

the Not Ready state when the timer expires. 

This feature is useful for users making calls for outbound campaigns. It can also be used 

to ensure that users have time to record LOB codes, which describe the reason for the 

call.  For more information on configuring LOB codes, refer to the iceBar User Manual. 

Smart Routing 

Smart Routing compares dialed numbers with users’ remote DNs. This feature modifies 

ice call routing so that calls are routed within ice as much as possible to ensure the 

following: 

• All ice call forwarding and busy rules take effect in this case, including Not Ready 

state, PAQ, and Not Logged On.  

• ice reports/stats will track these calls and attribute them to an agent 

• Subsequent call control operations by the agent will be performed as that agent 

(instead of by a remote PBX system). 

• Agent based call recording rules will be adhered to when calls are routed this way.  

Smart Routing Options 

Options Description  

Use switch default ice uses the settings from the switch in ice Registry 

Set.  

Note: ice Registry Set is an advanced topic. It is a 

configuration tool used to set some system level 

and switch level settings.  

Use smart routing Over-rides the switch settings to enable smart 

routing 

Don’t use smart 

routing 

Over-rides the switch settings to disable smart 

routing 
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ACS Settings 

Enable ACS Voice 

This feature allows a user to enable and use the icePhone. If the Enable ACS Voice is 

enabled, the user can handle voice contacts using icePhone. By default, this feature is 

disabled. 

Enable ACS IM 

This feature allows a user to enable and use the icePhone. If the Enable ACS IM is 

enabled, the user can handle chat contacts using icePhone. By default, this feature is 

disabled. 

Note: In order for the user to use icePhone to handle chat contacts, they must have both 

the ‘Use ACS’ box enabled in the Connections tab, and the ‘Enable ACS IM’ box enabled 

in the Class of Service tab. 
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Outbound Presentation  

Send Name to PBX 

Note: This feature applies to users who use physical phones. 

This feature can be used when ice is integrated with an existing PBX through a media 

gateway. 

By default, the ‘Outbound Caller Name’ that is specified for the UC Group is displayed 

when the user makes a call to the PBX.  

When ‘Send Name to PBX’ is enabled, the name specified in the ‘Name to Send’ field is 

displayed when the user makes a call to a user on the PBX, provided that the PBX phone 

has the ability to display this information. The name specified here overrides the 

‘Outbound Caller Name’ configured for the UC Group. 

Send Name to PSTN/SIP Display Name 

Note: This feature applies to users who use physical phones. 

By default, the ‘Outbound Caller URI’ that is specified for the UC Group is populated with 

the outbound call information when the user makes an outbound call.  

When ‘Send Name to PSTN/SIP Display Name’ is enabled, the name specified in the 

‘Name to Send’ field is used when the user makes an outbound call.  

Use IM Alias 

This feature allows you to specify the name of the user that appears in an IM chat.  

To enable the Use IM Alias feature: 

1. Check the box beside Use IM Alias 

2. Enter the IM Alias of the user in the IM Alias field.  

 

Note: When this feature is not enabled the IM chat will show the user’s ID number. 
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Unified Numbering Plan 

This feature allows you to specify the caller number sent to PBX. 

By default, the ‘Outbound Caller URI’ that is specified for the UC Group is populated with 

the outbound call information when the user makes an outbound call. 

When ‘Unified Numbering Plan’ is enabled, the number specified in the ‘Caller Number 

sent to PBX’ field is used when the user makes an outbound call. 

User has a Direct Inward Dial (DID) number / SIP URI 

This feature allows you to specify the number sent to PSTN / SIP URI when the user has 

their own direct number. 

By default, the ‘Outbound Caller URI’ that is specified for the UC Group is populated with 

the outbound call information when the user makes an outbound call. 

When ‘User has a Direct Inward Dial (DID) number / SIP URI’ is enabled, the number 

specified in the ‘Caller Number sent to PSTN / SIP URI’ field is used when the user makes 

an outbound call. 
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Call Forwarding 

 

Call forwarding can be used to send a user’s direct calls to another user ID, to a DN that has been 

created in workflow with the Assign DN action, or to an external number. Call forwarding does 

not affect queued calls that are presented to a user’s workstation, unless the queued call was 

answered and then transferred to the user. For more information on contact handling, refer to the 

iceBar User Manual. 

 

Note: To modify a user, you must be in Edit Mode and have a user type that allows you to access 

the Users, Queues, Teams & Skills folder that is part of the iceAdministrator’s tree view. For 

information on permission levels and user types, refer to page 27. 

 

By default, call forwarding is disabled for users. The table below describes what happens when the 

call forwarding rules are disabled: 

Rules when call forwarding is disabled 

Rule Description 

No Logon When the user is logged off from ice, direct callers hear a fast-

busy tone.  

No Answer When the user does not answer a direct call within the ‘No 

Answer Threshold’, the direct caller hears a fast-busy tone.  

PAQ 

Overflow 

A direct call waits in the user’s Personal Access Queue (PAQ) 

until the user answers the call, or until the caller hangs up. The 

PAQ is a holding place for direct contacts that are presented to a 

user while they are handling another contact, or in the Not Ready 

state. Callers that have been parked in the user’s PAQ are not 

subject to the ‘PAQ Overflow Threshold.’  

Note: If the class of service feature ‘Disable PAQ Queuing’ is 

enabled, then a direct call receives a busy signal and does not 

wait in the user’s PAQ. For more information on this class of 

service feature, refer to page 79.  
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If you decide to enable call forwarding, the following options are available:  

Call forwarding options 

Option Description  

All Calls When enabled, all direct calls to the user are re-routed to a 

specified number and the user will not receive direct calls even 

when in the Ready state. When this option is selected, it will 

override other call forwarding options. 

No Logon When enabled, direct calls to the user are re-routed to a specified 

number when the user is not logged on to ice.  

No Answer When enabled, direct calls to the user are re-routed to a specified 

number when the user does not answer the call alerts within the 

‘No Answer Threshold.’  

PAQ 

Overflow 

When enabled, direct calls to the user are re-routed to a specified 

number if the caller’s wait time in the user’s PAQ reaches the ‘PAQ 

Overflow Threshold.’ Callers that have been parked in the user’s 

PAQ are not subject to the ‘PAQ Overflow Threshold.’  

Note: If the class of service feature ‘Disable PAQ Queuing’ is 

enabled, then a direct call goes directly to the dial number for 

PAQ Overflow and does not wait in the user’s PAQ. For more 

information on this class of service feature, refer to page 79. 
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To create or modify a user’s call forwarding features: 

1. Navigate to the user you wish to customize or modify. 

The ‘Properties’ page for the selected user appears on the right side of the iceAdministrator 

window. 

2. Click the Call Forwarding tab to bring that page to the front. 

3. Check the call forwarding options that you wish to enable. 

  

4. Enter the appropriate number in the ‘Dial’ fields. 

The same number is usually entered in each of these fields.  

Note: If you are using a third-party voicemail system, the iceBar Voicemail button does not blink 

automatically. If you would like this button to blink to alert users when messages have been 

transferred to their mailbox, select the Voicemail checkboxes.  

5. From the ‘No Answer Threshold’ drop-down list, select the number of seconds that a caller should 

alert at the user’s workstation before being directed to the call forwarding number specified for 

‘No Answer.’  

6. From the ‘PAQ Overflow Threshold’ drop-down list, select the number of seconds that a caller 

should wait in the user’s PAQ before being directed to the call forwarding number specified for 

‘PAQ Overflow.’ 

7. In the ‘Voicemail retrieval DN’ field, enter the number where you will retrieve the voicemails.  
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8. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

This section has explained how to configure call forwarding for a user. The section that follows 

provides information on configuring outbound workflow to control the user’s outbound calls.  

Outbound Workflow 

Instead of directly routing a call to a number that a user dials, the call can first be passed 

to an outbound workflow for inspection and treatment. Before you can enable outbound 

workflow for a user, the outbound workflow must already be created with an Assign DN 

action. Workflow has access to the number the user dialed through the Variable 

$System:DialedNumber. For more information on variables and workflow, refer to 

iceWorkflow Designer User Manual.  

Consider the following examples of outbound workflow: 

• Call blocking: If the user attempts to dial a number that is restricted by workflow, the 

user hears a message indicating the number cannot be dialed.  

• Least cost routing: Workflow determines the carrier with lowest rates for the number 

dialed. The call is placed using a UC Group associated with the lowest cost carrier.  

• Long distance PIN’s: If workflow determines that a dialed number is a long distance call, 

the user is prompted to enter a PIN before the call can be completed.  

• Dial string manipulation: On a system that uses SIP ports to place outbound calls, the 

outbound dial string must be in a specific format. For example, it might be 

sip:4164662411@192.233.60.20, where 4164662411 is the number the user is calling and 

192.233.60.20 is the sip gateway from which the call is placed. To avoid having users dial 

this long dial string for each outbound call, outbound workflow can be built so that users 

simply dial 4162662411 from iceBar. The outbound workflow generates the appropriate 

dial string before sending the call out.  

For each user, you can choose one of the following four modes for outbound workflow: 

Outbound workflow modes 

Mode Description 

Disabled The default setting. There is no treatment of the 

user’s outbound calls using outbound workflow.  

All Calls Except Calls to 

Users 

This includes external calls and calls to workflow 

DNs (Directory Number). There is no treatment of 

calls from the user to other users.  

All Calls Placed This includes external calls, calls to workflow DNs, 

and calls to other users on ice.  
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Outbound workflow modes 

Mode Description 

External Calls Only Includes external calls only. 

 

Outbound workflow can be enabled for each user, as described in the instructions that 

follow, or can be enabled for an entire switch. For more information on enabling 

outbound workflow for a switch, refer to Appendix B: Switches, Nodes, & Sites.  

Note: To modify a user, you must be in Edit Mode and have a user type that allows you 

to access the Users, Queues, Teams & Skills folder that is part of the iceAdministrator’s 

tree view. For more information on permissions on iceAdministrator, refer to page 27. 

To enable outbound workflow for a user’s calls: 

1. Navigate to the user that you wish to customize or modify. 

The ‘Properties’ page for the selected user appears on the right side of the 

iceAdministrator window. 

2. Click the Call Forwarding tab to bring that page to the front. 

For this process, you need to work with the ‘Outbound Workflow’ portion of the page. 

  

3. From the ‘Mode’ drop-down list choose one of the four modes: Disabled, All Calls Except 

Calls to Users, All Calls Placed, or External Calls Only. 

For all modes except Disabled, you must choose the DN that points to the outbound 

workflow from the ‘DN’ drop-down list. If your user type is Supervisor or higher, you can 

click Go To Target to view the outbound workflow.  

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 

This section has explained how to configure outbound workflow for a user’s calls. The 

section that follows provides information on configuring a user’s queue assignments. 
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Queue Assignments 

A user that is not assigned to any queues is permitted to log on to iceBar. This accommodates 

contact centers with users whose focus is placing outbound calls and users who do not handle 

queued calls.  

Most users are assigned to the queues from which they are required to handle contacts.  

Note: To modify a user, you must be in Edit Mode and have a user type that allows you to access 

the Users, Queues, Teams & Skills folder that is part of the iceAdministrator’s tree view. For 

information on permission levels and user types, refer to page 27. 

 

To add or remove queue assignments: 

1. Navigate to the user that you wish to customize or modify and click on the Queue Assignments 

page.  

The user’s current queue assignments are shown in the ‘Assigned Queues’ column, while queues 

that the user is not assigned appear in the ‘Unassigned Queues’ column. 

  

 

Note: If there is more than one queue in the ‘Unassigned Queues’ or the ‘Assigned Queues’ 

column, you can sort the list numerically by queue ID or alphabetically by name by clicking on the 

ID or Name column headings. 

2. To assign a user to a queue, highlight the queue in the ‘Unassigned Queues’ column by clicking 

on it and then click Add. 

To remove a user from a queue, highlight the queue in the ‘Assigned Queues’ column by clicking 

on it and then click Remove. 

3. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

This section has explained how to configure a user’s queue assignments. The section that follows 

provides information on assigning skills to a user.  
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Assigning Skills to Users  

iceAdministrator requires configuration in order to route contacts to the user with the most 

appropriate skills. One of these areas is the ‘Skills’ page for a user. For more information on 

configuring skills, refer to  
 

Chapter 5: Skills. 

Note: To modify a user, you must be in Edit Mode and have a user type that allows you to access 

the Users, Queues, Teams & Skills folder that is part of the iceAdministrator’s tree view. For more 

information on permissions in iceAdministrator, refer to page 27.  

 

To modify a user’s skills: 

1. Navigate to the user that you wish to customize or modify. 

The ‘Properties’ page for the selected user appears on the right side of the iceAdministrator 

window.  

2. Click the Skills tab to bring that page to the front.  

The user’s current skill assignments are shown in the ‘Assigned Skills’ column, while unassigned 

skills appear in the ‘Unassigned Skills’ column.  

  

Note: If there is more than one skill in the ‘Assigned Skills’ column, you can sort the list 

alphabetically by name or numerically by level by clicking on the ‘Skill’ or ‘Level’ column headings. 

3. Highlight the skill you wish to assign to the user in the ‘Unassigned Skills’ column. 

Note: The available skills are the skills that have been added to the ‘Skills’ folder in the tree view. 

For more information on adding a new skill, refer to page 169. 
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4. From the ‘Level’ drop-down list, select a number between one and five that represents the user’s 

proficiency in the skill. 

   

Five represents the highest level of proficiency in a skill. 

5. Click Add to assign the skill to the user. 

To remove a skill from a user, highlight the skill in the ‘Assigned Skills’ column and click Remove. 

6. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

This section has explained how to configure a user’s skill assignments. The section that follows 

provides information on making modifications to multiple users simultaneously.   
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Modifying Multiple Users 

Use the ‘Multi-Settings Change’ feature to avoid modifying each user’s settings individually when 

you need to change the same settings for a subset of your users. For example, use this feature 

when you want to disable the ‘Logon to Not Ready’ setting on the Class of Service tab for all 

users. 

 

To modify the settings for multiple users: 

1. Right-click on any user in the tree view. 

A menu appears. 

    

2. Select Multi-Settings Change from the menu. 

A message box displaying the following message appears: 
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3. Click Yes to continue. Click No to cancel the process. 

The ‘Apply Selected Settings to Multiple Users’ dialog box appears. This dialog box contains the 

same tabs and configuration settings as those that appear for a single user. The difference lies at 

the bottom of the dialog box, where you can select the users for whom you want to change the 

settings. 

   

 

4. You must highlight the fields that you want to change for the change to be applied. Hold the Ctrl 

key and click the field you want to highlight. To deselect the field, hold the Ctrl key and click the 

field again. 

The field remains highlighted even if you move to a different tab. When you save your changes, 

all highlighted fields will be changed to the values that you set for each selected user. 

5. Click on the box beside the field to select or deselect an option.  

Note: You must highlight the field by holding the Ctrl key before selecting or deselecting an 

option. 
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6. To apply the changes to other users, highlight the users in the left column on the bottom of the 

page and click Add. 

To remove a user from ‘Apply Selected Fields To’ section, highlight the user in the right column 

and click Remove. 

7. Click Apply to make the changes. Click Exit to close the dialog box without making any changes. 

Once you click Apply, the following message appears. 

  

8. Click OK to close the message box. 

9. Click Exit or click the close (X) button to close the ‘Apply Selected Settings to Multiple Users’ 

dialog box. 

10. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 
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Deleting a User 

If you wish to completely remove a user from iceAdministrator, then the user should be deleted. 

To remove a user from a queue without completely removing the user, refer to page 97. 

Note: To delete a user, you must be in Edit Mode and have a user type that allows you to access 

the Users, Queues, Teams & Skills folder. For information on permission levels and user types, 

refer to page 27. 

 

To delete a user: 

1. Navigate to the user that you wish to delete.  

2. Right-click on the user in the tree view. 

A menu appears. 

 

3. Select Delete from the menu that appears.  

For the first time, you will get a delete confirmation. If you do not want to be shown the 

confirmation message, you can click ‘Do not show this message again’ checkbox. 

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

This section has explained how to delete a single user. The section that follows provides 

information on deleting all users.  

Note:  

• If the user that you delete is used in workflow, the actions where the user ID is used may fail. For 

example, if you use Route Object to send calls directly to the user, this action will follow the 

failure condition when the user ID no longer exists. 

• For more information on actions and workflow, refer to the iceWorkflow Designer User Manual. 
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Deleting Multiple Users 

If you wish to completely remove users from iceAdministrator, then the users should be deleted. 

To remove users from a queue without completely removing the users, refer to page 97. 

Note: To delete users, you must be in Edit Mode and have a user type that allows you to access 

the Users, Queues, Teams & Skills folder. For information on permission levels and user types, 

refer to page 27. 

 

To delete multiple users, complete the following steps: 

1. Navigate to the Users subfolder in the tree view.  

2. Right-click on the Users subfolder. 

A menu appears. 

  

 

3. Select Delete User(s)... from the menu.  

A menu appears. 
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4. Highlight the user(s) that you would like to delete. You can use the Ctrl or Shift key while clicking 

to make multiple selections. 

5. Click the arrow   to move the selected user(s) over to the right. 

6. Click OK.  

7. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

The selected user(s) are deleted. 

This section has explained how to delete multiple users. The section that follows provides 

information on emptying the Users subfolder.  

 

Note:  

• If the users that you delete are used in workflow, the actions where the User IDs are used may fail. 

For example, if you use Route Object to send calls directly to the users, this action will follow the 

failure condition when the User IDs no longer exist.  

• For more information on actions and workflow, refer to the iceWorkflow Designer User Manual. 
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Emptying the Users Folder 

Global Administrators can empty the Users subfolder. This will delete all users from 

iceAdministrator. You may decide to delete all these users to avoid conflict messages when 

importing users.  

Note: To delete all users, you must be in Edit Mode and have the Global Administrator user type.  

To empty the Users subfolder, complete the following steps:  

1. Right-click on the Users subfolder. 

A menu appears. 

   

2. Select Empty... from the menu. 

A warning appears. 

  

 

3. Click Yes to delete all of the users, except the user ID that you used to log in to iceAdministrator, 

or click No to cancel the deletion.  

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

Note:  

If the users that you delete are used in workflow, the actions where these IDs are used may fail. 

For example, if you use Route Object to send calls directly to certain users, this action will fail if 
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one of the user IDs no longer exists. For more information on actions and workflow, refer to the 

iceWorkflow Designer User Manual. 
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Emptying the Users, Queues, Teams & Skills Folder 

Global Administrators can empty the Users, Queues, Teams & Skills folder. This means that all 

users, queues, teams, and skills are deleted from iceAdministrator. You may decide to delete all of 

these items to avoid conflict messages when importing users, queues, teams, and skills.  

Note: To delete all users, queues, teams, and skills, you must be in Edit Mode and have the Global 

Administrator user type.  

 

To empty the Users, Queues, Teams & Skills folder:  

1. Right-click on the Users, Queues, Teams & Skills folder. 

A menu appears.  

 

2. Select Empty from the menu. 

A warning appears. 

   

3. Click Yes to delete all of the users (except the user ID that you used to log in to iceAdministrator), 

queues, teams and skills or click No to cancel the deletion.  

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

Note: 

• If the users that you delete are used in workflow, the actions where the User IDs are used may fail. 

For example, if you use Route Object to send calls directly to the users, this action will follow the 

failure condition when the user IDs no longer exists.  

• If the queue or skill(s) that you delete is used in workflow, you will need to complete or modify 

the workflow before you can save your changes.  
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• If the skill(s) that you delete is used in workflow, you will need to complete or modify the 

workflow before you can save your changes. 

• For more information on actions and workflow, refer to the iceWorkflow Designer User Manual. 
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icePhone Connection and Backup Settings 

 

Voice Settings 

The following table describes the settings required to configure icePhone as a primary or backup 

connection for voice calls. This includes settings in iceManager Configuration groups, as well as 

settings in iceAdministrator.  

For more information on the settings in iceManager, refer to the iceManager User Manual. 

 iceAdministrator   iceManager Configuration 

Groups 

Voice Enable 

ACS 

Voice  

Connection 

address 

(Remote 

DN)  

Use MS 

Teams 

Direct 

Routing  

Block 

PSTN 

remote 

DN  

Default User Connectivity  

Primary Backup Voice Primary Voice Backup 

Teams 

Direct 

Routing 

icePhone ✓ Direct 

Routing 

number 

✓ ✓ iceAdministrator-

defined 

icePhone 

Teams 

Direct 

Routing 

PSTN 
 

PSTN 

number 

✓ 

 

iceAdministrator-

defined 

iceAdministrator-

defined 

PSTN icePhone ✓ PSTN 

number 

  

iceAdministrator-

defined 

icePhone 

icePhone PSTN ✓ PSTN 

number 

  

icePhone iceAdministrator-

defined 

icePhone Teams 

Direct 

Routing 

✓ Direct 

Routing 

number 

✓ ✓ icePhone iceAdministrator-

defined 

 

Note: If the User Connectivity Changeable From iceBar setting is enabled in iceManager 

Configuration Groups, the iceBar remote DN will override any settings in iceAdministrator and 

iceManager. For more information, refer to the iceManager User Manual. 

 

IM Settings 

The following table describes the settings required to configure icePhone as a primary or backup 

connection for IMs. These settings are configured in iceAdministrator.  
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 iceAdministrator 

IM Enable ACS IM Use ACS IM Address 

Primary Backup 

icePhone SIP ✓ ✓ Sip address 

SIP icePhone ✓  Sip address 

 

Consider the following example to set Teams Direct Routing as the primary connection, and 

icePhone as the backup. 

 

In iceManager 

1. In iceManager settings, locate the correct Configuration Group, and open the General 

Tab. 

2. Set the Default User Connectivity to iceAdministrator defined. 

 

 

In iceAdministrator 

1. In iceAdministrator, ensure that both the Enable ACS Voice and Enable ACS IM class of 

service features are enabled. 
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2. In the user’s Connections tab, set the Connection address to their Direct Routing number. 

3. Ensure both Use MS Teams Direct Routing and Block PSTN Remote DN are enabled. 

Note: Use MS Teams Direct Routing and Block PSTN Remote DN can only be enabled by 

the Global Administrator. If you require these settings to be enabled, please contact 

Computer Talk.  

 

 

4. Set the user’s IM Address to their sip address, and enable the “Can Handle IM Contacts 

from ice” checkbox. 
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To switch the connection from the primary to the backup 

Open Configuration Groups in iceManager, and set the Default User Connectivity to 

‘icePhone’.  

 

 

 

If the agent is using icePhone to handle IMs, enable both the Can Handle IM Contacts 

from ice and the Use ACS checkbox. 

 

 





 

 

 

 

 

 

 

 

Chapter 3: Queues 

Queues are holding places where inbound contacts wait to be handled by users. 

iceAdministrator allows you to add, modify, and delete queues as required by 

your contact center. Configurable properties for a queue can affect the way 

contacts are handled within the queue. For example, if you want calls about 

certain topics to be answered first, you may manipulate a contact’s priority within 

the queue by modifying queue properties.  

In addition to the properties described in this chapter, the treatment of contacts 

waiting in queue is determined by the design of workflow. For example, workflow 

determines if callers hear messages and music while waiting in queue. For more 

information on workflow, refer to the iceWorkflow Designer User Manual.  

The sections that follow describe how to view existing queues, add new queues, 

modify queues, assign users to queues, and delete queues from ice.  

Note: 

• iceAdministrator should be used by trained contact center staff. Before you begin 

modifying or creating queues, you must be familiar with your current 

configuration.  

• To view and edit queues, you must have a user type that allows you to access the 

Users, Queues, Teams & Skills folder that is part of the iceAdministrator’s tree 

view. This chapter assumes that you are familiar with the permissions on ice, as 

described in  
 

Chapter 1: Getting Started. 

• Special configuration is not required for a queue that handles email messages.  
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• Changes to queue properties are audited and visible in iceManager Audit Trails. 

For a complete list of audited objects, refer to the iceManager User Manual. 
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Viewing a Queue 

You may wish to view a queue if you are planning to change its parameters, change user 

assignments, or delete the queue from ice.  

Viewing queues involves finding and selecting a queue in the tree view. When a queue is selected, 

the right side of the iceAdministrator window displays two tabs detailing the queue’s 

configuration.  

Note: To view a queue you must have a user type that allows you to access the Users, Queues, 

Teams & Skills folder. For information on permission levels and user types, refer to page 27. 

 

To navigate to a queue: 

1. Open the Users, Queues, Teams & Skills folder in the tree view. 

The queues sub-folder is displayed. 

   

2. Open the queues folder in the tree view. 
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The queues that have already been created are displayed in the tree view. Each queue can be 

expanded to show the users that have been assigned to the queue. The ‘Unassigned Users’ folder 

expands to show users that have not yet been assigned to a queue. 

3. Highlight the queue to view its configuration. 

Two tabs appear in the detail view: the ‘Properties’ tab, and the ‘User Assignment’ tab. By default, 

the ‘Properties’ page is displayed. 

     

This section has explained how to navigate to a queue. The sections that follow describe how to 

add a new queue and explain how to modify the properties for a queue. 
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Adding a Queue 

A new queue may need to be added to accommodate changes in your contact center. 

 

There are several methods of adding a queue: 

• Add a ‘New Queue.’ This allows you to create one queue with iceAdministrator’s default 

properties.  

• Add ‘New Queue(s).’ This allows you to create one queue or many queues. This feature can be 

helpful if you want new queues to have the same properties as an existing queue in your contact 

center. 

• Add a new queue when setting up workflow. This allows you to create queues on the spot as 

workflow is being developed. For more information on workflow, refer to the iceWorkflow 

Designer User Manual. 

Once you have added a new queue, you can configure unique properties for that queue. For more 

information on completing configurable properties for newly-created queues or modifying 

existing queues, refer to page 127. 

Note: To add a queue, you must be in Edit Mode and have a user type that allows you to access 

the Users, Queues, Teams & Skills folder that is part of the iceAdministrator’s tree view. For 

information on permission levels and user types, refer to page 27. 
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Adding a New Queue 

To add a new queue: 

1. Right-click on the Queues folder in the tree view. 

A menu appears. 

   

 

2. Select New Queue from the menu. 

Two tabs appear in the detail view: the ‘Properties’ tab, and the ‘User Assignment’ tab. By 

default, the ‘Properties’ page is displayed. 
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3. From the File menu, choose Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 

This section has explained how to add a queue with the default properties. For more 

information on modifying the properties of a newly-created queue, refer to page 127. The 

section that follows describes how to add multiple queues to the tree view. 

Adding Multiple Queues 

iceAdministrator allows you to create multiple queues simultaneously: 

• You can add queues based on iceAdministrator’s default properties for a queue. This is 

similar to adding a New Queue, which was described in the previous section.  

• You can add queues based on an existing queue’s configuration, which is called a 

‘Template.’ Use this feature if you want new queues to have the same properties as the 

existing queues in your contact center.  

Once you have created the queues, you should configure their properties. For more 

information on modifying queue properties, refer to page 127. 

 

To add multiple queues: 

1. Right-click on the Queues folder in the tree view. 

A menu appears. 

  

2. Select New Queue(s) from the menu. 
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A message box displaying the following message appears: 

 

3. Click Yes to continue. Click No to cancel the process. 

4. The ‘Create New Queues’ dialog box appears. 

   

5. Select the number of queues that you wish to create from the ‘Number of Queues to 

create’ drop-down list. 

6. Select the starting queue ID from the ‘Starting ID’ drop-down list. 

This ID is assigned to the first queue. The next available queue IDs are assigned to any 

additional queues you are creating.  

7. Choose the configuration for your queue. 

Select the ‘Default’ radio button if you would like the queues to have the default queue 

configuration. 

Select ‘From Template’ if you would like each queue to have the same configuration as an 

existing queue. When the ‘From Template’ radio button is selected, you can select a 

queue in the ‘Choose Template’ table. 

This illustration shows that queue 6001 has been selected as the template. 
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8. Click OK to create the new queues. 

The queues appear in the tree view. 

   

9. From the File menu, choose Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.)  
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Adding a Queue from the Properties of a Workflow Action 

On the properties page of specific workflow actions that require the selection of a queue, 

you can create a new queue by using the appropriate drop-down list. For more 

information on workflow actions, refer to the iceWorkflow Designer User Manual.  

 

To create a queue from the properties dialog box of a workflow action: 

1. From the workflow page, double-click the action from which you would like to create the 

queue. 

Note: Not all actions allow you to create a queue. Queue Object is an example of an 

action that allows the creation of queues.  

2. In the field that requires a queue, for example, the ‘Queue’ field on the Get Queue Status 

workflow action’s properties page, select <NEW QUEUE> from the drop-down list. 
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You can also right-click the arrow in the drop-down list box and select Queue from the 

menu that appears. 

 

The ‘Select Queue’ dialog box appears. 
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3. Click the Create New button on this dialog box. 

The ‘New Queue’ dialog box appears. This dialog box has the same configuration tabs as 

the ones that appear when you create a queue from the tree view. 

4. Click OK on this dialog box to add the queue. 

The queue is added to the tree view and becomes the selected option in the workflow 

action field. 

5. From the File menu, choose Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 
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General Properties 

You may wish to modify an existing queue to reflect changes in your contact center, or you may 

wish to configure a queue that you have just added. 

General properties for a queue include queue name, short name, and queue ID.  

Note: To modify a queue, you must be in Edit Mode and have a user type that allows you to 

access the Users, Queues, Teams & Skills folder that is part of the iceAdministrator’s tree view. For 

information on permission levels and user types, refer to page 27. 

 

To modify a queue’s general properties: 

1. Navigate to the queue that you wish to customize or modify. 

The ‘Properties’ page for the selected queue appears on the right side of the iceAdministrator 

window.  

2. Enter the name of the queue in the ‘Queue Name’ field. 

  

The queue’s name can be up to 40 characters in length. 

3. Select a four-digit number from the ‘Queue ID’ drop-down list. 

  

The queue ID is used to identify the queue when creating workflow and when generating reports. 

4. Enter a short name for the queue in the ‘Short Name’ field. 

  

The short name of the queue appears in the queue statistics within iceBar. The short name can be 

up to 8 characters in length.  

5. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

This section has explained how to configure a queue’s general properties. The section that follows 

provides information on configuring properties for Auto Wrap Time. 
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Auto Wrap Time 

Users can enter a Wrapup state after each queued contact they receive. While in Wrapup state, a 

user cannot receive any contacts from a queue. Wrapup state is commonly used to allow a user to 

finish post-contact work before handling a new contact. 

For example, a user that handles contacts from two queues can stay in Wrapup state for ten 

seconds after handling a call from the Sales queue and for thirty seconds after handling a call 

from the Support queue. Other users in the same queues may not receive any time for Wrapup 

state if they do not have the ‘Wrapup After Queued Call’ class of service feature enabled.  

 

The following settings determine how Wrapup state is used for queued calls:  

• For a user to enter Wrapup state, the ‘Wrapup After Queued Call’ class of service feature must be 

enabled in his/her user profile. For more information on this feature, refer to page 84. 

• The default setting for the ‘Auto Wrap Time’ is ‘Infinite’ seconds. With the default setting, the user 

stays in Wrapup state until they change themselves to either Ready state or Not Ready state. You 

can also select a number as the ‘Auto Wrap Time.’ In this case, the value selected determines the 

number of seconds a user stays in Wrapup state. If the user takes no action, he or she is placed in 

the Ready state when the selected timer expires. If the user selects Not Ready while in Wrapup 

state, the user is placed in the Not Ready state when the timer expires. If the user selects Ready 

while in Wrapup state, the user is immediately placed in the Ready state. For more information, 

refer to the iceBar User Manual.  

• You can disable the ‘Auto Wrap Time’ for a queue by selecting ‘Disable’ from the drop-down list. 

In this case, if a user has the ‘Wrapup After Queued Call’ class of service enabled, he/she does not 

enter the Wrapup state for this particular queue. 

Note: To modify a queue, you must be in Edit Mode and have a user type that allows you to 

access the Users, Queues, Teams & Skills folder that is part of iceAdministrator’s tree view. For 

more information on permissions in iceAdministrator, refer to page 27. 

 

To modify the queue’s Auto Wrap Time: 

1. Navigate to the queue that you wish to customize or modify. 

The ‘Properties’ page for the selected queue appears on the right side of the iceAdministrator 

window.  

2. Select the number of seconds of allowed time for Wrapup state from the ‘Auto Wrap Time’ drop-

down list. 

  

3. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 
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No Answer Time for a Queue 

‘No Answer Time’ determines how long a queued call alerts at a user’s workstation before it is 

directed back to the queue. The default setting for ‘No Answer Time’ is 18 seconds. 

Note: To modify a queue, you must be in Edit Mode and have a user type that allows you to 

access the Users, Queues, Teams & Skills folder. For information on permission levels and user 

types, refer to page 27. 

 

To modify the queue’s No Answer Time: 

1. Navigate to the queue you wish to customize or modify. 

The ‘Properties’ page for the selected queue appears on the right side of the iceAdministrator 

window.  

2. Select the number of seconds of allowed alerting time from the ‘No Answer Time’ drop-down list. 

  

3. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

This section has explained how to configure ‘No Answer Time’ for a queue. The section that 

follows provides more information on configuring a queue’s properties.  

Note:  

• A user that misses a queued call is automatically placed into the Not Ready state, provided that 

the ‘Disable Auto Not Ready’ class of service feature is disabled (unchecked) in his/her user 

profile. This feature is disabled by default. 

• A ‘No Answer Threshold’ is also set in each user profile. The setting in the user profile affects 

direct calls, while the setting for ‘No Answer Time’ affects queued calls.  

Caution: If a user has the class of service feature ‘Auto Answer’ enabled and the ice telephone 

line is off-hook, it is possible for a caller to be presented to an unattended workstation. Users 

should always place themselves in the Not Ready state when they are not available to handle 

contacts from the queue.   
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User Email State Timeout 

The default setting for the ‘User Email State Timeout’ is ‘Infinite’ seconds. With the default setting, 

the user enters the Email state upon receiving an email message from ice and stays in the Email 

state until they change themselves to either Ready state or Not Ready state.  

You can select a number as the ‘User Email State Timeout.’ In this case, the value selected 

determines the maximum number of seconds a user stays in the On Email State. If the user takes 

no action, he/she is placed in the Ready state when the selected timer expires. If the user selects 

Not Ready while in the On Email state, the user is immediately placed in the Not Ready state. If 

the user selects Ready while in the On Email state, the user is immediately placed in the Ready 

state. For more information, refer to the iceBar User Manual.  

You can also set ‘User Email State Timeout’ to ‘Immediate.’ With this valued selected, the user 

does not enter the email state upon receiving an email message from ice.  

Note: To modify a queue you must be in Edit Mode and have a user type that allows you to 

access the Users, Queues, Teams & Skills folder. For information on permission levels and user 

types, refer to page 27. 

 

To modify User Email State Timeout: 

1. Navigate to the queue you wish to customize or modify. 

The ‘Properties’ page for the selected queue appears on the right side of the iceAdministrator 

window.  

2. Select Infinite, Immediate, or the number of seconds for the Email state from the ‘User Email State 

Timeout’ drop-down list. 

  

3. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

This section has explained how to configure User Email State Timeout for a queue. The section 

that follows provides more information on configuring a queue’s properties.  
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Queue Targets and Thresholds  

There are several thresholds that can be modified for a queue, as described in the sections that 

follow.  

Target Average Speed of Answer 

Target ASA (average speed of answer) and Target ASA2 express the longest amount of 

time a contact should wait in queue before being handled by a user. These settings 

represent targets used to calculate the grade of service and grade of service 2 for 

reporting purposes and have no bearing on how long users actually take to answer 

queued contacts. For more information on the grade of service, refer to page 132.  

Note: To modify a queue you must be in Edit Mode and have a user type that allows you 

to access the Users, Queues, Teams & Skills folder that is part of iceAdministrator’s tree 

view. For information on permission levels and user types, refer to page 27. 

 

To configure the Target ASA or Target ASA2 for a queue: 

1. Navigate to the queue that you wish to customize or modify. 

The ‘Properties’ page for the selected queue appears on the right side of the 

iceAdministrator window. 

For this process, you need to use the Thresholds portion of the page. 

  

2. Select the first target from the ‘Target ASA’ spin box. 

The default value is 45 seconds. You may set the Target ASA to reflect any number of 

seconds, minutes, days, or weeks. For example, you may click on 0d and increase the 

Target ASA to 1 day. This can be useful for queues that handle email contacts.  
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3. Select the second target from the ‘Target ASA2’ spin box.   

The default value is 1 minute. This target can be set to any number of seconds, minutes, 

days, or weeks, as described in step 2.   

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 

This section has explained how to configure a queue’s target average speed of answer. 

The section that follows provides information on the grade of service calculation that is 

displayed in reports and in iceMonitor.  

Grade of Service 

The Grade of Service (GOS) is the percentage of offered contacts that have been 

handled in less than the Target ASA (Average Speed of Answer). The Grade of Service 2 

(GOS2) is the percentage of offered contacts that have been handled in less than the 

Target ASA2 (Average Speed of Answer2). Both the GOS and the GOS2 are displayed in 

iceMonitor, iceBar, and on reports.  

To better understand GOS, consider how ice calculates GOS for a caller. To arrive at GOS 

or GOS2, ice looks at handled callers wait time in queue. A caller’s wait time in queue 

starts once they have successfully passed through the Queue Object action in workflow, 

and the caller’s wait time in queue ends when they are connected with a user. The 

number of calls that have been handled in less than the target ASA is divided by the 

number of calls offered to the queue. The result is expressed as a percentage.  

 

Consider the following example for a queue with a 30 second target ASA:  

• Caller A enters the queue, waits 5 seconds, and hangs up.  

• Caller B enters the queue, waits 45 seconds, and hangs up.  

• Caller C enters the queue, waits 5 seconds, and is answered.  

• Caller D enters the queue, waits 45 seconds, and is answered.  

Four calls were offered to the queue, but only one call (Caller C) was answered in less 

than 30 seconds. Therefore, the grade of service is 25% (1 divided by 4, multiplied by 

100). 

For details on how you can ignore the calls that waited for a short time in queue and 

remove them from the GOS calculation, refer to the following section.  
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GOS Short Abandoned Threshold 

GOS can be calculated without including the callers who hung up after waiting for a short 

period of time (e.g., five seconds). This can be accomplished with the GOS Short 

Abandoned Threshold. Calls that ended in less than the number of seconds that you 

specify as the GOS Short Abandoned Threshold will be excluded from GOS calculations.  

 

Consider the following example for a queue with a 30 second target ASA and a 10 second 

GOS Short Abandoned Threshold:  

• Caller A enters the queue, waits 5 seconds, and hangs up.  

• Caller B enters the queue, waits 45 seconds, and hangs up.  

• Caller C enters the queue, waits 5 seconds, and is answered.  

• Caller D enters the queue, waits 45 seconds, and is answered.  

Four calls were offered to the queue, but one call will be ignored because it was 

abandoned in less than the GOS Short Abandoned Threshold. One call (Caller C) was 

answered in less than 30 seconds. Therefore, the grade of service is 33% (1/3, multiplied 

by 100). 

Note: To modify a queue, you must be in Edit Mode and have a user type that allows you 

to access the Users, Queues, Teams & Skills folder. For information on permission levels 

and user types, refer to page 27. 

 

To configure the GOS Short Abandoned Threshold for a queue:  

1. Navigate to the queue that you wish to customize or modify. 

The ‘Properties’ page for the selected queue appears on the right side of the 

iceAdministrator window. 
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For this process, you need to use the Thresholds portion of the page. 

   

2. Select the threshold from the ‘GOS Short Abandoned’ spin box.  

The default value is 0 seconds. You may set the threshold to reflect any number of 

seconds, minutes, days, or weeks. For example, you may click on 0d and increase the 

threshold to 1 day. This can be useful for queues that handle email contacts. 

You may also select the ‘Use Target ASA’ or ‘Use Target ASA2’ checkboxes to use either of 

those targets as the GOS Short Abandoned Threshold.  

3. From the File menu, choose Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 

This section has explained how to configure a queue’s GOS Short Abandoned Threshold. 

The sections that follow provide information on the queue thresholds.  
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Busy Queue Threshold 

Busy Queue Threshold expresses the maximum number of contacts that the queue can 

accommodate before it stops accepting contacts. Once this maximum is reached, the 

queue enters busy mode and contacts that workflow attempts to place in the queue are 

directed to the action specified in the ‘On Busy Mode Go To’ field that is part of the 

Queue Object action.  

The default value is for the Busy Queue Threshold is 500. For more information on queue 

modes, refer to page 142.   

Note: To modify a queue, you must be in Edit Mode and have a user type that allows you 

to access the Users, Queues, Teams & Skills folder. For information on permission levels 

and user types, refer to page 27. 

 

To configure the Busy Queue Threshold for a queue: 

1. Navigate to the queue that you wish to customize or modify. 

The ‘Properties’ page for the selected queue appears on the right side of the 

iceAdministrator window. 

For this process, you need to use the Thresholds portion of the page. 
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2. From the ‘Busy Queue Threshold’ drop-down list, select the number of contacts that must 

be waiting in the queue before it is considered to be in busy mode. 

  

3. From the File menu, choose Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 

This section has explained how to configure the Busy Queue Threshold for a queue. The 

section that follows provides more information on configuring a queue’s skill thresholds. 
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Skill Thresholds for a Queue 

There are three skill thresholds that you can enable at the queue level which affect the 

use of skills in ice:  

• Ignore Discretionary Skill Threshold. 

• Ignore Mandatory Skill Threshold. 

• Dynamic Skill Downgrade Threshold. 

 

For information on these thresholds, refer to Queue Skill Thresholds on page 183.  
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Queue Weights 

By modifying settings in a queue and in workflow, several factors can be used to determine the 

contact’s position in queue and the user’s suitability for a contact. These factors are Queued Time 

Weight, Skills Score Weight, Priority Weight, and User Idle Time Weight.  

 

By default, the contact that has been waiting for the longest period of time in a queue is handled 

first. For example, a contact that has been waiting for 30 seconds is handled before a contact that 

has just entered the queue.  

If multiple contacts are waiting in queue and a user becomes available to handle a contact, the 

user’s suitability for each of the contacts waiting to be handled is calculated. This equation takes 

into consideration the skills score of the user, compared with the needs of each contact, the time 

each contact has been waiting in the queue, and the priority of each contact. The contact with the 

highest score is presented to the user. The equation is as follows: 

(SC * SW) + (QT * QW) + (PL * PW)   

The abbreviations are explained in the table below. 

If multiple users are available to take a particular contact, the most suitable user will receive the 

contact. This is calculated based on the skills score of each user compared to the needs of that 

contact and the amount of time each user has been idle. The equation is as follows: 

(SC * SW) + (AT * AW) 

The table below explains the abbreviations used in the equations.  

Queue weight equation variables 

Variable Meaning 

SC The user’s skills compatibility score (i.e., proficiency of the user in 

relation to what the contact wants). For more information refer to 

page 195. 

SW The skill score weight that has been selected for the queue.  

QT The actual amount of time, in seconds, the contact has been 

waiting in queue. 

QW The queued time weight that has been selected for the queue. 

PL The priority level the contact has been assigned in the Queue 

Object action that is part of workflow. 
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Queue weight equation variables 

Variable Meaning 

PW The priority weight that has been selected for the queue.  

AT The actual amount of time, in seconds, the user has been idle.  

A user’s idle time is calculated from the time that they last 

completed a queued contact. Changing states (i.e., toggling 

Ready/Not Ready, receiving a direct call, placing an outbound call) 

does not reset the user’s idle time. The user’s idle time refreshes 

once they have completed a queued contact. 

AW The user idle time weight that has been selected for the queue. 

 

The ways that queue weights affect a contact’s position in queue or a user’s suitability for a 

contact are described in the sections that follow. 

Queued Time Weight 

‘Queued Time Weight’ can allow contacts that have been waiting in the queue for a long 

time to be handled even when other contacts have a higher level of priority or a skill 

requirement. Decreasing ‘Queued Time Weight’ (e.g., by setting it to 0) allows the caller’s 

actual wait time in queue to be ignored so that they are routed based only on priority 

and/or skills.  

Caution: It is not recommended to set ‘Queued Time Weight’ to 0 unless you have 

configured the queues to route calls based solely on priority and/or skills. When ‘Queued 

Time Weight’ is set to 0, the caller’s actual wait time in queue is not considered when 

determining the position of contacts in the queue.  

A queue’s default ‘Queued Time Weight’ is 1, but the drop-down list allows you to select 

a number between 0 and 100. The number selected is multiplied by the contact’s actual 

wait time. The resulting value is used as part of the calculation described on page 138 to 

determine the contact’s position in queue.  
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Priority Weight 

By modifying settings in workflow and settings for a queue, a contact’s position in queue 

can be affected by priority: 

• A queue’s default ‘Priority Weight’ is 1, but the drop-down list allows you to select a 

number between 0 and 100. The selected number is used in an equation that also 

takes into consideration the contact’s priority level. If you choose 0, priority weight is 

not considered when determining the position of contacts in the queue. 

• Priority is assigned to a contact when it passes through the Queue Object action. The 

value selected from the ‘With Priority’ field in the Queue Object action determines a 

contact’s priority level when it is presented to the queue.  

Consider a contact that passes through a Queue Object action with a value of 10 in the 

‘With Priority’ field. This contact is registered in the queue that has a Priority Weight of 

10. The equation to determine ‘Priority Weight’ is Priority multiplied by Priority Weight. In 

this example, 100 seconds (Priority multiplied by Priority Weight) are added to the 

contact’s actual wait time in queue, putting the contact ahead of contacts that have not 

been assigned priority and have been waiting in the queue for less than 100 seconds. This 

contact has a greater chance of being handled more quickly in the queue because the 

queue is configured to handle the contact that has been waiting for the longest period of 

time first.  

Skills Score Weight 

A queue’s Skills Score Weight’ is 1, but the drop-down list allows you to select a number 

between 0 and 100. The selected number is used in an equation that also takes into 

consideration a user’s skills compatibility score. This score measures his/her ability to 

handle a contact. For more information on the skill compatibility score, refer to page 195.  

An increased Skills Score Weight places more value on the compatibility score when 

calculating a contact’s position in queue or when finding the best user for contacts in the 

queue. If you choose 0, skills compatibility score is not considered when determining the 

position of contacts in the queue or when finding the best user for contacts in the queue. 

For more information on using skills to route contacts in your contact center, refer to  
 

Chapter 5: Skills. 

  



 

 

 

  
  

141 iceAdministrator User Manual 

User Idle Time Weight 

‘User Idle Time Weight’ affects the suitability of particular users for contacts in the queue. 

If you give user idle time a heavy weight, you could ensure that users who have been idle 

for a long time would receive contacts, even if users who have higher skill scores are 

available. 

A queue’s default ‘User Idle Time Weight’ is 1, but the drop-down list allows you to select 

a number between 0 and 100. The number selected is multiplied by the amount of time 

the user has been idle. The resulting value is used as part of the calculation described on 

page 138 to determine a user’s suitability for a contact in queue. If you choose 0, the 

amount of time a user is idle is not considered when finding the best users for contacts in 

the queue. 

Modifying Queue Weights 

Note: To modify a queue, you must be in Edit Mode and have a user type that allows you 

to access the Users, Queues, Teams & Skills folder that is part of the iceAdministrator’s 

tree view. For information on permission levels and user types, refer to page 27. 

To modify any Weights setting: 

1. Navigate to the queue that you wish to customize or modify. 

The ‘Properties’ page for the selected queue appears on the right side of the 

iceAdministrator window.  

For this process, you need to use the ‘Weights’ area of the page. 

  

2. For each of the different weights, select a number from the drop-down list box. For 

information on how these numbers are used to calculate a contact’s wait time in 

queue, refer to the equation on page 138. 

3. From the File menu, choose Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 
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Queue COS 

Queues have two Class of Service (COS) features: ‘Force Day Mode’ and ‘Always handle contacts 

from other queues before this one.’  

The sections that follow provide more information on the Class of Service features for a queue. 

Day Mode, Night Mode, and Busy Mode  

To understand Force Day Mode, you must understand what the different modes are. 

Workflow directs contacts to a queue through the Queue Object action. Based on the 

queue’s current status, workflow can provide a contact unique treatment:  

• A queue is in day mode when at least one user is logged on. A contact presented to the 

queue while it is in day mode is successfully registered in the queue and is directed to the 

action specified in the ‘On Success Go To’ field. 

• A queue is in night mode when all users have logged off from the queue. A contact 

presented to the queue while it is in night mode is not registered in the queue and is 

directed to the action specified in the ‘On Night Mode Go To’ field.   

• A queue is in busy mode when the ‘Busy Queue Threshold’ is met. A contact presented 

to the queue while it is in busy mode is not registered in the queue and is directed to the 

action specified in the ‘On Busy Mode Go To’ field.  

Force Day Mode 

Selecting ‘Force Day Mode’ for a queue allows you to force workflow to follow the path 

that is specified for day service as described above, even when all of the users log off 

from the queue. When the ‘Force Day Mode’ feature is enabled, the night treatment for a 

queue is ignored. 

• A contact presented to the queue while it is in day mode is successfully registered in the 

queue and is directed to the action specified in the ‘On Success Go To’ field.  

• A contact presented to the queue while it is in night mode is successfully registered in the 

queue and is directed to the action specified in the ‘On Success Go To’ field. 

A contact presented to the queue while it is in busy mode is not registered in the queue 

and is directed to the action specified in the ‘On Busy Mode Go To’ field. Note: To modify 

a queue, you must be in Edit Mode and have a user type that allows you to access the 

Users, Queues, Teams & Skills folder. For information on permission levels and user types, 

refer to page 27. 

 

To enable Force Day Mode: 
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1. Navigate to the queue that you wish to customize or modify. 

The ‘Properties’ page for the selected queue appears on the right side of the 

iceAdministrator window.  

2. Click the ‘Force Day Mode’ checkbox to enable this feature. 

  

3. From the File menu, choose Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box) 

  

Caution: When ‘Force Day Mode’ is disabled and a queue goes into night mode while 

contacts are queued, the contacts are not handled unless a user picks them out of the 

queue, or unless a user logs on to the queue to handle the remaining contacts. 

 

 
 If Logged in Elsewhere 

Selecting this option forces the queue to be in Day Mode, only if agents are logged into 

the same queue on another server. If agents are not logged into the queue on the current 

server, or any other server, the queue will be in night mode. It allows contacts to enter the 

queue during failover. 

 

 
 

 Note: 

• This option is only available if ‘Force Day Mode’ is selected. 

• This option should only be used for non-24/7 queues. 

Always handle contacts from other queues 

This class of service feature allows you to assign a prioritization setting to a queue. If 

selected, the contacts for this queue will never be handled unless all other queues are 

empty. This class of feature would be used for a queue which only receives email 

contacts.  By enabling this setting, the contact center would always handle queued voice 

calls before queued emails. 

If multiple queues have this class of service, their contacts, weights, and priority 

calculations are treated equally. 
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Alerting Mode 

There are three queue alerting modes; hunt group, longest idle, and parallel. A queue can 

only be configured with one of the alerting modes at a time and alerting modes apply to 

all modalities that can be placed into the queue.   

 

Alerting Modes 

Mode Description  

Hunt 

Group 

Hunt Groups alert users in a pre-specified order. The alerting 

order can be specified under ‘User Assignments.’ For more 

information on viewing or changing the Hunt Group order, view 

Hunt Group Order on page 147. 

 

Longest 

Idle 

This is the default alerting mode. This mode will alert the user who 

has been idle (not on call) the longest.  

 

Parallel This alerting mode rings multiple users at once. If the ‘Alert All 

Users’ box is selected, ice will alert all users up to the “Max Parallel 

Alert” setting specified during the ice deployment. By deselecting 

the ‘Alert All Users’ box, you can enter the ‘Maximum number of 

Users Parallel Alerting.’ This means ice will alert as many users who 

are in the Ready State until it reached the maximum number. 

  

 

Note:  

• Max number of users parallel alerting – if the max is higher than the number of 

agents logged in, ice will alert all agents logged in. 
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• Parallel alerting is incompatible with Multi-contact handling, SwitchID Tagging, 

Teams Direct Routing Fallback to PSTN/SIP and Teams Direct Routing PSTN 

Block. 
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User Assignments 

As described in  
 

Chapter 2: Users, a user can be assigned to queues from his or her user profile. Use this feature if 

you want to assign one user to different queues. Alternatively, you may assign multiple users to a 

single queue from the ‘User Assignments’ page that is available for each queue. 

Note: To modify a queue you must be in Edit Mode and have a user type that allows you to 

access the Users, Queues, Teams & Skills folder. For information on permission levels and user 

types, refer to page 27. 

 

To add users to a specific queue: 

1. Navigate to the queue that you wish to customize or modify.  

2. Click the User Assignments tab to bring that page to the front. 

The queue’s current user assignments are shown in the ‘Assigned Users’ column. The left column 

displays all of the users that have not been assigned to the queue. 

 

 

Note: If there is more than one user in the ‘Unassigned Users’ or the ‘Assigned Users’ column, 

you can sort the list numerically by user ID or alphabetically by name by clicking on the ID or 

Name column headings. You can also click on the Type column to sort by user type (e.g., User, 

Team Leader, Supervisor, or Administrator).  
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3. To add a user to the queue, highlight the user in the left column and click Add. 

To remove a user from the queue, highlight the user in the right column and click Remove. 

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

Hunt Group Order 

A Hunt Group queue will alert agents in the order specified under ‘Assigned Users.’ For 

more information on Hunt Groups, view Alerting Mode on page 144. 

 

To change the alerting order: 

1. Select the user whose position you want to change.  

2. Click the Up button to move the user up in the order, or the Down button to move the 

user down in the order. 

  

This section has explained how to configure a queue’s user assignments. The section that 

follows provides information on deleting a queue. 

Note: If you remove a user from a queue while they are logged on to the queue, the user 

is automatically logged off from the queue when you save your changes. 
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Modifying Multiple Queues 

Use the ‘Multi-Settings Change’ feature if you want to avoid modifying each user’s settings 

individually when you need to change the same settings for all queues or a subset of queues. For 

example, you want to change the ‘No Answer Time’ on the ‘Properties’ tab to 15 seconds for all 

queues. You could change this for all queues all at once using this feature, rather than modifying 

each queue’s settings individually. 

Note: To modify a queue, you must be in Edit Mode and have a user type that allows you to 

access the Users, Queues, Teams & Skills folder. For information on permission levels and user 

types, refer to page 27. 

 

To modify the settings for multiple queues: 

1. Right-click on any queue in the tree view. 

A menu appears. 

   

2. Select Multi-Settings Change from the menu. 

The following message appears: 

  

3. Click Yes to continue. Click No to cancel the process. 
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The ‘Apply Selected Settings to Multiple Queues’ dialog box appears. This dialog box contains the 

same tabs and configuration settings as those that appear for a single queue. At the bottom of 

the dialog box, you can select the queues for which you want to change the settings. 

  

 

 

You must highlight the fields that you want to change. 

4. Hold the Ctrl key and click the field you want to highlight. To deselect the field, hold the Ctrl key 

and click the field again. 

The field remains highlighted even if you move to a different tab. When you save your changes, 

all highlighted fields will be changed for each selected queue to the values that you set. 

5. Click on the box beside the field to select or deselect an option.  

Note: You must highlight the field by holding the Ctrl key before selecting or deselecting an 

option. 
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6. To apply the changes to other queues, highlight the queues in the left column and click Add. 

To remove a queue from the ‘Apply Selected Fields To’ section, highlight the queue in the right 

column and click Remove. 

7. Click Apply to make the changes. (Click Exit to close the dialog box without making any changes.) 

A message similar to the one below appears: 

  

8. Click OK to close the message box. 

9. Click Exit or click the close (X) button to close the ‘Apply Selected Settings to Multiple Queues’ 

dialog box. 

10. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 
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Deleting a Queue 

If you wish to completely remove a queue from iceAdministrator, you should delete the queue.  

Note: To delete a queue, you must be in Edit Mode and have a user type that allows you to 

access the Users, Queues, Teams & Skills folder that is part of iceAdministrator’s tree view. For 

information on permission levels and user types, refer to page 27. 

 

To delete a queue, complete the following steps: 

1. Navigate to the queue that you wish to delete.  

2. Right-click on the queue in the tree view and select Delete from the menu that appears. 

   

3. A warning appears:  

  

Click Yes to delete the queue or click No to cancel the deletion. 

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 
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Note: 

• All users are automatically unassigned from the deleted queue.  

• If the queue that you delete is used in workflow, an error message appears to inform you that a 

specific action in workflow is incomplete. You will not be able to save your changes until you 

make the appropriate modifications to the specified action in workflow.  

• The New User option is also available from the right-click menu. Selecting this option allows you 

to create a new user that is also assigned to this queue. For more information on creating users, 

refer to page 49. 

This section has explained how to delete a queue. The section that follows provides information 

on deleting multiple queues. 
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Emptying the Queues Folder 

You may decide to delete all queues to avoid conflict messages when importing queues. 

Note: To delete a queue, you must be in Edit Mode and have a user type that allows you to 

access the Users, Queues, Teams & Skills folder. For more information on permissions on 

iceAdministrator, refer to page 27. 

 

To delete all queues: 

1. Right-click on the Queues folder. 

A menu appears. 

   

2. Select Empty from the menu. 

A warning appears. 

  

3. Click Yes to delete all of the queues or click No to cancel the deletion. 

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

Note: If a deleted queue was used in workflow, the actions where the queue was used must be 

completed before you can save your changes. For example, if the queue that was specified in the 

queue object action was deleted, the action is now incomplete and changes cannot be saved.

 





 

 

 

 

 

 

 

 

Chapter 4: Teams 

Team Leaders and other user types can use teams to view groups of users in iceMonitor. For more 

information on iceMonitor, refer to the iceMonitor User Manual.  

The sections that follow describe how to view existing teams, add new teams, modify teams, 

assign users to teams, and delete teams from ice.  

Note: 

• iceAdministrator should be used by trained contact center staff. Before you begin modifying 

or creating teams, you must be familiar with your current configuration.  

• To view and edit teams, you must have a user type that allows you to access the Users, 

Queues, Teams & Skills folder that is part of iceAdministrator’s tree view. This chapter 

assumes that you are familiar with the permissions on ice, as described in  
 

Chapter 1: Getting Started. 

• Team Leaders can manage users that are part of their team, within the confines of the 

permissions allowed to the Team Leader user type. 

• Changes to team properties are audited and visible in iceManager Audit Trails. For a complete 

list of audited objects, refer to the iceManager User Manual. 
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Viewing a Team 

You may wish to view a team if you are planning to change its name, the user assignments, or 

delete the team from ice.  

Viewing teams involves finding and selecting a team in the tree view. When a team is selected, the 

right side of the iceAdministrator window displays two tabs that detail the team’s configuration.  

Note: To view a team, you must have a user type that allows you to access the Users, Queues, 

Teams & Skills folder. For information on permission levels and user types, refer to page 27. 

 

To navigate to a team: 

1. Open the Users, Queues, Teams & Skills folder in the tree view. 

The Teams sub-folder is displayed. 

 

2. Open the Teams folder in the tree view. 

The teams that have already been created are displayed in the tree view. Each team can be 

expanded to show the users who have been assigned to the team. 
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3. Highlight a team to view its configuration. 

Two tabs appear in the detail view: the ‘Properties’ tab, and the ‘User Assignment’ tab. By default, 

the ‘Properties’ page is displayed.  

 

 

 

This section has explained how to navigate to a team. The sections that follow describe how to 

add a new team, and how to modify the properties for a team. 
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Adding a Team 

A new team may need to be added to accommodate changes in your contact center. 

 

There are two methods of adding a team: 

• Add a ‘New Team.’ This allows you to create one team with iceAdministrator’s default properties.  

• Add ‘New Team(s).’ This allows you to create one team or many teams. Use this feature if you 

want new teams to have the same properties (e.g., User Assignments) as an existing team in your 

contact center.  

The sections that follow describe each method of creating teams. 

Note: To add a team, you must be in Edit Mode and have a user type that allows you to access 

the Users, Queues, Teams & Skills folder that is part of iceAdministrator’s tree view. For 

information on permission levels and user types, refer to page 27. 

Adding a New Team 

To add a new team: 

1. Right-click on the Teams folder in the tree view. 

A menu appears. 

 

2. Select New Team from the menu. 
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Two tabs appear in the detail view: the ‘Properties’ tab, and the ‘User Assignment’ tab. By 

default, the ‘Properties’ page is displayed on top. 

  

3. In the ‘Team Name’ field, enter a name for the team. 

This name can be up to 40 characters in length. The name of the team appears on ice 

reports. 

4. In the ‘Short Name’ field, enter a short name for the team. 

This name can be up to 8 characters in length. The short name of the team appears in 

iceMonitor.  

5. From the File menu, choose Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 

This section has explained how to add a team with the default properties. The section that 

follows describes how to add multiple teams.  
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Adding Multiple Teams 

iceAdministrator allows you to create multiple teams simultaneously: 

• You can add teams based on iceAdministrator’s default properties, which is very 

similar to adding a ‘New Team’, as described in the previous section.  

• You can add teams based on an existing team’s configuration, which is referred to as 

the ‘Template.’ This feature can be helpful if you want the new teams to have the 

same properties as the existing teams in your contact center. 

To add multiple teams: 

1. Right-click on the Teams folder in the tree view. 

A menu appears. 

 

 

2. Select New Team(s) from the menu. 

The following message box appears: 
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3. Click Yes to continue. Click No to cancel the process. 

The ‘Create New Teams’ dialog box appears. 

 

 

4. Select the number of teams that you wish to create from the ‘Number of Teams 

to create’ drop-down list. 

5. Select the ‘Default’ radio button if you would like the new teams to have the 

default team configuration or select ‘From Template’ if you would like each new 

team to have the same configuration as an existing team. 

When the ‘From Template’ radio button is selected, you can highlight a team in 

the ‘Choose Template’ table. 
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The illustration below shows that Team Y has been selected as the template. 

 

 

6. Click OK to create the new teams. 

The teams appear in the tree view. 

 

 

7. From the File menu, choose Save. (To cancel the save operation, click Cancel on 

the ‘Progress’ dialog box.) 
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User Assignments 

As described in Chapter 2: Users, a user can be assigned to queues from his or her user profile. 

Use this feature if you want to assign one user to different queues. Alternatively, you may assign 

multiple users to a single queue from the ‘User Assignments’ page that is available for each 

queue.  

Note: To modify a team, you must be in Edit Mode and have a user type that allows you to access 

the Users, Queues, Teams & Skills folder. For information on permission levels and user types, 

refer to page 27. 

 

To add users to a team: 

1. Navigate to the team that you wish to modify.  

2. Click the User Assignments tab to bring that page to the front. 

The team’s current user assignments are shown in the ‘Assigned Users’ column. The left column 

displays all of the users that have not been assigned to the team. 

 

 

Note: If there is more than one user in the ‘Unassigned Users’ or the ‘Assigned Users’ column, 

you can sort the list numerically by user ID or alphabetically by name by clicking on the ID or 

Name column headings respectively.  

3. To assign a user to the team, highlight the user in the left column and click Add. 

To remove a user from the team, highlight the user in the right column and click Remove.  

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) When you save your changes, the user is automatically added to or removed from 

the team. 
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Deleting a Team 

If you wish to completely remove a team from iceAdministrator, you should delete the team.  

Note: To delete a team, you must be in Edit Mode and have a user type that allows you to access 

the Users, Queues, Teams & Skills folder that is part of the iceAdministrator’s tree view. For 

information on permission levels and user types, refer to page 27. 

 

To delete a team: 

1. Navigate to the team that you wish to delete.  

2. Right-click on the team in the tree view and select Delete from the menu that appears. 

 

3. The following confirmation message appears:  

 

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

When you save your changes, the team is deleted and the users are automatically removed from 

the team. 
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Emptying the Teams Folder  

You may decide to delete all teams to avoid conflict messages when importing teams.  

Note: To delete a team, you must be in Edit Mode and have a user type that allows you to access 

the Users, Queues, Teams & Skills folder. For information on permission levels and user types, 

refer to page 27. 

 

To delete all teams: 

1. Right-click on the Teams folder. 

A menu appears. 

 

2. Select Empty from the menu. 

A warning appears. 

 

3. Click Yes to delete all of the teams or click No to cancel the deletion. 

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 





 

 

 

 

 

 

 

 

Chapter 5: Skills 

Skills can be used to route contacts with particular needs to a user who is best qualified to meet 

those needs. Instead of routing contacts to the user who has been idle the longest in a queue, 

you may route the contact to the user who has the highest skill level. To direct contacts requiring 

particular skills to the most qualified users possible, you can do the following:  

• Create skills in the Skills folder 

• Use workflow to determine contact needs (e.g., tagging a contact with specific skills) 

• Assign skills to users 

• Modify queue thresholds and weights 

The sections that follow describe how to view existing skills, create new skills, assign skills to 

contacts, assign skills to users, modify skill parameters in a queue, and delete skills from ice.  

Note: 

• This chapter assumes you are familiar with the concepts of workflow. For more information on 

workflow, refer to iceWorkflow Designer User Manual. 

• iceAdministrator should be used by trained contact center staff. Before you begin modifying 

or creating skills, you must be familiar with your current configuration.  

• To view and edit skills you must have a user type that allows you to access the skills subfolder 

that is part of the Users, Queues, Teams & Skills folder in iceAdministrator’s tree view. This 

chapter assumes that you are familiar with the permissions on ice, as described in  

 

Chapter 1: Getting Started. 

• Changes to skills are audited and visible in iceManager Audit Trails. For a complete list of 

audited objects, refer to the iceManager User Manual. 
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Viewing a Skill 

You may wish to view existing skills if you are planning to modify the way in which skills are used 

in your contact center.  

Viewing a skill involves finding and selecting the skill in the tree view. When a skill is selected, the 

right side of the iceAdministrator window displays some information about the skill.  

Note: To view skills, you must have a user type that allows you to access the Skills subfolder in 

the Users, Queues, Teams & Skills folder. For more information on permissions on 

iceAdministrator, refer to page 27. 

 

To navigate to a skill: 

1. Open the Skills subfolder in the tree view. 

The skills that are currently configured are displayed. 

 

2. Highlight a skill to view its skill ID and skill name on the right side of the iceAdministrator window. 

 

This section has explained how to navigate to a skill. The sections that follow describe how to add 

a new skill, and how to modify the properties for a skill. 
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Adding a Skill 

You might need to create a new skill to accommodate changes at your contact center. 

 

There are two methods of adding skills: 

• Add a skill in the tree view. 

• Add a skill when setting up workflow. This allows you to create skills on the spot as workflow is 

being developed. For more information on workflow, refer to the iceWorkflow Designer User 

Manual. 

The sections that follow describe each method of creating skills. 

Note: To add a skill, you must be in Edit Mode and have a user type that allows you to access the 

Skills folder. For more information on permissions on iceAdministrator, refer to page 27. 

Adding a Skill in the Tree View 

To add a skill to the tree view: 

1. Right-click on the Skills subfolder in the tree view. 

A menu appears. 

  

 

2. Select Add Skill from the menu. 

The detail view displays a ‘Properties’ page for a new skill. 
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3. Specify a name for the skill in the ‘Skill Name’ field. 

The name can be up to 40 characters in length. 

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 

A new skill does not have any impact on your contact center until it has been assigned to 

users and workflow has been designed to assign the skill to contacts. 

Adding a Skill from the Properties of a Workflow Action 

On the properties page of a workflow action, you can create a new skill from a drop-

down list that requires the selection of a skill. 

 

To create a skill from the properties dialog box of a workflow action: 

1. From the workflow page, double-click the action from which you would like to create the 

skill. 

2. In the field that requires a skill, for example, the ‘Skill’ field on the Assign Skills to Object 

workflow action’s properties page, select <NEW SKILL> from the drop-down list box. 
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You can also right-click the arrow in the drop-down list box and select Skill from the 

menu that appears. 
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The ‘Select Skill’ dialog box appears. 

 

 

3. Click the Create New button on this dialog box. 

The ‘New Skill’ dialog box appears. This dialog box has the same properties page as the 

one that appears when you create a skill from the tree view. 

4. Click OK on this dialog box to add the skill. 

The skill is added to the tree view and becomes the selected option in the workflow 

action field. 

5. From the File menu, choose Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 
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Assigning Skills to Users 

As described in Chapter 2: Users, skills can be assigned to a user from his or her user profile. This 

tab is useful if you wish to assign multiple skills to one user. Alternatively, you may assign a single 

skill to multiple users using the ‘User Assignments’ page that is available for each skill.  

Note: When you assign skills to users from the ‘User Assignments’ page of that skill, you are 

modifying the users in question. You must have a user type that allows you to modify users. For 

information on permission levels and user types, refer to page 27. 

 

To assign a skill to users: 

1. Navigate to the skill that you wish to modify.  

2. Click the User Assignments tab to bring that page to the front. 

The users with this skill are shown in the ‘Assigned Users’ column. The left column displays all of 

the users that have not been assigned the skill. 

 

Note: If there is more than one user in the ‘Unassigned Users’ or the ‘Assigned Users’ column, 

you can sort the list numerically by user ID or alphabetically by name by clicking on the ID and 

Name column headings.  

3. Highlight the user that you wish to assign to this skill in the ‘Unassigned Skills.’ 

4. From the ‘Level’ drop-down list, select a number between one and five that represents the user’s 

proficiency in the skill. 

 

Five represents the highest level of proficiency in a skill. 

5. Click Add to assign the skill to the user. 

To remove the skill for a particular user, highlight the user in the right column and click Remove.  
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6. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

When you save your changes, the skill is automatically assigned to the user(s) or removed from 

the user(s)’ list of skills. 

Note: To assign skills to a particular user from the user’s own properties pages, refer to ‘Assigning 

Skills to Users ’ on page 98. 
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Deleting a Skill 

A skill that is no longer required can be deleted. 

Note: To delete a skill, you must be in Edit Mode and have a user type that allows you to access 

the Skills subfolder that is part of iceAdministrator’s tree view. For information on permission 

levels and user types, refer to page 27. 

 

To delete a skill: 

1. Navigate to the Skills subfolder and right-click on the skill you wish to delete. 

A menu appears. 

 

2. Select Delete from the menu. 

A message box appears. 

 

3. Click Yes to proceed or click No to cancel the deletion. 

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

This section has explained how to delete a skill that is no longer required. The next section 

provides information about deleting all skills.  

Note: If the skill you have deleted was used in workflow, you may have to complete any Assign 

Skills to Object actions or modify workflow before you can save your changes. 
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Emptying the Skills Folder 

You may decide to delete all skills to avoid conflict messages when importing skills.  

Note: To delete a skill, you must be in Edit Mode and have a user type that allows you to access 

the Skills folder. For information on permission levels and user types, refer to page 27. 

 

To delete all skills: 

1. Right-click on the Skills folder. 

A menu appears. 

 

2. Select Empty from the menu. 

A warning appears. 

 

3. Click Yes to delete all of the skills or click No to cancel the deletion. 

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 
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Assigning Skills to Contacts 

Workflow can be designed so that contacts are answered by users who possess the skills 

necessary to handle them.  

Skills are assigned to a contact using the Assign Skills to Object action in workflow. The properties 

for the Assign Skills to Object action include a series of drop-down lists allowing you to select a 

skill, a skill type, a skill level, and a skill priority. These settings are used to calculate the 

compatibility of each user with the contact waiting in the queue based on the contact’s 

requirements and each user’s skill level. Multiple skills can be assigned to a contact. 

• The skill type is either discretionary or mandatory. For more information, refer to ‘Queue Skill 

Thresholds’ on page 183. 

• The skill level setting determines the skill level required by a user in order to handle the contact. 

The skill level can be set to a number or ‘Dynamic.’ For more information on the dynamic skill 

level feature, refer to Dynamic Skill Downgrade Threshold on page 184. 

• The skill priority sets the importance of a skill relative to the other skills assigned to the contact. 

For more information, refer to ‘How Skill Priority Affects Skills Score ’ on page 197. 

For more information on completing the properties of the Assign Skills to Object action, refer to 

iceWorkflow Designer User Manual. 

Before the Assign Skills to Object action is used, workflow must have a means to determine the 

contact’s needs. This is accomplished by using actions such as Check ANI, Check DNIS, Get Caller 

Input, Compare Data, Evaluate Expression, Database actions, Check Email, etc. to determine 

information about the contact.  

Any action that makes a routing decision can be used to determine whether a contact requires a 

user with specific skills (e.g., did the caller dial a specific number?). Multiple actions in workflow 

can help clarify contact demands further (e.g., did the caller make a selection for assistance in 

French?).  

The sections that follow describe some of the ways that skills can be assigned to contacts. 
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Assigning Skills Based on DNIS or ANI 

Check DNIS and Check ANI can be used to assign skills to contacts. This method is 

recommended for contact centers that: 

• Have a relatively low number of skills to associate with contacts; 

• Publish multiple telephone numbers and are able to identify contact needs by numbers 

dialed; 

• Segment callers on the basis of geography. 

To understand how Check ANI can be used to assign skills to a contact, consider a 

contact center that provides technical support service for PCs and employs a certain 

number of bilingual staff. The ice administrator, knowing that any contact from 

Montreal’s 514 area code could be either an English- or French-speaking client, might: 

• Assign the skill “Bilingual” to the appropriate users. 

• Use the Check ANI action to scan for the 514 area code, and route the contacts with this 

area code to an Assign Skill action.  

• Assign the skill “Bilingual” to the contacts that pass through the Assign Skill action.  

These actions examine the area code of each contact that arrives and instructs ice to 

exclude, as a routing possibility, any user who is not bilingual whenever the originating 

telephone number has an area code of 514. 

The following illustration provides an example of the workflow required for this 

configuration. A green link indicates success (e.g., caller makes a valid selection). A red 

link indicates failure (e.g., caller makes an invalid selection).  
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Using the Check DNIS action can help to further clarify caller demands. For example, the 

same contact center might provide clients with a special telephone number to dial 

whenever they have questions specifically about operating systems. Only certain 

personnel are knowledgeable about this topic. In this case the ice administrator could: 

• Assign the skill “Operating System” to the appropriate users. 

• Use the Check DNIS action to scan for the DNIS associated with the special telephone 

number, and route contacts that have dialed this number to an ‘Assign Skills to Object’ 

action. 

• Assign the skill “Operating System” to the contacts that pass through the Assign Skills to 

Object action.  

The following illustration provides an example of the workflow required for this 

configuration.  
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Assign Skills Based on Caller Input 

Get Caller Input can be used to assign skills to contacts by prompting a contact to 

identify the nature of his/her call through touch-tone commands (DTMF signals). This 

action can be used multiple times in workflow to narrow the pool of eligible users.  

Consider a caller who encounters the following instructions: 

• For service in English, press one; pour le service en français, appuyez sur deux. 

• If your question is about your operating system, press one; otherwise, press two. 

If the contact presses 2 for French, then his or her call can be routed to an ‘Assign Skills to 

Object’ action that assigns the skill ‘Bilingual’ to the contact. The caller is then routed to 

the second set of options in French.  

In the second example, if the caller presses one at this decision point, then his or her call 

can be routed to an ‘Assign Skills to Object’ action that assigns the skill ‘Operating 

System.’ In this scenario, the contact is ‘tagged’ as one requiring a user who is bilingual 

and has a specialty in operating systems. 

The following illustration provides an example of the workflow required for this 

configuration. A blue link indicates a timeout has occurred (e.g., caller does not make a 

selection.) 
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Assign Skills based on Database Query 

Database actions might be used to query a database. Data that is returned to workflow 

from the database can be analyzed (e.g., by the Compare Data or Evaluate Expression 

actions) to determine if the contact requires skills.  

There are two possible ways of identifying a client so that his/her profile can be retrieved 

from the database: 

• Through an account number that the caller is prompted to enter (i.e., through the Get 

Caller Input action). 

• Through the telephone number that the caller dialed (i.e., through the Check DNIS 

action).  

Consider a contact center that sets the following parameters: 

• Calls from Montreal and surrounding areas require bilingual users. 

• Calls from clients who have purchased their operating systems in the past three months 

require users with expertise in operating systems. 

Three clients call the contact center on March 14, 2017, with profiles as follows: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Based on the parameters outlined above: 

• Client A would not be assigned any skills. 

• Client B would be assigned a “Bilingual” skill. 

• Client C would be assigned “Bilingual” and “Operating System” skills.  

Sample clients 

 Client A Client B Client C 

Name John Smith Thunderbolt 

Consulting 

Jean Monchamp 

Address 100 Green Street 73 Rue de l’Anse-

Bleu 

42 Rue Talbot 

City Toronto Laval Montreal 

Province Ontario Quebec Quebec 

Postal Code M7T 3R8 H7N 4B1 H3B 5E7 

System 

Purchased 

January 26, 2015 June 28, 2006 

 

February 28, 2017 
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The following illustration provides an example of the workflow required for this 

configuration. 
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Queue Skill Thresholds 

Queue thresholds can affect the skill requirements calculation for a contact waiting in a queue.  

Ignore Discretionary/Mandatory Skill Threshold  

The Assign Skill action in workflow allows you to set a skill as either discretionary or 

mandatory. The Assign Skill action also allows you to choose the skill level that is required 

by the contact.  

When a skill is designated as discretionary, ice considers any user with a skill proficiency 

that is equal to or greater than the skill level required as qualified. However, when the 

‘Ignore Discretionary Skill Threshold’ is reached, a user with a lesser skill level or no skill 

level for that skill may be presented with the contact. This threshold cannot be greater 

than the ‘Ignore Mandatory Skill Threshold.’ 

When a skill is designated mandatory, ice considers any user with a skill proficiency that is 

equal to or greater than the skill level required as qualified. However, when the ‘Ignore 

Mandatory Skill Threshold’ is reached, a user with a lesser skill level or no skill level for 

that skill might be presented with the contact. This threshold cannot be less than the 

‘Ignore Discretionary Skill Threshold.’  

By default, these thresholds are disabled so that the skill requirement that you set in the 

Assign Skill action is never removed from the contact.  

Caution: If you disable these thresholds, it is important that users with the skill levels 

required by contacts are logged onto the queues. If the logged on users do not have the 

required skill level, the contact could wait indefinitely for the user with the appropriate 

skill set.  
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Dynamic Skill Downgrade Threshold  

The Assign Skills action allows you to set the skill level required by the contact to 

‘Dynamic’, which indicates that, initially, the contact requires the highest level of skill 

available.  

When the queue threshold ‘Dynamic Skill Downgrade Threshold’ is reached, ice 

automatically downgrades the contact’s skill requirement by one level. The downgrade 

threshold acts as an interval, so that at each interval the contact’s skill requirement 

continues to decrease to a minimum of level of 1.  

 

Consider a contact center that currently has two users logged on to a queue that uses a 

“Bilingual” skill to route callers to the user with the best skill set: 

• The caller has been assigned the “Bilingual” skill with a dynamic skill level.  

• The ‘Dynamic Skill Downgrade Threshold’ has been set to 10 seconds.  

• User A has been assigned level 4 in the “Bilingual” skill.  

• User B has been assigned level 3 in the “Bilingual” skill. 

As a result of the above settings, User A should be presented with the call because this 

user has the highest level in the required skill. If User A is not available, the call waits for 

10 seconds for a user with the highest skill level to become available. After 10 seconds, 

the skill requirement is decreased by one level, and the call can be answered by either 

User A or User B.  

By default, the ‘Dynamic Skill Downgrade Threshold’ is disabled so the skill requirement 

stays constant as the highest level of skill available. A contact with a dynamic skill 

requirement is also subject to the discretionary/mandatory skill thresholds as described in 

the previous section.  

  



 

 

 

  
  

185 iceAdministrator User Manual 

Configuring Queue Thresholds  

Note: To modify a queue, you must be in Edit Mode and have a user type that allows you 

to access the Users, Queues, Teams & Skills folder. For information on permission levels 

and user types, refer to page 27. 

 

To configure the thresholds for a queue: 

1. Navigate to the queue that you wish to customize or modify. 

The ‘Properties’ page for the selected queue appears on the right side of the 

iceAdministrator window. 

For this process, you need to use the Thresholds portion of the page. 

 

2. To enable the ‘Ignore Discretionary Skill Threshold’, uncheck the ‘Disable’ checkbox and 

select the number of seconds for the threshold from the spin box.   

The default value is 0 seconds. You may set the threshold to reflect any number of 

seconds, minutes, days, or weeks. For example, you may click on 0d and increase the 

threshold to 1 day. This can be useful for queues that handle email contacts.  

3. To enable the ‘Ignore Mandatory Skill Threshold’, uncheck the ‘Disable’ checkbox and 

select the number of seconds for the threshold from the spin box.  

The default value is 0 seconds. This threshold can be set to any number of seconds, 

minutes, days, or weeks, as described in step 2.   

4. To enable the ‘Dynamic Skill Downgrade Threshold’, uncheck the ‘Disable’ checkbox and 

select the number of seconds for the threshold from the spin box.  

The default value is 0 seconds. This threshold can be set to any number of seconds, 

minutes, days, or weeks, as described in step 2.   
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5. From the File menu, choose Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 
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Queue Weights 

Queue weights can affect skills. 

 

A queue’s default ‘Skills Score Weight’ is 1, but the drop-down list allows you to select a number 

between 0 and 100. The selected number is used in an equation that also takes into consideration 

a user’s skills score, which measures his or her ability to handle a contact.  

An increased ‘Skills Score Weight’ places more value on the skill score (and less value on both the 

contact’s queued time and user’s idle time) when calculating a contact’s position in queue. 

In addition to the ‘Skills Score Weight’, each queue also has a ‘Priority Weight’, a ‘Queued Time 

Weight’, and a ‘User Idle Time Weight.’ For more information on configuring a queue’s weights, 

refer to page 138. 
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Finding the “Best User” for a Contact 

As soon as a contact with skill requirements arrives in a queue, ice calculates a total  against that 

contact for each user who meets all of the following eligibility conditions: against that contact for 

each user who meets all of the following eligibility conditions: 

• Currently logged into the queue. 

• Currently in the Ready state (in other words, available to receive a contact). 

• Assigned at least the minimum proficiency level in each of the skills assigned to the contact. 

The formula to calculate a user’s total score against a contact is as follows:  

(SC * SW) + (AT * AW) 

The table below explains the abbreviated variables above.  

Best User equation variables 

Variable Meaning 

SC The user’s skills compatibility score (i.e., proficiency of the user in 

relation to the contact. For more information on the skills 

compatibility score, refer to page 195). 

SW The skills score weight that has been selected for the queue. 

AT The actual amount of time the user has been idle, expressed in 

seconds.  

A user’s idle time is calculated from the time that they last 

completed a queued contact. Changing states (i.e., toggling 

Ready/Not Ready, receiving a direct call, placing an outbound call) 

does not reset the user’s idle time. The user’s idle time refreshes 

once they have completed a queued contact.  

AW The user’s idle time weight that has been selected for the queue. 

 

The user who meets all three eligibility conditions and registers the highest total score against the 

contact is the one who will receive the contact. If there are no users who meet every condition, no 

total scores are calculated and the contact waits in queue. 

Calculating Users’ Scores Against a Contact 

To understand how users’ total scores are calculated against a contact, consider Users A 

and B, who are currently in the Ready state and operating in the same queue. The queue 

has a ‘Skills Score Weight’ of 1, a ‘User Idle Time Weight’ of 1, and each user’s last contact 



 

 

 

  
  

189 iceAdministrator User Manual 

was completed 60 seconds ago. A contact, for which User A’s skills compatibility score is 

45% and User B’s skills compatibility score is 80%, arrives in the queue. For more 

information on calculating a user’s skills compatibility score against a contact, refer to 

page 195. 

The total score that User A registers against this newly arrived contact is calculated as 

follows: 

(45 * 1) + (60 * 1) = 105 

The total score that User B registers against the contact is calculated as follows: 

(80 * 1) + (60 * 1) = 140 

Because User B registers the higher of the two total scores, the newly arrived contact is 

sent to him.  

How User Idle Time Weight Affects a User’s Score 

Consider the result if User A’s skills score was still 45%, but his last contact was completed 

45 seconds ago and User B’s skills score was still 80%, but his last contact was completed 

20 seconds ago: 

User A’s total score against the contact is calculated as follows: 

(45 * 1) + (45 * 1) = 90 

User B’s total score against the contact is calculated as follows: 

(80 * 1) + (20 * 1) = 100 

In the above case, the skills score is still more important, and User B receives the contact. 

If the user’s idle time is given more weight, however, the results could be different. 

Consider the same scenario, but with a ‘User Idle Time Weight’ of 2: 

User A’s total score against the contact is calculated as follows: 

(45 * 1) + (45 * 2) = 135 

User B’s total score against the contact is calculated as follows: 

(80 * 1) + (20 * 2) = 120 

User A now receives the contact, despite his much lower skills compatibility score. By 

including user idle time weight in the formula for a user’s total score, ice allows your 

contact center to reduce the likelihood that less qualified users remain unoccupied for 

indefinite periods while more qualified ones become overburdened by contacts. 
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How Skills Score Weight Affects a User’s Score 

To illustrate the effect of different skills score weights on a user’s total score, consider the 

result if the ‘Skills Score Weight’ for the same queue was 10 (and all the above 

circumstances remained the same). 

User A’s total score against the newly arrived contact would be calculated as follows: 

(45 * 10) + (45 * 2) = 540 

User B’s Total Score would be calculated as follows: 

(80 * 10) + (20 * 2) = 840 

In this case, User B receives the contact once again, even though he has been idle for less 

than half of the time that User A has. By including ‘Skills Score Weight’ in the formula for 

a user’s Total Score, ice allows your contact center to improve the likelihood that contacts 

requiring certain user capabilities are handled by the most qualified user possible, despite 

greater idle time experienced by less suitable users. 
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Finding the “Best Contact” for an Available User 

Each time any user in a queue enters the Ready state, ice calculates a contact score for that user 

for each queued contact he/she is qualified to handle. The contact that registers the highest 

contact score against the user is the one that ice sends to the user. 

The formula to calculate a queued contact’s score against any qualified, newly available user is as 

follows: 

(SC * SW) + (QT* QW) + (PL * PW) 

The table below explains the abbreviated variables above. 

Best Contact equation 

Variable Meaning 

SC The user’s skills compatibility score (i.e., proficiency of the user in 

relation to the contact. For more information on the skills score, 

refer to page 195). 

SW The skills score weight that has been selected for the queue. 

QT The actual amount of time the contact has been waiting in queue. 

QW The queued time weight that has been selected for the queue. 

PL The priority level the contact has been assigned in the queue 

object action that is part of workflow. 

PW The priority weight that has been selected for the queue. 

 

Note: 

• The default setting for each queue weight is 1. 

• For more information on configuring a queue’s weights, refer to page 138. 

Calculating Contacts’ Scores Against a User 

To understand how the contact scores are calculated against a newly available user, 

consider Contacts X and Y, who have been waiting for an available user for 20 seconds.  

If a user with a skills compatibility score of 30% for Contact X and 50% for Contact Y 

becomes available, Contact X’s contact score against that user, assuming a ‘Skill Score 
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Weight’ of 1 a ‘Queued Time Weight’ of 1, and a ‘Priority Weight’ of 1, is calculated as 

follows: 

(30 * 1) + (20 * 1) + (0 * 1) = 50 

Contact Y’s contact score against the user is calculated as follows: 

(50 * 1) + (20 * 1) + (0 * 1) = 70 

Because Contact Y registers the higher score, this contact is sent to the newly available 

user.  

How Priority Affects a Contact’s Score 

Consider the result if Contact X, in being directed to this queue, has received a level of 

priority of 6, while Contact Y has received a level of priority of 8. This could occur if each 

contact passed through different Queue Object actions, where the level of priority is set 

in the ‘With Priority’ field.  

If a user with a skills compatibility score of 30% for each contact becomes available after 

20 seconds, Contact X’s contact score against that user, assuming a ‘Skills Score Weight’ 

of 1 and a ‘Queued Time Weight’ of 1, and a ‘Priority Weight’ of 1, is calculated as follows: 

(30 * 1) + (20 * 1) + (6 * 1) = 56 

Contact Y’s contact score against the user is calculated as follows: 

(30 * 1) + (20 * 1) + (8 * 1) = 58 

Because Contact Y registers the higher contact score against the newly available user, 

Contact Y is routed to the user. 

By including priority in the calculation for contact scores, ice allows your contact center to 

improve the likelihood that any contact assigned a high priority level in the Queue Object 

action is the one sent to the next available and qualified user. 

How Queued Time Affects a Contact’s Score 

Consider the result if Contact X had arrived in the queue 15 seconds sooner. Its contact 

score against the newly available user would be calculated as follows: 

(30 * 1) + (35 * 1) + (6 * 1) = 71 

In this case, Contact X is routed to the user. By including contact age in the formula for 

queued contacts, ice allows your contact center to improve the likelihood that any 

contact assigned a low priority level or skill requirements does not wait indefinitely in 

queue.  
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Preventing Perpetual Wait for the “Perfect User” 

Built-in mechanisms prevent contacts from waiting forever to reach the perfect user.  

Ignore Discretionary Skill Threshold 

Once any contact requiring skills has waited in a queue until that queue’s ‘Ignore 

Discretionary Skill’ threshold is reached, ice modifies the eligibility conditions in order to 

broaden the pool of qualified users. A score against the contact is now calculated for 

each user who meets all the following criteria: 

• Currently logged into the queue. 

• Currently in the Ready state. 

• Assigned at least the minimum proficiency level in each of the mandatory skills assigned 

to the contact. 

In other words, skills defined as discretionary no longer have any bearing on a user’s 

inclusion in the pool of routing possibilities. With potentially more users qualified to 

answer the contact, ice sends the contact to the user who registers the highest score 

against the contact (assuming mandatory skills are present). If these modified eligibility 

conditions fail to yield at least one additional qualified user, the contact remains in queue; 

however, each time another user becomes available, ice continues to measure his/her 

eligibility using the new standard. 

Note: For more information on the ‘Discretionary Skill Threshold’ for a queue, refer to 

page 131. 

Ignore Mandatory Skill Threshold  

Once any contact requiring skills has waited in a queue until that queue’s ‘Ignore 

Mandatory Skill’ threshold is reached, ice modifies the eligibility conditions once again. A 

score against the contact is now calculated for each user who is both: 

• Currently logged into the queue 

• Currently in the Ready state 

In other words, skill proficiency levels no longer have any bearing on a user’s inclusion in 

the pool of routing possibilities. With this pool as large as possible, ice sends the contact 

to the available user who has been idle the longest. If there are no available users logged 

into the queue, the contact continues to wait, and ice immediately directs it to the next 

user who becomes available. 

Note: For more information on the ‘Mandatory Skill Threshold’ for a queue, refer to page 

131. 
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Dynamic Skill Level 

Dynamic skill level prevents contacts from waiting unnecessarily for a specific skill level 

that may not be available.  

The Assign Skills action allows you to set the skill level required by the contact to 

‘Dynamic’, which indicates that the contact requires the highest level of skill possessed by 

users assigned to the particular queue.  

In addition, the ‘Dynamic Skill Downgrade Threshold’ can be set to automatically 

downgrade the required skill level at a timed interval. This feature prevents contacts from 

waiting for long periods of time for users who may otherwise be occupied. For more 

information on ‘Dynamic Skill Downgrade Threshold’, refer to page 184.  

Overflowing Contacts  

In workflow, a contact can “overflow” when it is registered in another queue with the 

Queue Object action. When this happens, a user in the originating queue or a user in any 

of the subsequent queues in which the contact has been registered, can answer the 

contact.  

If, after waiting in the originating queue, a contact is registered in another queue, the 

criteria used to determine its final destination does not change. In other words, ice never 

allows a contact to be handled by any user who would have been ineligible, under the 

same circumstances, to receive that contact in the originating queue.  

Registering a contact in the second queue starts a new set of Discretionary and 

Mandatory Skill Ignore timers. Each queue has its own set of timers. It is recommended 

that you register a contact in another queue before the discretionary/mandatory 

thresholds expire as a final means of ensuring that a waiting contact is matched with a 

reasonably qualified user before the system frees the call to be answered by anybody in 

the originating queue.  
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Skills Compatibility Score 

To understand how ice determines a user’s skills compatibility score for any contact, consider User 

C, who is currently available to receive a contact in the queue that she is operating in. Her skill 

assignments are as follows: 

Skill assignments for User C 

Skill Skill Level 

French 4 

Intranet 5 

Hardware 3 

 

Note: For information on configuring a user’s skills, refer to page 98.  

A contact with the following parameters arrives in the queue: 

Skill requirements for a contact 

Skill Required Skill Level Skill Priority Level 

French 2 2 

Intranet 3 1 

Hardware 2 3 

 

Note: For more information on assigning skills to contacts, refer to page 177.  

Because User C meets every minimum proficiency level that the contact requires, she is qualified 

to receive the contact ice begins to calculate her skills score in order to determine whether she is 

the best suited of all the available users. To do so, ice first totals User C’s proficiency levels in the 

required skills, each of which is expressed as a Score out of 10, as follows: 

 

HardwareIntranetFrench

5

3

5

5

5

4
++  
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ice then accounts for the priority levels assigned to the contact’s assigned skills by duplicating 

User C’s proficiency level once for each skill with an assigned level of priority greater than 1. 

Therefore, the calculation changes to: 

 

HardwareIntranetFrench

5

3

5

3

5

3

5

5

5

4

5

4
+++++  

This calculation can also be expressed as: 

 

( ) ( ) ( )
5

3*31*52*4

HardwareIntranetFrench

++
 

To complete the equation, ice determines the average of User C’s proficiency levels in all skills 

involved. To do so, it divides the sum of the skills’ assigned priority levels into the result of the 

above calculation, as follows: 
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


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6

5
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








=  
6

4.4
=  = .73 

 

Therefore, the figure that ice uses to represent User C’s degree of aptitude for the demands of the 

newly arrived contact is .73; in other words, her skills score is 73%. The more formal expression 

for this calculation is as follows: 
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How Skill Priority Affects Skills Score  

To understand the effect of different skill priority levels on a user’s skills score, consider User D, 

whose skill assignments are as follows: 

Skill assignments for user D 

Skill Skill Level 

French 3 

Intranet 3 

Hardware 5 

 

The skill requirements for the contact are as follows:  

Skill requirements for a contact 

Skill Required Skill Level Skill Priority Level 

French 2 2 

Intranet 3 1 

Hardware 2 3 

 

His skills score for the same contact used to calculate User C’s skill compatibility score is 

calculated as follows: 

( ) ( ) ( )
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6
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=  = 80% 

Because User D has the higher of the two skill scores, he receives the contact. Even though he is 

weaker in two of the skills (namely, French and Intranet), he is stronger in Hardware, which has the 

highest priority. His skill in Hardware makes him the more suitable user to handle the contact.  
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However, consider the result if the contact’s assigned priority level for Intranet were 4. The 

contact now has the following parameters: 

 

Skill requirements for a contact 

Skill Required Skill Level Skill Priority Level 

French 2 2 

Intranet 3 4 

Hardware 2 3 

User C’s compatibility grade would be calculated as follows: 
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User D’s skills score would be calculated as follows: 
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Because User C now has the higher of the two skills scores, she receives the newly arrived contact, 

even though she is weaker in one of the skills (namely, Hardware). By including skill priority levels 

in the formula for skills scores, ice allows your contact center to improve the likelihood that any 

contact with a strong need for certain user aptitudes are handled by the most qualified user 

possible. 

 



 

 

 

 

 

 

 

 
 

Chapter 6: Email Groups 

Email groups enable ice to accept email messages and route them to workflow so that email 

messages can be treated in workflow and queued for the first available user.  

In iceAdministrator, one or more email addresses used to reach your contact center can be 

grouped together in an email group. With the initial installation of ice, each email address is 

configured on the system and assigned to an appropriate email group. After the initial 

installation, email addresses and email groups can be created, deleted, and modified as your 

contact center’s requirements change.  

The sections that follow describe how to view and understand email groups that have already 

been created, as well as how to add, modify, and delete email groups. 

Caution: Many tasks involving email addresses and/or email groups may require the involvement 

of the person that oversees your mail server. 

Note: 

• iceAdministrator should only be used by trained contact center staff. Before you begin 

modifying or creating email groups, you must be familiar with your current configuration.  

• To view and edit email groups, you must have a user type that allows you to access the Email 

Groups folder that is part of iceAdministrator’s tree view. This chapter assumes that you are 

familiar with the permissions on ice, as described in  

 

Chapter 1: Getting Started. 
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Viewing an Email Group 

You may wish to view an email group if you are planning to change the way that inbound email 

messages are handled.  

Viewing email groups involves finding and selecting an email group in the tree view. When an 

email group is selected, the right side of the iceAdministrator window displays two tabs that detail 

the group’s configuration.  

Note: To view an email group, you must have a user type that allows you to access the Email 

Groups folder that is part of iceAdministrator’s tree view. For information on permission levels 

and user types, refer to page 27. 

 

To navigate to an email group: 

1. Open the Email Groups folder in the tree view. 

The email groups that are currently configured are displayed. 

 

2. Open an email group to view the email addresses that are currently assigned to the group. 

The assigned email addresses are displayed. 
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3. Click on an email group to highlight it and view its configuration settings. 

The ‘Properties’ page for the email group appears in the detail view. 

 

This section has explained how to navigate to an existing email group. The sections that follow 

describe how to add and modify settings for an email group. 
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Adding an Email Group 

An email group can be added or modified to meet requirements for new email addresses. 

Note: To add an email group, you must be in Edit Mode and have a user type that allows you to 

access the Email Groups folder that is part of iceAdministrator’s tree view. For more information 

on permissions on iceAdministrator, refer to page 27. 

 

Adding an email group involves adding a new profile to the Email Groups folder in the tree view. 

To add an email group: 

1. Right-click on the Email Groups folder in the tree view. 

A menu appears. 

 

2. Select New Email Group from the menu. 
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The ‘Properties’ page for the new email group appears on the right side of the iceAdministrator 

window. 

 

 

3. In the ‘Email Group Name’ field, enter a name for the email group. 

This name can be up to 40 characters in length. The name of the email group appears on ice 

reports. 

4. In the ‘Unrouted Email Address’ field, enter the email address to which any unrouted email 

messages will be sent. 

The email address can be up to 250 characters in length. Email messages are directed to this 

address in the event the contact is closed without being routed to a user (e.g., the message is 

never queued or is removed from queue before it was presented to a user).  

The email group cannot be saved until the Terminus is selected, as described in the section that 

follows.  

Caution: The default setting for ‘Concurrent Threads’ is 3. This setting controls the performance 

of the processing of email messages. Do not change this setting unless instructed to do so by a 

trained technician. 
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Defining a Terminus 

You must specify an Email Terminus to save the Email Group. A Terminus is a starting point for 

emails in workflow. Any email that is sent to an email address that is part of the Email Group is 

directed to the terminus that you specify.  

If you are not already familiar with workflow, then you may wish to review the iceWorkflow 

Designer User Manual. To create a terminus, workflow must already be created, and you must be 

familiar with the following terms: 

• In general, workflow is used to create logical routing for contacts. Workflow is composed of 

graphs, pages, actions, and links, as described below. 

• A workflow graph is a holding place for one or more workflow pages that may or may not be 

linked together. For example, workflow can become so large that it requires the canvas of two 

workflow pages, and these pages are usually part of the same workflow graph.  

• A workflow page displays a graphical representation of the logical routing for contacts that has 

been designed for your contact center. 

• Actions are placed on the workflow page. Links are placed between the actions to create the 

logical routing for contacts. 

Note: To modify an email group, you must be in Edit Mode and have a user type that allows you 

to access the Email Groups folder that is part of iceAdministrator’s tree view. For more 

information on permissions on iceAdministrator, refer to page 27. 
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To define the terminus for an email group: 

1. Navigate to the email group for which you want to define the terminus. 

For this process, you need to work with the ‘Terminus’ area that is part of the ‘Properties’ page. 

 

2. Select the appropriate workflow graph from the ‘Graph’ drop-down list. 

The graph that you select should contain the workflow page to which you wish to direct email 

messages. 

3. Select the appropriate workflow page from the ‘Page’ drop-down list. 

Only the pages belonging to the graph you selected are listed. 

4. Select the appropriate action from the ‘Action’ drop-down list. 

Only the actions on the workflow page you selected are listed. Contacts that arrive on this email 

group are directed to the selected action. 

5. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

All email messages that are sent to an email address that is part of this email group will be 

directed to the terminus that you have selected. Click Go to Terminus if you wish to view the 

starting point in the workflow for the email messages. For more information on adding email 

addresses to the email group, refer to the next section.  
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Adding an Email Address 

Email addresses can be added to an email group to meet new requirements for the contact 

center.  

The following instructions describe how to add new email addresses. These instructions assume 

that the appropriate steps have been taken to add email addresses to the mail server and that 

messages sent to the new addresses are directed from the mail server to the ice server.  

Note: To modify an email group, you must be in Edit Mode and have a user type that allows you 

to access the Email Groups folder. For information on permission levels and user types, refer to 

page 27. 

 

To add email addresses to an email group: 

1. Navigate to the email group that requires additional addresses. 

2. Right-click on the email group. 

A menu appears. 

 

3. Select New Email Address from the menu. 

The ‘Properties’ page for the email address appears on the right side of the iceAdministrator 

window. 
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4. In the ‘Email Address’ field, enter the email address from which your contact center will receive 

email messages. 

This email address can be up to 80 characters in length.  

5. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

This section has explained how to add email addresses to an email group. The section that follows 

explains how to delete an email address. 
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Deleting an Email Address  

An email address that is no longer required can be deleted from iceAdministrator. The following 

instructions assume that the email address has already been removed from the mail server or is 

no longer directed to ice.  

Note: To modify an email group, you must be in Edit Mode and have a user type that allows you 

to access the Email Groups folder. For information on permission levels and user types, refer to 

page 27. 

 

To delete an email address that is no longer required: 

1. Right-click on the email address in the tree view. 

A menu appears. 

 

2. Select Delete from the menu that appears. 

3. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

This section has explained how to delete email addresses from an email group. The section that 

follows explains how to delete an email group. 
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Deleting an Email Group and its Email Addresses 

Email groups that are no longer required can be deleted from the iceAdministrator. Email 

addresses are also deleted when the email group they belong to is deleted.  

Note: To delete an email group, you must be in Edit Mode and have a user type that allows you 

to access the Email Groups folder. For more information on permissions on iceAdministrator, refer 

to page 27. 

 

To delete an email group that is no longer required: 

1. Right-click on the email group in the tree view. 

A menu appears. 

  

2. Select Delete from the menu that appears. 

A message box appears to notify you that deleting the email group also deletes all email 

addresses that are part of the group. 

  

3. Click Yes to proceed, or click No to cancel the deletion. 

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

This section has explained how to delete an email group. The section that follows explains how to 

delete all email groups. 
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Emptying the Email Groups Folder 

You may decide to delete all email groups to avoid conflict messages when importing email 

groups.  

Note: To delete an email group, you must be in Edit Mode and have a user type that allows you 

to access the Email Groups folder. For more information on permissions on iceAdministrator, refer 

to page 27.  

 

To delete all email groups: 

1. Right-click on the Email Groups folder. 

A menu appears. 

 

2. Select Empty from the menu. 

A pop-up message box appears. 

  

 

3. Click Yes to delete all of the email groups or click No to cancel the deletion. 

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

 



 

 

 

 

 

 

 

 

 

 

 

Chapter 7: UC Groups 

UC Groups control which workflow is used for incoming contacts. They enable ice to accept 

instant messages and inbound and outbound calls. ice routes them to workflow so that they can 

be treated in workflow and queued for the first available user.  

In iceAdministrator, UC addresses can be grouped together in a UC group. With the initial 

installation of ice, each UC address is configured on the system and assigned to an appropriate 

UC group. After the initial installation, UC addresses and UC groups can be created, deleted, and 

modified as your contact center’s requirements change.  

The sections that follow describe how to view and understand UC groups that have already been 

created, as well as how to add, modify, and delete UC groups. 

Caution: Many tasks involving UC addresses and UC groups may require the involvement of the 

person that oversees your Skype for Business Server. 

Note: 

• iceAdministrator should only be used by trained contact center staff. Before you begin 

modifying or creating UC groups, you must be familiar with your current configuration.  

• The UC account connection point must be provisioned in the Skype for Business server before 

you create a UC Group in iceAdministrator.  

• To view and edit UC groups, you must have a user type that allows you to access the UC 

Groups folder that is part of iceAdministrator’s tree view. This chapter assumes that you are 

familiar with the permissions on ice, as described in  
 

Chapter 1: Getting Started. 
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• Instant messaging on ice works in conjunction with Skype for Business Server. Skype for 

Business Server must be installed at your office and configured to communicate with ice 

before users can receive queued instant messages through ice.  
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Viewing a UC Group 

You may wish to view a UC Group if you are planning to change the way SIP calls and instant 

messages are handled.  

Viewing UC Groups involves finding and selecting a UC group in the tree view. When a UC Group 

is selected, the right side of iceAdministrator window displays two tabs that detail the group’s 

configuration.  

Note: To view a UC Group, you must have a Supervisor user type or higher. To edit a UC Group, 

you must have switch administrator user type or higher.  For information on permission levels and 

user types, refer to page 27. 

Changing some of these features may require a restart of the ice server.  

 

To navigate to a UC Group: 

1. Open the UC Groups folder in the tree view. 

The UC Groups that are currently configured are displayed. 

 

2. Open a UC Group to view the UC addresses that are currently assigned to the group. 

The assigned UC addresses are displayed. 
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3. Click on a UC Group to highlight it and view its configuration settings.  

The ‘Properties’ page for the UC group appears in the detail view. 
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The following table provides more information on each of the settings on the UC Group 

Properties page.  

UC Group Settings 

Setting Description 

UC Group 

Name 

Enter a name for the UC Group. This display name helps identify 

the purpose of the Group to users. This name can be up to 40 

characters in length. Information about this group is presented in 

ice reports, under the name of the group. 

UC Group ID The internal Group ID that is used to identify this group. 

Outbound 

Caller URI 

Specify the From URI that ice will place outbound SIP calls under 

certain calling scenarios.  

Note: Depending on the configured options, the outbound caller 

URI may be derived from other data (such as the inbound caller 

URI. 

Outbound 

Caller Name 

Specifies the display name portion of the From URI that ice will 

place in outbound SIP calls. 

Max Inbound 

AV 

Maximum number of simultaneous inbound calls allowed in this 

group.  

Note: Once the maximum is reached, subsequent calls will be 

rejected with the AV Reject Code specified in workflow. 

Max Inbound 

IM 

Maximum number of simultaneous inbound IM sessions allowed 

in this group.  

Note: Once the maximum is reached, subsequent instant 

messages will be rejected with the IM Reject Code specified in 

workflow. 

AV Terminus This defines the action to start on when an inbound AV call is 

received in ice. Typically this is a Wait For Incoming Call action. 

For more information on workflow actions, refer to the 

iceWorkflow Designer User Manual. 
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UC Group Settings 

Setting Description 

IM Terminus This is an optional setting: this defines the action to start on when 

an inbound IM session is received in ice. Typically this is a Wait 

For Instant Message action. For more information on workflow 

actions, refer to the iceWorkflow Designer User Manual. 

Note: If you do not want to allow IM handling, you can leave the 

checkbox unchecked. In this case, inbound IMs will be rejected 

with the IM Reject Code. 

 

This section has explained how to navigate to an existing UC Group. The sections that follow 

describe how to add and modify settings for a UC Group. 
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Adding a UC Group 

A UC Group can be added or modified to meet requirements for new UC addresses. 

Note: To add a UC group, you must be in Edit Mode and have a user type that allows you to 

access the UC Groups folder. For more information on permissions on iceAdministrator, refer to 

page 27. 

Adding a UC group involves adding a new profile to the IM Groups folder in the tree view.  

 

To add a UC group: 

1. Right-click on the UC Groups folder in the tree view. 

A menu appears. 

 

2. Select New UC Group from the menu. The ‘Properties’ page for the new UC group appears in 

the detail view. 
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3. Fill in the appropriate fields. For more information about each field, refer to the table that 

follows.  

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

 

Note: 

• Once a UC Group has been created, you must create a route to use the group for calls, 

otherwise they will fail. 

• The UC group cannot be saved until the fields in the AV Terminus section has been filled, as 

described in the section that follows.  

Defining a Terminus 

You must specify an AV Terminus to save the UC Group. You can also specify an IM 

Terminus, if you wish to route IMs through workflow. A Terminus is a starting point for 

audio calls and IMs in workflow. Any audio calls and IM that is sent to a UC address that is 

part of the UC group is directed to the terminus that you specify.  

If you are not already familiar with workflow, then you may wish to review the 

iceWorkflow Designer User Manual. To create a terminus, workflow must already be 

created, and you must be familiar with the following terms: 
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• In general, workflow is used to create logical routing for contacts. Workflow is composed 

of graphs, pages, actions, and links, as described below. 

• A workflow graph is a holding place for one or more workflow pages that may or may not 

be linked together. For example, workflow can become so large that it requires the canvas 

of two workflow pages, and these pages are usually part of the same workflow graph.  

• A workflow page holds the workflow that has been designed for your contact center. 

• Actions are placed on the workflow page. Links are placed between the actions to create 

the logical routing for contacts. 

Note: To modify a UC group, you must be in Edit Mode and have a user type that allows 

you to access the UC Groups folder that is part of iceAdministrator’s tree view. For more 

information on permissions on iceAdministrator, refer to page 27. 
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To define the AV terminus for a UC group: 

1. Navigate to the UC group for which you want to define the terminus. 

For this process, you need to work with the ‘AV Terminus’ area that is part of the 

‘Properties’ page. 

  

2. Select the appropriate workflow graph from the ‘Graph’ drop-down list. 

The graph that you select should contain the workflow page to which you wish to direct 

calls and emails. 

3. Select the appropriate workflow page from the ‘Page’ drop-down list. 

Only the pages belonging to the graph you selected are listed. 

4. Select the appropriate action from the ‘Action’ drop-down list. 

Only the actions on the workflow page you selected are listed. Contacts that arrive on this 

UC group are directed to the selected action. 

5. From the File menu, choose Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 

All audio calls that are sent to a UC address that is part of this UC group will be directed 

to the terminus that you have selected. Click Go to Terminus if you wish to view the 

starting point in the workflow for the audio message.  
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To define the IM terminus for a UC group: 

1. Navigate to the UC group for which you want to define the terminus. 

For this process, you need to work with the ‘IM Terminus’ area that is part of the 

‘Properties’ page. 

  

2. Enable IM Terminus to make the options available.  

3. Select the appropriate workflow graph from the ‘Graph’ drop-down list. 

The graph that you select should contain the workflow page to which you wish to direct 

instant messages. 

4. Select the appropriate workflow page from the ‘Page’ drop-down list. 

Only the pages belonging to the graph you selected are listed. 

5. Select the appropriate action from the ‘Action’ drop-down list. 

Only the actions on the workflow page you selected are listed. Contacts that arrive on this 

UC group are directed to the selected action. 

6. From the File menu, choose Save. (To cancel the save operation, click Cancel on the 

‘Progress’ dialog box.) 

All IMs that are sent to a UC address that is part of this UC group will be directed to the 

terminus that you have selected. Click Go to Terminus if you wish to view the starting 

point in the workflow for the IM. For more information on adding UC addresses to the UC 

group, refer to the next section. 
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Adding a UC Address 

UC addresses can be added to a UC group to meet new requirements for the contact center. UC 

Addresses are SIP URIs from which contacts will be routed to ice for handling.  They are 

associated with the Skype for Business account for the ice server.  

Example: sip:LiamGerbert@widgets.ca 

UC Addresses must be configured both in Skype for Business and in the iceAdministrator UC 

Group settings before they can be used. This should be completed by someone who knows how 

to provision a Skype for Business address.  

UC addresses. These instructions assume that the appropriate steps have been taken to add the 

UC address to the Skype for Business Server and that messages sent to the new address are 

directed from the Skype for Business Server to the ice server.  

Note:  

• To modify a UC group, you must be in Edit Mode and have a user type that allows you to access 

the UC Groups folder that is part of iceAdministrator’s tree view. For information on permission 

levels and user types, refer to page 27. 
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223 iceAdministrator User Manual 

To add UC addresses to a UC group: 

1. Navigate to the UC group that requires additional addresses. 

2. Right-click on the UC group. 

A menu appears. 

  

3. Select New UC Address from the menu. 

The ‘Properties’ page for the UC address appears in the detail view.  

 

4. In the ‘UC Address’ field, enter the UC address from which your contact center will receive calls 

and instant messages. 

Example of required format: sip:LiamGerbert@widgets.ca 

The UC address can be up to 256 characters in length.  

5. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

This section has explained how to add UC addresses to a UC group. The section that follows 

explains how to delete a UC address. 

mailto:sip:LiamGerbert@widgets.ca
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Deleting a UC Address  

A UC address that is no longer required can be deleted from iceAdministrator. The following 

instructions assume that the UC address has already been removed from the Skype for Business 

Server, or is no longer directed to ice. 

Note: To modify a UC group, you must be in Edit Mode and have a user type that allows you to 

access the UC Groups folder that is part of iceAdministrator’s tree view. For information on 

permission levels and user types, refer to page 27. 

 

To delete a UC address that is no longer required: 

1. Right-click on the UC address in the tree view. 

A menu appears. 

  

2. Select Delete from the menu that appears. 

3. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

 

This section has explained how to delete UC addresses from a UC group. The section that follows 

explains how to delete a UC group. 
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Deleting a UC Group and its UC Addresses 

UC groups that are no longer required can be deleted from iceAdministrator. IM addresses are 

also deleted when the IM group they belong to is deleted.  

Note: To delete a UC group, you must be in Edit Mode and have a user type that allows you to 

access the IM Groups folder that is part of iceAdministrator’s tree view. For more information on 

permissions on iceAdministrator, refer to page 27. 

 

To delete an IM group that is no longer required: 

1. Right-click on the IM group in the tree view. 

A menu appears. 

  

2. Select Delete from the menu that appears. 

A message box appears to notify you that deleting the IM group also deletes all IM addresses 

that are part of the group. 

 

3. Click Yes to proceed, or click No to cancel the deletion. 

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

 

This section has explained how to delete a UC group. The section that follows explains how to 

delete all UC groups. 
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Emptying the UC Groups Folder 

You may decide to delete all UC groups to avoid conflict messages when importing UC groups.  

Note: To delete a UC group, you must be in Edit Mode and have a user type that allows you to 

access the IM Groups folder that is part of iceAdministrator’s tree view. For more information on 

permissions on iceAdministrator, refer to page 27. 

 

To delete all UC groups: 

1. Right-click on the UC Groups folder. 

A menu appears. 

  

2. Select Empty from the menu. 

A pop-up message box appears. 

 

3. Click Yes to delete all of the UC groups and UC addresses or click No to cancel the deletion. 

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 



 

 

 

 

 

 

 

Appendix A: Exporting and Importing 

Data in iceAdministrator can be exported to a file (*.xml). You might use this feature to 

copy data from one system to another or to save items with incomplete properties. Once 

information has been exported, it can then be imported to another system, or to the 

same system. iceAdministrator supports the importing of .xml and .ima.  

In general, to export data, right-click on a folder and select Export (refer to the ‘Export 

Folder’ column in the table below). To import data, right-click on the folder and select 

Import (refer to the ‘Import Folder’ column in the table below).  

Importing and exporting 

Item(s) Description of Exported Data Export 

Folder 

Import 

Folder 

Users, Queues, 

Teams & Skills 

All details of the users, queues, 

teams & skills that are part of the 

folder. 

Note: Users, queues, teams and skills 

can also be exported individually, as 

described below.  

Users, 

Queues, 

Teams & 

Skills 

Users, 

Queues, 

Teams & 

Skills 

Users All details of the users, except for 

queue assignments. 

Users Users 

Queues  All details of the queues, except for 

user assignments.  

Queues Queues 

Teams All details of the teams, except for 

user assignments. 

Teams Teams 
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Importing and exporting 

Item(s) Description of Exported Data Export 

Folder 

Import 

Folder 

Skills All skills.  Skills Skills 

Email Groups All email groups, including the email 

addresses within each group.  

Email 

Groups 

Email 

Groups 

Workflow All details of the audio messages, 

holidays, variables, workflow graphs, 

and workflow pages. 

Workflow Workflow 

Audio 

Messages 

All audio messages.  Audio 

Messages 

Audio 

Messages 

Holidays All holidays. Holidays Holidays 

Building 

Blocks Folder 

All details of the building blocks 

folder, including the individual 

building blocks and associated audio 

messages, variables, and routines.  

Building 

Blocks 

Folder 

Building 

Blocks 

Folder 

Building Block All details of the individual building 

block, including audio messages, 

variables, and routines.  

Building 

Block 

Building 

Blocks 

Folder 

Routine All workflow that is part of the 

routine. 

Routine Building 

Block 

Variables All user-defined variables.  Variables Variables 

Workflow 

Graphs 

The workflow graph and all pages 

that are part of the workflow graph. 

All details of the audio messages, 

holidays, and variables that are used 

in the workflow graph.  

Workflow 

Graph 

Workflow 

Workflow 

Pages 

The workflow page and all details of 

the audio messages, holidays, and 

variables that are used on that 

workflow page. 

Workflow 

Page 

Workflow 

Graph 

Switches All details of each folder in the 

switch, and the properties for the 

switch (e.g., settings for statistics, 

etc.). 

Switch  Node or 

Contact 

Center* 
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Importing and exporting 

Item(s) Description of Exported Data Export 

Folder 

Import 

Folder 

Nodes All details for each switch within a 

node, and the properties for the 

node (e.g., node name and IP 

address of ice server). 

Node Site 

Sites All details for each node within a site, 

and the properties for the site (e.g., 

site name).  

Site Site or 

Contact 

Center 

Contact 

Center 

All details for each site that make up 

the contact center.  

Contact 

Center 

Contact 

Center 

 

Note: If importing a switch to the Contact Center, you must select Import Switch. If a site 

and node do not already exist (e.g., if you are working offline), iceAdministrator 

automatically creates these items. A site and node are required before the switch can be 

added. 

The following message appears to confirm the addition of the site and node. 
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Exporting  

iceAdministrator: 

1. Right-click on the folder in the tree view that contains the data you wish to export.  

A menu appears, like the one below when you right-click on the Queues folder. 

 

2. Select Export from the menu. 

The ‘Save As’ dialog box appears. 

 

3. Select a directory where the exported data will be saved.  
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4. Type the name for the exported data in the ‘File name’ field.  

The default name corresponds with the exported data. For example, if exporting queues, the 

default name is Queues.ima. If you change the name, it is recommended to use a name that 

allows you to easily recognize what the ima file contains.   

5. Click Save. 

The data that you have selected is exported and saved to the chosen directory. 
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Importing 

To make importing easier, it is recommended that you save your changes before you import the 

data. If you have changes with incomplete properties when you attempt to import data, you are 

prompted to complete the properties before you continue. 

You can import .xml files and .ima.  

Caution: ice should not be receiving calls when you are importing workflow. 

Note: To import to a new switch, you must first create the new switch in the DB tool, apply the 

license, and then port the file into the switch in iceAdministrator.   

 

To import data: 

1. Right-click on the folder where you wish to import data. 

A menu appears, like the one below when you right-click on the Queues folder. 

 

2. Select Import from the menu. 

If you have any windows open in the detail view of iceAdministrator, a message box appears. 
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3. Click Yes to close all windows in the detail view. Click No if you do not want to continue 

importing. 

The ‘Open’ dialog box appears. 

 

4. Select the iceAdministrator file (*.ima) that you have previously exported, and click Open.  

Ensure that the file you are importing contains the correct data for the folder selected.  

Refer to the section that follows for an explanation of the messages that may appear while 

importing. For example, if any items that you are importing have the same ID as an existing 

item, an ‘Import Conflict Resolution’ dialog box appears.  

 

5. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 
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Common Error Messages  

Duplicate Name 

Within their respective folders, the skills, audio messages, and variables cannot have the 

same name. For example, if you import a skill that has the same name as an existing skill, 

you are prompted with an ‘Import Conflict Resolution’ dialog box. 

 
 

You can choose to add a new skill, overwrite the existing skill with the same name, or 

discard the imported skill and use the existing skill. If you check the ‘Apply selected action 

to all items of this type’ checkbox, the option you choose is applied to all imported skills 

that are in conflict with existing skills. If you do not check this checkbox, the option you 

choose is only applied to the particular skill mentioned in the dialog box. You will have to 

repeat the conflict resolution process for every imported skill that has the same name as 

an existing skill. 

If you click Add New, the ‘New Skill’ dialog box appears. Enter a unique name for the skill 

in this dialog box and click OK. 
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Duplicate ID 

If any items that you are importing have the same ID as an existing item, an ‘Import 

Conflict Resolution’ dialog box appears.  

• Select Add New to import the item and assign a unique ID (iceAdministrator uses the 

next available ID number).  

• Select Overwrite Existing to copy the imported item over the existing item.  

• Select Use Existing to discard the imported item (the existing item is unchanged).  

If you check the ‘Apply selected action to all items of this type’ checkbox, the option you 

choose is applied to all imported items that are in conflict with existing items. If you do 

not check this checkbox, the option you choose is only applied to the particular item 

mentioned in the dialog box. You will have to repeat the conflict resolution process for 

every imported item that has the same ID as an existing item. 

 

 

If you click Add New, the ‘New ID’ dialog box appears. Select a unique ID for the new user 

and select the option if you want iceAdministrator to use the next available ID for other 

users. Click OK after you have made the required changes. 
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Exceeding Permissions 

If you attempt to import an item that exceeds the permissions for your user type, the 

‘Import Error’ dialog box appears. Click OK on this dialog box to continue importing. The 

item that you have been warned about is not imported. For more information on 

permissions on ice, refer to page 27. 

 

Invalid Workflow Reference 

When importing email groups or workflow, the ‘Import Error’ dialog box appears if you 

attempt to import an item containing a reference to workflow that does not exist. Click 

OK on this dialog box to continue importing. You will need to complete the properties of 

the items with the invalid references before you can save your changes.  
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Validate Reference 

The ‘Validate Reference’ dialog box appears when you import contact groups (i.e., UC 

groups). This dialog box asks you to verify a reference to another item in 

iceAdministrator: for contact groups, the message asks you if the terminus contains a 

reference to existing workflow.  

When prompted with this message, click Yes to validate the reference. Click Yes to All to 

validate all references. Click No to remove the reference. Click No to All to remove all 

references to other items in iceAdministrator. If you have selected No or No to All, you 

will need to complete the properties of the item(s) before your changes can be saved. 

  

Broken Links 

When importing a workflow graph or page, some links between pages may be broken. 

The ‘Import Error’ dialog box notifies you of broken links. Click OK to continue importing. 

When importing is completed, you will need to manually repair the broken links before 

your changes can be saved. 
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Exporting and Importing Workflow 

When importing a workflow page, iceAdministrator automatically completes actions when the ID 

in the action matches the appropriate component in iceAdministrator. In the case of queues, if no 

queue in iceAdministrator with an ID matching the one in the action exists, it will be created as 

part of the import process. For other components, if no component in iceAdministrator with the 

same ID exists, the action will not be complete until that component is manually created in 

iceAdministrator. For example:  

• If the Queue Object action has been used to register a contact in queue 6001, this action will 

be completed automatically. If queue 6001 does not already exist, it will be created in the 

Queues folder as part of the import process. 

• If the Assign Skill to Object action has been used to assign a skill (e.g., with skill ID 2) to a 

contact, this action will be completed automatically, provided that the skill ID (e.g., skill ID 2) 

is found in the Skills folder. If the skill does not exist, the action will be incomplete. 

• If the Play Audio Message action plays message 90011.wma. This action will be completed 

automatically, provided that message 90011.wma is added to the Audio Messages folder. If 

the message does not exist, the action will be incomplete.  

The automatic completion of actions requires special attention when you import workflow that 

was created on a different switch. In this scenario, it is important that the Queue Object actions, 

Skills actions, Play Audio Message actions, etc. are double-checked to ensure they are using the 

appropriate queues, skills, and audio messages.  
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Import Settings 

Import settings allow you to:  

• Configure iceAdministrator’s actions when an item being imported has the same ID as an 

existing item in iceAdministrator.  

• Configure a prompt for a new switch number when importing switches.  

Import Actions 

By default, all items are set to ‘Prompt Me’, allowing you to decide which action to take 

while importing the data. 

You can change the default setting of ‘Prompt Me’ to one of the following:  

• Add New Item – if an item with the same ID is found, the imported item is created 

with a different ID number (i.e., the first available ID number).  

• Overwrite Existing – if an item with the same ID is found, the imported item 

overwrites the existing item.  

• Use Existing – if an item with the same ID is found, the item is not imported. The 

existing item is unchanged.  

You can choose one of these options for each item that can be imported. The option to 

Add New Item is not available for Configuration Value and Email Address.  
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To change import settings: 

1. Select Import from the Settings menu. 

 

 

The ‘Import Conflict Resolution Settings’ dialog box appears. 
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2. To change the default action for an item, double-click directly in the action field for 

that item. 

A drop-down list appears with a list of options. 

 

 

3. Select the option that you want to use for the item, as described on page 239. 

4. Click OK to save your changes and close the dialog box. Click Cancel to close the 

dialog box without saving your changes.  

The new settings will be used the next time you import data into iceAdministrator.  
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Prompt for New Switch 

Click the ‘Prompt for Switch number when importing’ checkbox at the bottom of the 

‘Import Contact Resolution’ dialog box if you wish to prompted to identify the destination 

switch number (e.g., 1 for switch 11001) each time you import a switch. If this checkbox is 

not checked, you will still be prompted if there are conflicts with an existing switch ID 

(provided ‘Prompt Me’ is selected as the import setting for switches).  



 

 

 

 

 

 

 

Appendix B: Switches, Nodes, & Sites 

Caution: This is an advanced topic and should not be attempted without first 

contacting Computer Talk.  

Switches, nodes, and sites represent the hierarchy of an ice system in 

iceAdministrator:  

• A switch contains all configuration required for a single contact center. In 

iceAdministrator, a switch can be expanded in the tree view to show the 

following folders: Users, Queues, Teams & Skills, Email Groups, UC Groups, 

and Workflow. Each folder represents a component of your contact center.  

• A node is comprised of one switch or multiple switches. An ice server is 

essentially a node.  

• A site is comprised of one node or multiple nodes. Multiple ice servers linked 

together form a site.  

Note: To view and edit switches, nodes, and sites, you must have a user type that 

allows you to access these folders in iceAdministrator’s tree view. This appendix 

assumes that you are familiar with the permissions on ice allowed to user types, 

as described in  

 

Chapter 1: Getting Started. 
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Adding a Switch 

Many ice systems have a single switch, node, and site at the time of installation. When the needs 

of your contact center change, there may be a requirement to add a new switch.  

Consider the following example. An ice system can be “shared” between two contact centers. For 

example, two departments in the same company might use the same ice system for their 

respective contact centers. In this scenario, each department could be configured with its own 

switch, which can also be thought of as a partition of the ice system.  

Caution: This is an advanced topic and should not be attempted without first contacting 

Computer Talk.  

Note: 

• To add a switch, you must be in Edit Mode and have a user type that allows you to access the 

Switch folder that is part of iceAdministrator’s tree view. For more information on permissions 

on iceAdministrator, refer to page 27. 

• Adding a switch requires that the ice server be restarted.  

 

To create a new switch: 

1. Right-click on the Node folder in the tree view. 

A menu appears. 

 

2. Select New Switch from the menu. 

A message box displaying the following message appears: 

 “ice Server must be restarted in order to use a newly created switch. Do you want to 

continue?” 
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3. Click Yes to continue. Click No if you do not want to add a new switch. 

Note: The message in Step 2 is a reminder only. Clicking Yes does not start the ice server 

restart. You will still have to do restart ice in order to use the newly created switch. 

Five tabs appear in the detail view: ‘Properties’, ‘Routing’ ‘Statistics’, ‘Statistics (cont’d)’, and 

‘License.’ By default, the ‘Properties’ page is displayed. 

 

4. Specify a name for the switch in the ‘Switch Name’ field. 

The name can be up to 40 characters in length. 

A switch name can be changed at any time. Before you can save the switch, you must enter a 

valid license code, as described on page 261. 
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Routing 

Caution: This is an advanced topic and should not be attempted without first contacting 

Computer Talk.  

The ‘Routing’ page provides access to the configurable parameters for routing at the switch level. 

Perl Compatible Regular Expressions (PCRE) is used to define routing rules for outbound calls.  

These settings are not frequently modified. Changes to the Routing settings can only be 

performed by a node administrator, site administrator and global administrator.  Changes should 

be made only by individuals familiar with the Regular Expression syntax.  The PCRE library is a set 

of functions that implement regular expression pattern matching using the same syntax and 

semantics as Perl 5. PCRE has its own native API, as well as a set of wrapper functions that 

correspond to the POSIX regular expression API. More Information on PCRE is readily available on 

the Internet.   

Changes to these settings must then be saved and the ice server would need to be restarted. 

Multiple routing rules can be configured on a switch.   
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Examples of routing rules:  

• All calls placed to area code 905 will be assigned a particular contact group. 

• All calls placed to 705 and 514 area codes will be prefixed with a 1. 

The default Routing page is shown below.  
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The table that follows describes the settings found on the routing page: 

Routing 

Field Description 

Routing 

Rule Name 

A name for the routing rule, corresponding to its functionality. 

Regular 

Expression 

Contains your PCRE syntax. 

Output 

String 

The end result of this routing rule if a match is found.   

 

Contact 

Group 

The contact group that corresponds to this routing rule. 

Route Flags Indicates whether this routing rule should be sent to a PBX. 

Description A description of this routing rule. 
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To add a new routing rule: 

1. Click Add on the Routing page. 

2. Fill out the fields as described in the Routing table. 

There are examples of PCRE code in the bottom portion of the window.  

 

 

3. Click OK to add the routing rule to the table. Click Cancel to discard the routing rule. 

4. Save your changes. 
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To edit a routing rule: 

1. Highlight the rule you wish to edit by single-clicking on it. 

2. Click Edit. 

3. Edit the fields as described in the Routing table. 

4. Click OK to add the routing rule to the table. Click Cancel to discard the edits. 

5. Save your changes. 

 

To remove a routing rule: 

1. Highlight the rule you wish to remove by single-clicking on it. 

2. Click Remove. 

3. Save your changes. 

 

The order of conditions within the Routing table is important because a search for a matching 

condition is performed from the top down, and the first matching condition is used to route the 

contact. 

 

To change the order of the rules in the table: 

1. Highlight the rule you wish to promote/demote.   

2. Click Move Up to promote it or Move Down to demote it.  Click the button as many times as 

required to move the condition to the desired position in the table. 

3. Save your changes. 
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The Routing page provides a testing capability for your routing rules. 

 

To test a routing rule: 

1. Key in the input you wish to test.  For example, 81792347211. 

2. If you wish to test this input against a particular routing rule, highlight the row containing the 

rule and click Apply to Selected. To test this input against all rules, click Apply to All. 

 

 

 

The result field will populate with the result based on the output string.  In the example 

above, the phone number 81792347211 will become sip: 1792347211@gateway.com. The test 
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verified that the regular expression was formatted correctly since the 8 was removed from the 

beginning of the number and sip: and @gateway.com were added to it. 
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Outbound Workflow 

Instead of directly routing a call to a number that a user dials, the call can first be passed to an 

outbound workflow for inspection and treatment. Before you can enable outbound workflow for a 

user, the outbound workflow must already be created with an Assign DN action. Workflow has 

access to the number the user dialed through the variable $System:DialedNumber. For more 

information on variables and workflow, refer to iceWorkflow Designer User Manual.  

Consider the following examples of outbound workflow: 

• Call blocking: If the user attempts to dial a number that is restricted by workflow, the user 

hears a message indicating the number cannot be dialed.  

• Least cost routing: Workflow determines the carrier with lowest rates for the number dialed. 

The call is placed using a UC Group associated with the lowest cost carrier.  

• Long distance PIN’s: If workflow determines that a dialed number is a long distance call, the 

user is prompted to enter a PIN before the call can be completed.  

• Dialed number manipulation: For example, a user on SIP-based systems can place a call by 

dialing a telephone number. Outbound workflow can manipulate the number dialed so that it 

is in the appropriate format in order to be sent out to the SIP port. If the user dials 

4162411234, the outbound workflow can generate the following dial string before the call is 

sent out on the sip port – for example, sip:4162411234@sipgateway.com.  

 

For the switch, you can choose one of four modes of outbound workflow: 

• Disabled: The default setting. There is no treatment of the user’s outbound calls using 

outbound workflow.  

• All Calls Except Calls to Users: This includes external calls and calls to workflow DN’s (Dial 

Number). There is no treatment of the calls from the user to other users.  

• All Calls Placed: This includes external calls, calls to workflow DN’s, and calls to other users 

on ice.  

• External Calls Only: Includes external calls only.  

Outbound workflow can be enabled for the switch, as described in the following instructions, or it 

can be enabled on a user-by-user basis. For more information on enabling outbound workflow 

for a user, refer to page 95.  

Caution: This is an advanced topic and should not be attempted without first contacting 

Computer Talk.  

Note: To modify a switch, you must be in Edit Mode and have a user type that allows you to 

access the Switch folder that is part of iceAdministrator’s tree view. For information on permission 

levels and user types, refer to page 27. 

mailto:sip:4162411234@sipgateway.com
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To enable outbound workflow for a switch: 

1. Navigate to the switch that you wish to customize or modify.  

The ‘Properties’ page for the selected switch appears on the right side of the iceAdministrator 

window. This process calls for the outbound workflow part of the page. 

 

2. From the ‘Mode’ drop-down list choose one of the four modes: Disabled, All Calls Except Calls 

to Users, All Calls Placed, and External Calls Only. 

If you have chosen any mode except Disabled, you must choose the DN that points to the 

outbound workflow from the ‘DN’ drop-down list. 

You can click Go To Target to view the outbound workflow.  

3. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 
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Statistics 

Caution: This is an advanced topic and should not be attempted without first contacting 

Computer Talk.  

The ‘Statistics’ pages provide access to the configurable parameters for statistics generated by a 

switch. These settings are not frequently modified. Changes to the Statistic settings can only be 

performed by a Node Administrator, Site Administrator or Global Administrator. Changes to these 

settings must then be saved and the ice server would need to be restarted.  
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The table below describes the fields found on the ‘Statistics’ page. 

Statistics 

Field Description 

ADR Enabled Indicates if User Agent Detail Record (ADR) is enabled. For 

more information on ADR, refer to the iceReporting User 

Manual.  

CDR Enabled Indicates if Contact Detail Record (CDR) is enabled. For more 

information on CDR, refer to the iceReporting User Manual.  

Maximum 

Age 

Determines the number of days, weeks, months, or years 

that statistics are saved in the database. Statistics older than 

the selected number of days, weeks, months, or years are 

purged from the database.  
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Statistics (Cont’d) 

Caution: This is an advanced topic and should not be attempted without first contacting 

Computer Talk.  

The Statistics (Cont’d) page contains advanced configurable statistics parameters. These settings 

are not editable by default, but if you enable ‘Make statistics parameters editable’, you will be 

able to change the values in the fields. 

  

 

The following message appears when you enable ‘Make statistics parameters editable.’ 
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The table below describes the fields found in the ‘Statistics (Cont’d)’ page. 

Statistics (continued) 

Field Description 

First Day of 

the Week 

Determines the start of the week. By default, this is set to 

Sunday. If this setting is changed, the accuracy of previous 

statistics cannot be guaranteed. Statistics will be accurate 

from the date modified.  

First Month of 

the Year 

Determines the start of the year. By default, this is set to 

January. If this setting is changed, the accuracy of previous 

statistics cannot be guaranteed. Statistics will be accurate 

from the date modified.  

Daily Reset 

Time 

Determines when statistics are refreshed in the iceMonitor 

and in the ‘Queue Statistics’ window in iceBar. By default, 

these statistics refresh every day at 12: 00:00 AM. For more 

information on the iceMonitor, refer to the iceMonitor User 

Manual. For more information on iceBar, refer to the iceBar 

User Manual. 

Interval 

Length 

Determines how often interval statistics are written to the 

database. By default, interval statistics are written to the 

database every 15 minutes. Changes to this setting require 

that ice is restarted. 

DB Buffer 

Capacity 

Determines how many records are buffered in the event that 

ice loses connectivity to the database. By default, up to 

100,000 records are buffered. Changes to this setting require 

a restart of ice. 

DB Writer 

Threads 

Allows concurrent database writes. The recommended 

setting is 3. This setting should not be changed unless you 

are instructed to do so by Computer Talk Technology, Inc. 

Changes to this setting require a restart of ice.  
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Statistics (continued) 

Field Description 

Queue Time 

Boundary 1 

through to 5. 

Boundaries are used in several reports. For example, a report 

can show how quickly contacts were handled based on the 

boundaries. By default the boundaries are set to 5, 10, 30, 

60, and 120 seconds. Changes to these settings require a 

restart of ice.  

In the report sample below, the default boundaries affect the 

report by showing the number of contacts handled in 0-4 

seconds, 5-9 seconds, 10-29 seconds, 30-59 seconds, 60-119 

seconds, and >=120 seconds.  
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License 

The license page is an overview of the licenses you have available for your ice Contact Center. 

Note: Contact Computer Talk to change your licenses. 
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Deleting a Switch 

Caution: This is an advanced topic and should not be attempted without first contacting 

Computer Talk. 

When a switch is no longer used, you may wish to delete it from ice. 

Note: To delete a switch, you must be in Edit Mode and have a user type that allows you to 

access the switch folder that is part of iceAdministrator’s tree view. For more information on 

permissions on iceAdministrator, refer to page 27. 

 

To delete a switch: 

1. In the tree view, right-click the switch that you wish to delete. 

A menu appears. 

 

2. Select Delete from the menu. 

Note: If you are logged in as a user belonging to the switch you are trying to delete, a 

message box displaying the following message appears: 

“Cannot delete a switch containing current iceAdministrator user <user name>.”  

3. Click OK to close this message box. 

Otherwise, if you have permission to delete the switch, a message box appears. 

 

4. Click Yes to confirm the deletion or click No to cancel.  
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5. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 
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Emptying a Switch 

Caution: This is an advanced topic and should not be attempted without first contacting 

Computer Talk.  

You may decide to delete all items in a switch to avoid conflict messages when importing a 

switch.  

 

To delete all items in the switch: 

1. Right-click on the Switch folder. 

A menu appears. 

  

2. Choose Empty. 

A warning appears. 

 

3. Click Yes to delete the entire configuration for the switch, or click No to cancel the deletion. 

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 



 

 

 

  
  

265 iceAdministrator User Manual 

Adding a Node 

Caution: This is an advanced topic and should not be attempted without first contacting 

Computer Talk. 

iceAdministrator. The instructions that follow assume that the appropriate hardware has been 

installed to support the new node. The instructions that follow assume that the appropriate 

hardware has been installed to support the new node. 

Note: To add a node, you must be in Edit Mode and have a user type that allows you to access 

the Node folder. For information on permission levels and user types, refer to page 27. 

 

To create a new node: 

1. Right-click the Site folder in the tree view. 

A menu appears. 

  

2. Select New Node from the menu. 

A ‘Properties’ page appears in the detail view. 
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3. Specify a name for the node in the ‘Node Name’ field. 

The name can be up to 40 characters in length.  

4. Click Change ice Server. 

The ‘Change ice Server’ dialog box appears. 

 
 

5. In the ‘Machine Name’ field, enter the name of the ice server  

If the server name cannot be recognized, select the ‘IP Address’ radio button, and enter the IP 

address for the ice server into the ‘IP Address’ field.  

6. Click OK to accept changes and close the dialog box, or click Cancel to cancel the changes 

and close the dialog box. 

7. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 
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Deleting a Node 

Caution:  

• This is an advanced topic and should not be attempted without first contacting Computer 

Talk.  

• When deleting a node, all switches that are part of the node are also deleted.  

When a node is no longer used, you may wish to delete it from ice by following the steps below.  

Note: To delete a node, you must be in Edit Mode and have a user type that allows you to access 

the Node folder. For more information on permissions on iceAdministrator, refer to page 27. 

 

To delete a node: 

1. In the tree view, right-click on the node that you wish to delete. 

A menu appears. 

 

2. Select Delete from the menu. 

Note: If you are logged in as a user belonging to the node you are trying to delete, a 

message box displaying the following message appears: 

 “Cannot delete a node containing current iceAdministrator user <user name>.”  

Click OK to close this message box. 

Otherwise, if you have permission to delete the node, a pop-up message box appears. 
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3. Click Yes to confirm the deletion, or click No to cancel. 

4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 
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Adding a Site 

Caution: This is an advanced topic and should not be attempted without first contacting 

Computer Talk. 

A site is comprised of one node or multiple nodes. Multiple ice servers linked together form a site. 

When an additional site is required, it can be added to iceAdministrator. The instructions that 

follow assume that the appropriate hardware has been installed to support the new site.  

Note: To add a site, you must be in Edit Mode and have a user type that allows you to access the 

Site folder. For information on permission levels and user types, refer to page 27. 

 

To create a new site: 

1. Right-click on the Contact Center folder in the tree view. 

A menu appears. 

 

2. Select New Site from the menu. 

The ‘Properties’ page appears in the detail view. 

 

3. Specify a name for the site in the ‘Site Name’ field. 

The name can be up to 40 characters in length. 
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4. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 
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Deleting a Site 

Caution:  

• This is an advanced topic and should not be attempted without first contacting Computer 

Talk.  

•  When deleting a site, all nodes that are part of the site are also deleted.  

When a site is no longer used, you may wish to delete it from ice by following the steps below.  

Note: To delete a site, you must be in Edit Mode and have a user type that allows you to access 

the Site folder. For more information on permissions on iceAdministrator, refer to page 27. 

 

To delete a site: 

1. In the tree view, right-click the site that you wish to delete. 

A menu appears. 

 

2. Select Delete from the menu. 

Note: If you are logged in as a user belonging to the site you are trying to delete, a message 

box displaying the following message appears:  

“Cannot delete a site containing current iceAdministrator user <user name>.” 

3. Click OK to close this message box. 

Otherwise, if you have permission to delete the node, a pop-up message box appears. 
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4. Click Yes to confirm the deletion, or click No to cancel. 

5. From the File menu, choose Save. (To cancel the save operation, click Cancel on the ‘Progress’ 

dialog box.) 

 

 

 

 

 



 

 

 

 

 

 

 

Appendix C: Acknowledgement 

The following are copyright and license notices for the third-party software 

components used in the creation of the ice SIP solution for VoIP call handling.   



 

 

ares 

/* Copyright 1998 by the Massachusetts Institute of Technology.  

 * 

 *Permission to use, copy, modify, and distribute this  

 *software and its documentation for any purpose and without 

 *fee is hereby granted, provided that the above copyright  

 *notice and this permission notice appear in supporting 

 *documentation, and that the name of M.I.T not be used in 

 *advertising or publicity pertaining to distribution of the 

 *software without specific, written prior permission. 

 *M.I.T makes no representations about the suitability of 

 *this software for any purpose.  It is provided “as is”  

 *without express or implied warranty.  

 */ 

 



 

  
  

OpenSSL 

OpenSSL License 

------------------------- 

 

/* =-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 

 *Copyright © 1998-2004  The OpenSSL Project.  All rights reserved.  

 * 

 * Redistribution and use in source and binary forms, with or without 

 * modification, are permitted provided that the following conditions 

 * are met:  

 * 

 * 1. Redistributions of source code must retain the above copyright 

 *     notice this list of conditions and the following disclaimer.  

 * 

 * 2. Redistributions in binary form must reproduce the above copyright 

 *     notice, this list of conditions and the following disclaimer in 

 *     the documentation and/or other materials provided with the 

 *     distribution.  

 * 3. All advertising materials mentioning features or use of this 

 *     software must display the following acknowledgment:  

 *     “This product includes software developed by the OpenSSL Project 

 *     for use in the OpenSSL Toolkit.  (http://www.openssl.org/)” 

 *  

 * 4. The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to  

 *     endorse or promote products derived from this software without 

 *     prior written permission. For written permission, please contact 

 *     openssl-core@openssl.org.  

 *  

 * 5. Products derived from this software may not be called “OpenSSL” 

 *     nor may “OpenSSL” appear in their names without prior written 

 *     permission of the OpenSSL Project.  

 *  

 * 6. Redistributions of any form whatsoever must retain the following 

 * acknowledgment:  

 *     “This product includes software developed by the OpenSSL Project  

 *     for use in the OpenSSL Toolkit. (http://www.openssl.org/)” 

 * 

 * THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” AND ANY  

 * EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 

 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 

 * PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR 

 * ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,  

 * SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 

 * NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;  

 * LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)  

 * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,  

 * STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)  

 * ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED 

 * OF THE POSSIBILITY OF SUCH DAMAGE.  

 *  =-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 

 *  

 * This product includes cryptographic software written by Eric Young 

 * (eay@cryptsoft.com).  This product includes software written by Tim 

 * Hudson  (tjh@cryptsoft.com).  

 */ 

  

http://www.openssl.org/
mailto:openssl-core@openssl.org
http://www.openssl.org/
mailto:eay@cryptsoft.com
mailto:tjh@cryptsoft.com


 

 

Original SSLeay Licence 

--------------------------------- 

 

/* Copyright © 1995-1998 Eric Young (eay@cryptsoft.com)  

 *All rights reserved.  

 * 

 *This package is an SSL implementation written 

 * by Eric Young (eay@cryptsoft.com).  

 * The implementation was written so as to conform with Netscapes SSL.  

 * 

 * This library is free for commercial and non-commercial use as long as 

 * the following conditions are adhered to.  The following conditions 

 * apply to all code found in this distribution, be it the RC4, RSA, 

 * lhash, DES, etc., not just the SSL code. The SSL documentation 

 * included with this distribution is covered by the same copyright terms 

 * except that the holder is Tim Hudson (tjh@cryptsoft.com).  

 * 

 * Copyright remains Eric Young’s, and as such any Copyright notices in 

 * the code is not to be removed. 

 * If this package is used in a product, Eric Young should be given attribution 

 * as the author of the parts of the library used.  

 * This can be in the form of a textual message at program startup or 

 * in documentation (online or textual) provided with the package.   

 * 

 * Redistribution and use in source and binary forms, with or without  

 * modification, are permitted provided that the following conditions 

 * are met:  

 * 1. Redistributions of source code must retain the copyright 

 *     notice this list of conditions and the following disclaimer. 

 * 2. Redistributions in binary form must reproduce the above copyright 

 *     notice, this list of conditions and the following disclaimer in the  

 *     documentation and/or other materials provided with the distribution.  

 * 3. All advertising materials mentioning features or use of this software 

 *     must display the following acknowledgment: 

 *     “This product includes cryptographic software written by  

 *       Eric Young  (eay@cryptsoft.com)”   

 *     The word cryptographic can be left out if the routines from the library 

 *     being used are not cryptographic related :-). 

 * 4. If you include any Windows specific code (or a derivative thereof) from 

 *     the apps directory (application code) you must include an acknowledgment:  

 *     “This product includes software written by Tim Hudson  (tjh@cryptsoft.com)”  

 * 

 * THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS” AND 

 * ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 

 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 

 * PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE  

 * LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR  

 * CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 

 * SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS  

 * INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 

 * CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 

 * ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 

 * POSSIBILITY OF SUCH DAMAGE).  

 *  

 * The license and distribution terms for any publically available version or  

 * derivative of this code cannot be changed.  i.e., this code cannot simply be 

 * copied and put under another distribution license 

 * (including the GNU Public Licence.)  

mailto:eay@cryptsoft.com
mailto:eay@cryptsoft.com
mailto:tjh@cryptsoft.com
mailto:eay@cryptsoft.com
mailto:tjh@cryptsoft.com
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PCRE 

PCRE License 

------------------------- 

PCRE is a library of functions to support regular expressions whose syntax 

and semantics are as close as possible to those of the Perl 5 language.  

 

Release 6 of PCRE is distributed under the terms of the “BSD” license, as 

specified below. The documentation for PCRE, supplied in the “doc” 

directory is distributed under the same terms as the software itself.  

 

The basic library functions are written in C and are freestanding. Also 

included in the distribution is a set of C++ wrapper functions.  

 

 

THE BASIC LIBRARY FUNCTIONS 

----------------------------------------------- 

 

Written by:  Philip Hazel 

Email local part: ph10 

Email domain:  cam.ac.uk 

 

University of Cambridge Computing Service,  

Cambridge, England.  Phone: +44 1223 334714.  

 

Copyright © 1997-2005 University of Cambridge.  

All rights reserved.  

 

 

THE C++ WRAPPER FUNCTIONS 

---------------------------------------------- 

 

Contributed by:  Google Inc.  

 

Copyright © 2005, Google Inc.  

All rights reserved.  

 

 



 

  
  

THE “BSD” LICENCE 

---------------------------- 

 

Redistribution and use in source and binary forms, with or without  

modification, are permitted provided that the following conditions are met:  

 

*  Redistributions of source code must retain the above copyright notice,  

    this list of conditions and the following disclaimer.  

 

*  Redistributions in binary form must reproduce the above copyright  

   notice, this list of conditions and the following disclaimer in the 

   documentation and/or other materials provided with the distribution.  

 

*  Neither the name of the University of Cambridge nor the name of Google 

   Inc. nor the names of their contributors may be used to endorse or 

   promote products derived from this software without specific prior 

   written permission.  

 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESSED OR IMPLIED 

WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 

PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR 

ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 

TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 

NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGE.  

 



 

 

popt 

Copyright © 1998   Red Hat Software 

 

Permission is hereby granted, free of charge, to any person obtaining a copy 

of this software and associated documentation files (the “Software”), to deal 

in the Software without restriction, including without limitation the rights 

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell 

copies of the Software, and to permit persons to whom the Software is 

furnished to do so, subject to the following conditions:  

 

The above copyright notice and this permission notice shall be included in 

all copies or substantial portions of the Software.  

 

THIS SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT 

LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN 

NO EVENT SHALL THE X CONSORTIUM BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION 

OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR 

OTHER DEALINGS IN THE SOFTWARE.  

 

Except as contained in this notice, the name of the X Consortium shall not be 

used in advertising or otherwise to promote the sale, use or other dealings 

in this Software without prior written authorization from the X Consortium.  

 

 



 

  
  

ReSIProcate/Repro 

/*=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 

 *  The Vovida Software License, Version 1.0 

 * 

 *  Copyright © 2000  Vovida Networks, Inc.  All rights reserved.  

 * 

 *  Redistribution and use in source and binary forms, with or without 

 *  modification, are permitted provided that the following conditions 

 *  are met:  

 *  

 *  1.  Redistributions of source code must retain the above copyright 

 *       notice this list of conditions and the following disclaimer.  

 * 

 *  2.  Redistributions in binary form must reproduce the above copyright 

 *       notice, this list of conditions and the following disclaimer in 

 *       the documentation and/or other materials provided with the 

 *       distribution.  

 * 

 *  3.  The names “VOCAL”, “Vovida Open Communication Application Library”,  

 *       and “Vovida Open Communication Application Library (VOCAL)” must 

 *       not be used to endorse or promote products derived from this 

 *       software without prior written permission.  For written 

 *       permission, please contact vocal@vovida.org.  

 *  

 *  4.  Products derived from this software may not be called “VOCAL”, nor 

 *       may “VOCAL” appear in their name, without prior written 

 *       permission of Vovida Networks, Inc.  

 *  

 *  THIS SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESSED OR IMPLIED 

 *  WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 

 *  OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND 

 *  NON-INFRINGEMENT ARE DISCLAIMED.  IN NO EVENT SHALL VOVIDA 

 *  NETWORKS,  INC. OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT DAMAGES 

 *  IN EXCESS OF $1,000,  NOR ANY INDIRECT, INCIDENTAL, SPECIAL, 

 *  EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,  

 *  PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;  LOSS OF USE, DATA, OR  

 *  PROFITS;  OR BUSINESS INTERRUPTION)  HOWEVER CAUSED AND ON ANY THEORY 

 *  OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 

 *  (INCLUDING NEGLIGENCE OR OTHERWISE)  ARISING IN ANY WAY OUT OF THE 

 *  USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 

 *  DAMAGE.  

 *  

 *  =-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 

 *   

 *  This software consists of voluntary contributions made by Vovida 

 *  Networks, Inc. and many individuals on behalf of Vovida Networks,  

 *  Inc.  For more information on Vovida Networks,  Inc.,  please see 

 *  http://www.vovida.org/.  

 *  

 */ 

 

mailto:vocal@vovida.org
http://www.vovida.org/


 

 

Oracle Berkeley DB 

=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 

/* 

 * Copyright (c) 1990-2006 

 *      Oracle Corporation.  All rights reserved. 

 * 

 * Redistribution and use in source and binary forms, with or without 

 * modification, are permitted provided that the following conditions 

 * are met: 

 * 1. Redistributions of source code must retain the above copyright 

 *    notice this list of conditions and the following disclaimer. 

 * 2. Redistributions in binary form must reproduce the above copyright 

 *    notice, this list of conditions and the following disclaimer in the 

 *    documentation and/or other materials provided with the distribution. 

 * 3. Redistributions in any form must be accompanied by information on 

 *    how to obtain complete source code for the DB software and any 

 *    accompanying software that uses the DB software.  The source code 

 *    must either be included in the distribution or be available for no 

 *    more than the cost of distribution plus a nominal fee, and must be 

 *    freely redistributable under reasonable conditions.  For an 

 *    executable file, complete source code means the source code for all 

 *    modules it contains.  It does not include source code for modules or 

 *    files that typically accompany the major components of the operating 

 *    system on which the executable file runs. 

 * 

 * THIS SOFTWARE IS PROVIDED BY ORACLE CORPORATION AS IS AND ANY EXPRESS 

 * OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 

 * WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR 

 * NON-INFRINGEMENT, ARE DISCLAIMED.  IN NO EVENT SHALL ORACLE CORPORATION 

 * BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 

 * CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 

 * SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 

 * INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 

 * CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 

 * ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF 

 * THE POSSIBILITY OF SUCH DAMAGE. 

 */ 

/* 



 

  
  

 * Copyright (c) 1990, 1993, 1994, 1995 

 * The Regents of the University of California.  All rights reserved. 

 * 

 * Redistribution and use in source and binary forms, with or without 

 * modification, are permitted provided that the following conditions 

 * are met: 

 * 1. Redistributions of source code must retain the above copyright 

 *    notice this list of conditions and the following disclaimer. 

 * 2. Redistributions in binary form must reproduce the above copyright 

 *    notice, this list of conditions and the following disclaimer in the 

 *    documentation and/or other materials provided with the distribution. 

 * 3. Neither the name of the University nor the names of its contributors 

 *    may be used to endorse or promote products derived from this software 

 *    without specific prior written permission. 

 * 

 * THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS AS IS AND 

 * ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 

 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 

 * ARE DISCLAIMED.  IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE 

 * FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 

 * DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS 

 * OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 

 * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 

 * LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY 

 * OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF 

 * SUCH DAMAGE. 

 */ 

/* 

 * Copyright (c) 1995, 1996 

 * The President and Fellows of Harvard University.  All rights reserved. 

 * 

 * Redistribution and use in source and binary forms, with or without 

 * modification, are permitted provided that the following conditions 

 * are met: 

 * 1. Redistributions of source code must retain the above copyright 

 *    notice this list of conditions and the following disclaimer. 

 * 2. Redistributions in binary form must reproduce the above copyright 

 *    notice, this list of conditions and the following disclaimer in the 

 *    documentation and/or other materials provided with the distribution. 

 * 3. Neither the name of the University nor the names of its contributors 

 *    may be used to endorse or promote products derived from this software 

 *    without specific prior written permission. 

 * 

 * THIS SOFTWARE IS PROVIDED BY HARVARD AND ITS CONTRIBUTORS AS IS AND 

 * ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 

 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 

 * ARE DISCLAIMED.  IN NO EVENT SHALL HARVARD OR ITS CONTRIBUTORS BE LIABLE 

 * FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 

 * DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS 

 * OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 

 * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 

 * LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY 

 * OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF 

 * SUCH DAMAGE. 

 */ 
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modifying multiple, 143 

night mode, 137 

no answer time, 124 

priority weight, 135 

queued time weight, 134 

skills score weight, 135 

target ASA, 126 

thresholds, 178 

user email state timeout, 125 

quick text messaging, 37 

R 

remote DN, 68 

resetting an user password, 65 

S 

saving, 35 

send name to PBX, 87 

send quick text message, 37 

silent monitoring notification, 80 

site administrator defined, 29 

sites 

defined, 26 

deleting, 265 

exporting, 223 

importing, 223 

skills 

adding from workflow, 164 

adding to the skills folder, 163 

based on ANI, 172 

based on DNIS, 172 

contact scores against an user, 185 

deleting, 169 

deleting all, 170 

dynamic skill level, 188 

exporting, 222 

importing, 222 

queue settings, 177 

skills score, 135 

skills score weight, 135 

user scores against a contact, 182 

viewing, 162 

supervisor, defined, 28 

switches 

adding, 238 



 
 

 

defined, 26 

deleting, 256 

deleting all, 258 

importing, 222 

T 

target ASA, 126 

team leader, defined, 28 

teams 

adding (multiple), 154 

adding (single), 152 

deleting, 158 

exporting, 221 

importing, 221 

viewing, 150 

thresholds 

configuring, 179 

U 

updating updating user name, 62 

updating user type, 62 

users 

adding (multiple), 52, 55 

adding (single), 49 

adding from workflow, 59 

assigning skills to users, 95 

call forwarding, 89 

defined, 28, 41 

deleting, 100, 101 

exporting, 221 

importing, 221 

modifying multiple, 97 

modifying name, 62 

modifying type, 62 

modifying user ID, 63 

viewing, 47 

V 

validating, 33 

variables 

exporting, 222 

importing, 222 

view mode 

defined, 3 

logging on to, 10 

viewing 

email groups, 194 

skills, 162 

teams, 150 

users, 47 

W 

waiting beep, 81 

workflow, ix 

workflow graph, defined, 198 

workflow page, defined, 198 

workflow, defined, 198 

wrap up 

after placed call, 81, 82, 83 

after queued call, 81 

defined, 123 

enabling for queues, 123 

 


